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INTRODUCTION  

The Impact/SQL Utilities module provides the system administrator with the tools required to oversee 
the configuration of the entire Impact/SQL suite. The Utilities module controls both the operating 
configuration of all of the other Impact modules and contains some tools used to monitor the system 
and address issues that might arise.  
 
This manual will explain all of the configuration parameters controlled from the Impact/SQL Utilities 
module and explain the available tools. There are a tremendous number of configuration options that 
can affect the functionality of the system.  In addition, the Batch Processor, Income Export utility, the 
Update program, the Printer Test routine and the Invoice Export programs are documented in this 
manual. As each company functions in its own unique way, there are some functions within 
Impact/SQL that may not be utilized, but you are encouraged to examine and consider all of them to 
ensure you are getting the most out of Impact/SQL.   
 
The settings made through Impact/SQL Utilities are very critical and some of them, once 
determined, cannot be altered without serious conse quences. Therefore, those responsible 
for system administration must be very clear on wha t each of the settings is for and the 
ramifications of their use. A careful review of the  information in this manual should help in 
that regard. Access to the Utilities module should be limited to those with an absolute need to 
be in it, and those individuals must have adequate training. 
 
Please contact USA Digital Solutions before making any changes in the Utilities module 
unless you are comfortable with the subject matter.   
 
There are three major areas of focus in Impact/SQL Utilities: fundamental system configuration, 
configuration of the large number of “lookup tables” with company-specific information, and tools. 
Again, some of the settings will be established during system installation and testing and will not be 
changed going forward. Others may be altered as the company changes how it uses Impact/SQL as 
time goes by. For example, turning on a function like “Wire In Processing”. 
 
While there may be more than one person who utilizes the Utilities module, there should not be many 
more. Generally, a system administrator and the manager of the Escrow Accounting area will be the 
primary users of Utilities. Due to the impact of some of the settings, it is imperative that only qualified 
users are given access to Utilities. It is also critical that all changes made through Utilities are 
documented. A change might be made that has an unanticipated effect on the user environment and 
it will be easier to troubleshoot if there is documentation about all changes made through Utilities. 
 
This manual will progress through the functions in Impact/SQL Utilities in the order that they appear 
on the menus within the module. This will not be how a user will work in the Utilities module -  that will 
depend on what changes are being made at the time.  
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HELPFUL HINTS 

 
Some of the formatting conventions used in this manual are: 
 

• Keystrokes, such as the Enter key, will be displayed as ENTER in the manual. 

• Any text that appears on the screen will be shown as Edit  or Cancel . 

• Menus and menu options you are to use will be displayed as System Files > XREF… . 
This will indicate you are to choose the XREF… option from the System Files pull-down 
menu.   

• Text you are to type will appear as Type This . 

QUICK KEYS 

In the Impact/SQL Utilities module, as in other Impact/SQL modules, there are opportunities to move 
through the options available without using the mouse. Most menu items contain an underlined letter. 
If you hold down the ALT  key and hit the underlined letter of the option list you want displayed, it will 
drop down.   

• ALT + S  will open the System Files  dropdown menu list; 
• ALT + U  will open the User Tables dropdown menu list; 
• ALT + T  will open the Tools  dropdown menu list; etc. 

 

CLOSING IMPACT/SQL UTILITIES 

As with most Windows applications, you can close Impact/SQL modules using the X box in the upper 
right hand corner. You can also select the Exit  item, under the File  option, to close any Impact 
module. 
 
DATE FIELDS 

In Impact/SQL, dates are entered into date fields 
in the format “mmddyy” without slashes or 
dashes. Once a user is familiar with the 
convention, he/she will find that entering dates 
this way is very efficient.   
 
There is an alternative way to enter dates into 
any field that needs one. You will see a box with 
“… “ in it next to each date field. If you click on 
this box, a calendar tool will be displayed as is 
shown here: 
 
You can use your mouse to select the month 
and year to display and click on the day you 
wish entered in the date field you started the tool 
from. You may also enter a number of days from 
the currently selected date, which for some 
reports is a nice shortcut. Enter a positive 
number to move forward in time, a negative to 
go back. 
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LOG ON 

Access to the Impact/SQL Utilities module (as to all Impact modules) is controlled by a user-rights 
table, administered by a limited set of user ID’s that have sufficient authority granted to them. This is 
a very important control and should be carefully managed. Depending on the nature of the rights 
assigned to a user, they will have access to various pieces of the overall Impact suite, but generally 
not complete access. This functionality helps reinforce audit controls and needs to be considered in 
conjunction with the network security plan.  
 
The system can be configured to require a logon routine each time the user opens any Impact 
module or it can be configured to provide for an automatic logon utilizing the NT user name. By 
providing for an automatic logon utilizing the NT user name, control over the access to the application 
is increased; both the system administrator and the rights table within Impact/SQL can control 
access. The system administrator can control access by disabling the user’s NT user name, a likely 
event in the case of an employee’s departure. In addition, the user name can be disabled within 
Impact/SQL Utilities – which will only affect the user’s ability to access Impact/SQL modules. This 
would be done if the user is still using the rest of the network, but should no longer be accessing 
Impact/SQL.  
 
Impact/SQL passwords do not expire, therefore the use of an automatic logon based on NT user 
names can be a more effective control – assuming automatic expiration of passwords is implemented 
through the operating system (NT). This matter is more fully explained later in this Impact/SQL 
Utilities manual. 
 
If the system is configured to require a user to logon to Impact/SQL Utilities, a screen like that shown 
below will be presented after the user double-clicks on the “Impact Utilities” icon. The Log on to:  field 
will display the company’s database name(s). 
 

 
When configured to require a log-on 
step, the user will be identified within the 
system by their initials (3 character 
maximum) and will be given a password 
(6 character maximum). When 
presented with the login screen: 

• Enter your login in the User 
Initials  field and then TAB  to 
the  Password  field. 

• Enter your password and, if the 
correct database is identified in 
the Log on to  field, click on the 
OK box or hit ENTER. If the 
database is not correct, click the 
dropdown box arrow on the Log 
on To  field, and select the 
correct database; then click on the OK button or press ENTER. 

• Alternatively, if you do not want to use the mouse to click on to the OK box, hit the ENTER 
key after login information is entered. 

 
Note:  When you enter your password, it will not be displayed on the screen, but will be represented 
by a series of asterisks “*”. 
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Keep your password private. You should not share your password or log on to the system and let 
someone else then operate under that session. The initials of the user logged on to the system will 
attach to transactions entered and you will only want to be responsible for your own activity. In 
addition, you may have access to functions that co-workers do not and should not. Therefore, keep 
your password private! 
 
If you forget your password, the administrator of the Impact application must assign a new one. 
 
There are three user levels that provide access to the Impact Utilities module:  
Utilities , Utilities – User Tables Only  and System Administrator . User levels are assigned in 
Utilities > Password  (discussed later in the manual). 
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THE IMPACT/SQL UTILITIES MAIN SCREEN 

 
Once you have entered your user initials, the correct password, have selected the appropriate 
database, and clicked OK, the system will log you in and present the main Impact/SQL Utilities 
screen (shown below). The screen, as it initially opens, presents the user with a menu of options 
across the top of the screen. Each option has a dropdown menu below it, which will be displayed 
when you click on the option name. Once you have clicked on one option name and the menu list 
below it is presented, you can slide your cursor down the list with your mouse to get to the function 
you wish to use. If you are not sure under which option heading the desired function is stored, click on 
any option heading and once the menu list is presented, slide your mouse to the left or right to other 
option headings. Their menu lists will present without you having to click again and you can then 
browse all of the menu choices available to you. 
 
The name of the user logged in and the current system date is displayed at the bottom of the screen.  
 
Note: If the date presented is not the current cale ndar day, contact your system administrator 
immediately and do not process any transactions unt il it has been corrected. 
 

Drop down 
menus 

Main Utilities screen 
with customizable 
company logo 

Name of the user 
that is logged in 

Current date 
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IMPACT/SQL UTILITIES MENU OPTIONS 

The following pages will describe all of the functions or tasks that are managed within the Impact/SQL 
Utilities module. Within each primary menu option, one or more items will appear on the dropdown 
menu listings.   
 
FILE MENU 

There is only one item under the File  Menu  option: Exit . This option should be the method used for 
closing Impact/SQL Utilities. 
 
SYSTEM FILES MENU 

The System Files  menu option has twelve generally accessible (or thirteen, depending on 
configuration) items under it: 
 

  
 
Each item is very distinct from the other and will be explained in detail 
below. The items do not  ‘flow’ one to the next as in a process workflow 
order. These functions cover a wide range of initial configuration 
options and include some routine maintenance functions (such as 
adding a branch or bank). Remember, improper changes to some 
settings can have serious consequences – so do not make 
changes you are not sure of. Consult USA Digital So lutions if you 
are in doubt. 
 
 

 

 

 

XREF 

The Xref  menu selection takes the user to a  
set of three screens on which “paths” are 
assigned for all of the functional components 
of Impact/SQL. The “path” is UNC path 
through which the program will search for 
required files. The only entry that must be a 
mapped drive is the Local Work Path  (Page 
2). The locations for the Escrow Master 
Documents, the Report files, the Legal Clause 
files, among others, are defined on the Xref 
screens.   
 
These paths will have been set up by the 
USA Digital Solutions installation manager 
and should only be changed at the 
direction of USA Digital Solutions 
personnel.   
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The Company Name  and System Name  
variables are also defined on the Xref  > Page 
2 (bottom). These variables are used in 
reports, generally in titles, and in documents. 
The System Name  variable can be used to 
identify a different company name from that 
shown in the Company Name  variable – 
which would be useful if a subsidiary 
company, with its own Impact/SQL database, 
wanted to show the parent company’s name 
on reports. The parent company name would 
go in the Company Name  variable, and the 
subsidiary’s name would go in the System 
Name field. Then, as Crystal Reports is used 
to develop custom reports, the appropriate 
names are available for use on the reports. 
The Company Name  would be the name 
printed on the HUD and Settlement 
Statements. 

The specific XREF paths defined are: 

XREF – Page 1 
  Object Path Where the Impact executables (“.exe” files) are stored (the programs 

that run Impact)  

Report Path All standard and custom Crystal Reports report templates. 

Project Path Location of project information. Projects are established in the 
Escrow module.  

Crystal Reports Path The location of the CRW32.exe (Crystal Reports Designer) program if 
it is installed. 

Legal Clause Path Where the Word documents of standardized legal clauses, used to 
assist in the creation of legal descriptions, are located. 

System Path Houses all the data files.  

Escrow Master 
Documents Path 

The ESCMST folder is where all the master forms for the escrow 
documents are stored. They are attached to the ‘Escrow.dot’ 
template. The global AutoText used in the Escrow module is also 
stored here. 

Laser Forms Path Where the master template for each check (and duplicate check files, 
if used), the overflow stub (STUB.RPT), and the transfer fee slip 
(TRANSFER.RPT) are stored. Each check corresponds to a bank 
number assignment. For example, if the bank number for an escrow 
trust account on your system is 01, then the corresponding form 
would be CHECKS01.rpt. 
 

Escrow Clause Path  The ESCCLS folder is where all the Escrow clauses are stored. They 
are attached to the ‘Escrow .dot’ template. 

Title Clause Path  The TTLCLS folder is where all the Title clauses (the Title Codebook) 
are stored. These are Word documents attached to the ‘Title.dot’ 
template, and have special formatting applied to each code (Word 
document).  
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Title Master Documents 
Path  

The TTLMST folder is where all the master Word forms are stored for 
Title. This includes the prelim, commitment, policies, endorsements, 
miscellaneous transmittal letters, and the global AutoText used in the 
Title module. 

Subdivision Masters 
Path  

The SUBDIV folder is where all the master subdivisions that are 
created by the Title Department, within the Title module, are stored. 

 

XREF – Page 2 
  
Title Plant Interface Path No longer used. 

Local Work Path Where all of the users’ temporary files are located.  This must be a 
mapped drive, as it must be a unique path per user. 

Local SAV Path Where “SAV” files used with Crystal Reports are stored. SAV files 
contain data fields with their size limitation. 

Desktop Logo Path Where the “company.gif” file is located in graphic information 
format.  This is the Impact desktop backsplash logo. 

Local EXE Path Where the programs are located (same as the Object Path). 

Help Path No longer used. 

Other Base Path Where base orders established on a previous system are located. 
These bases are used in the Title Department when creating 
prelims. 

Dot File Path Where all the Word macros and logo files are housed. The Word 
macros help in generating Word documents.  

Receive Path Reserved for future use. 

Send Path Reserved for future use.  

Company Number The company number is used to identify the company for use in 
accounting interfaces or integrating with other non-Impact 
systems. 

Company Name Used for DDE field insertion into documents. This is the name that 
appears on the HUD, Box ‘H’ if, under ‘Setup Options’, the ‘Print 
Company Name in HUD box H’ is checked (otherwise the escrow 
officer’s name appears in Box H). 

System Name Is the name shown on the title bar of each module. Normally, this 
is the same as the Company Name (discussed above). 
 

XREF – Page 3 
  Licensing Server Name The name of the SQL server running the Licensing service (only 

DSI administrators will see this tab). 
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PASSWORD 

The Password  function is the security control center for all users of all Impact/SQL modules. New 
users’ accounts must be created here before they can access the system and the user accounts for 
those that leave the company should be terminated here. Changes to a Password , Title , Email 
Address , Branch Number , Access Code , and Type of user  are all made here.   
 
Great care should be taken to only provide the “rights” required for a user to do his/her job. The risks 
of serious errors being made by an untrained user go up substantially if they are given rights to 
access functions beyond their scope. In addition, the rights that users are assigned will determine 
which functions are made available to them on the screen. Limiting the functions to those required for 
them to do their job will simplify their environment. 
 
When first called, the Password  function will display the following screen: 
 

 
 
From this screen, the user can Print  a report of all users, add a New user, Modify  the information 
about a user, or Delete  a user entered in error. The Cancel  button will return you to the main Utilities 
menu. 
 
In addition, the Search For:   field can be used to aid you in locating a specific entry to modify or 
delete.  Simply enter some contiguous information that you believe is in any of the three fields 
presented (Initials, Name and Branch) and the system will search the entire table and present those 
records that match the search criteria. 

PRINT 
The Print  button will generate a report of all of the users defined in the password file. The report will 
present the User Initials , Name, Title , Email Address , Branch Number , Access Level,  Type of 
User (whether the user is an EO, TO, Processor, Doc Admin &/or NAF Admin), Employee Number, 
Ltd. Practicing Number, Wire Access, Check Access a nd Lock Access.  It is recommended that 
the password file be printed out routinely and reviewed for terminated employees and for employees 
who have moved from one department to another who, therefore, may have improper rights assigned 
to them. 
 
NOTE: Their passwords will NOT print in spite of the name of the report. There is no way to 
determine a password after it has been entered into the system. If a user forgets their password, a 
new one must be entered for the user (assuming NT Authentication is not being used).   
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NEW 
The New button will bring up a blank form into which you will enter information about a new user. 
Depending on the company’s configuration, Dual Authorization Access  may be presented as well 
as the information presented in the following screen: 

 
 

The first item entered will be User 
Initials . Up to three characters can 
be entered, and they must be 
unique to the database. (No two 
users can have the same initials in 
the system). 
 
The NT User Name (which appears 
“grayed” out here due to a system 
setting related to automating logins 
– to be discussed below) would be 
entered in this field.  
 
The full name of the user is to be 
entered in the Name field. The 
names should be entered 
consistently in upper and lower 
case, if that is the company 
preference, or all in upper case. 
These names will appear on reports 
and in documents. 

 
The Password  field can contain numbers and letters up to a maximum of six (6) characters. As with 
the login screen, the password will not be displayed (it will present as a line of asterisks “******”) and 
so must be replaced if forgotten. 
 
The user’s job title should be entered into the Title field. Again, consistency of entry format should be 
followed with regard to case (upper & lower). 
 
The Email Address  of the user should be entered into the field of the same name. The address 
entered should be the full address not just the portion before the “@” sign. For example, Bob Smith, 
of Great Title Agency, Inc. has the e-mail address “bsmith@greattitleagency.com”. The address 
should be entered completely as shown, not as “bsmith”. These addresses should be entered with 
care as they will be used by the system to send notifications to the user from within several functions 
(such as when prelims are ready or when wire transfers are complete).  
 
The Branch Number  field is critical.  
 
Title users should be assigned to the Title branch (099 – or the appropriate secondary Title branch 
number if more than one has been created).  
 
Escrow users should be assigned to their home branch and they will be restricted to accessing files 
assigned to only their branch number.  
 
Accounting users should be assigned to the “999” branch number. This will permit them to work with 
all branch data.  
 
Floaters should be assigned to branch “099” or the floater’s home branch with the access code 
“Floater”. This will permit them to work in any branch. 
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Access Code  is the most critical field on this screen. This is the place where “rights levels” are 
assigned to a user. As has been said repeatedly, care should be taken to assign just the rights 
required by a user to perform their job. This will limit the functions they see on the screens and limit 
the potential risk of them taking actions or changing settings that they have not been trained on.  
 
The following table (on several pages) details the rights provided with each access level: 
 
� = No rights    � = Rights 
 

Module 
0 - 

Terminated 
1 - 

Receptionist 
2 - Escrow 
Secretary 

3 - Escrow 
Officer 4 - Escrow Manager 

Accounting � � � � � 

     Setup Banks      
     Add Banks to Branches      
     Change Banks      
            
Escrow � � � � � 

     Income Analysis  � � �Only theirs �All within branch 
     Log Book  � �  �Only theirs �All within branch 
     Tickler Maintenance  � � � � 

     Projects  � � � � 

     Cancel Escrow  � � � � 

     Trial Balance  � � �Only theirs �All within the branch 
     Savings Accounts  � � � � 

     Print Savings Accounts  � 

�only their 
branch 

�only their 
branch �only their branch 

     Print HUD Certification Stamp  � � � � 

     Void Checks  � � � � 

     Assigned Escrow Report  � � � � 

     Closing Report  � � � � 

     Deposit Slips  � � � � 

     Daily Receipts Journal  � � � � 

     Daily Disbursements Journal  � � � � 

     Wire Out Journal (if Dual Auth enabled)  � � � � 

     Wire Out Audit (if Dual Auth enabled)  � � � � 

            
Utilities � � � � � 

     SQL Error Log      
     View Clear Locks      
     Copy Naf (must be NAF admin)      
     Check Template      
            
Title � � � � � 

            
MIS � � � � � 

            
Accounting Export � � � � � 

       

Invoice Export � � � � � 

       

Income Export � � � � � 

       

Reconveyance Tracking � � � � � 

       

Batch Processor � � � � � 

       

Wire Monitor � � � � � 

       

Print Test � � � � � 

       

Archive Viewer � � � � � 

       

Order Desk � � � � � 
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The second set of access levels: 
 
� = No rights    � = Rights 
 

Module 
5 - 

Accounting 
6 - Accounting 

Mgr 7 - MIS 8 - Title 9 - Policy 
Accounting � � � � � 

     Setup Banks � �    
     Add Banks to Branches � �    
     Change Banks � �    
            
Escrow � � � � � 

     Income Analysis � �    
     Log Book � �    
     Tickler Maintenance      
     Projects � �    
     Cancel Escrow � �    

     Trial Balance � �    
     Savings Accounts � �    

     Print Savings Accounts � �    
     Print HUD Certification Stamp � �    
     Void Checks � �    
     Assigned Escrow Report � �    
     Closing Report � �    
     Deposit Slips � �    
     Daily Receipts Journal � �    
     Daily Disbursements Journal � �    
     Wire Out Journal (if Dual Auth enabled) � �    
     Wire Out Audit (if Dual Auth enabled) � �    
            
Utilities � � � � � 

     SQL Error Log      
     View Clear Locks      
     Copy Naf (must be NAF admin)      
     Check Template      
            
Title � � � � � 

            
MIS � � � � � 

            
Accounting Export � � � � � 

       

Invoice Export � � � � � 

       

Income Export � � � � � 

       

Reconveyance Tracking � � � � � 

       

Batch Processor � � � � � 

       

Wire Monitor � � � � � 

       

Print Test � � � � � 

       

Archive Viewer � � � � � 

       

Order Desk � � � � � 
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The third set of access levels: 
 
� = No rights    � = Rights 
 

Module 10 - Utilities 11 - CP 12 - E & T 13 - Sys Admin 14 - Utl Tables only 
Accounting �  � � � � 

     Setup Banks �   �  
     Add Banks to Branches �   �  
     Change Banks �   �  
            
Escrow � � � � � 

     Income Analysis � � � if EO �  
     Log Book � � � if EO �  
     Tickler Maintenance � � � if EO �  
     Projects � � � �  
     Cancel Escrow � � � �  

     Trial Balance 

� All within the 
branch if not 

assigned to 999 � � �  
     Savings Accounts � � � �  

     Print Savings Accounts � 

� Indiv. 
file only � �  

     Print HUD Certification Stamp � � � �  
     Void Checks � � � �  
     Assigned Escrow Report � � � �  
     Closing Report � � � �  
     Deposit Slips � � � �  
     Daily Receipts Journal � � � �  
     Daily Disbursements Journal � � � �  
     Wire Out Journal (if Dual Auth enabled) � � � �  
     Wire Out Audit (if Dual Auth enabled) � � � �  
            
Utilities � � � � � - User tables only 
     SQL Error Log �   � � 

     View Clear Locks �   � � 

     Copy Naf (must be NAF admin) �   � � 

     Check Template �   � � 

           
Title � � � � � 

            
MIS � � � � � 

            
Accounting Export � � � � � 

       

Invoice Export � � � � � 

       

Income Export � � � � � 

       

Reconveyance Tracking � � � � � 

       

Batch Processor � � � � � 

       

Wire Monitor � � � � � 

       

Print Test � � � � � 

       

Archive Viewer � � � � � 

       

Order Desk � � � � � 
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The fourth set of access levels: 
 
� = No rights    � = Rights 
 

Module 15 - Order Desk 16 - FLTR 
17 FLT 
w/Chk 18 - Sub escrow 

Accounting � � � � 

     Setup Banks     
     Add Banks to Branches     
     Change Banks     
          

Escrow 
� No access to 
disbursements 

� No access to 
disbursements � 

� the following areas are disabled 
for Sub Escrow: IRS, Copy File, 

Order Title Search, Rent 
Schedule, Balance Statement, 

Commissions (HUD 700), Lender 
Summary, HUD 800, HUD 900, 
HUD 100 thru HUD 510, HUD 

1000 
     Income Analysis � � � � 

     Log Book � � � � 

     Tickler Maintenance � � � � 

     Projects � � � � 

     Cancel Escrow � � � � 

     Trial Balance � � � � 

     Savings Accounts � � � � 

     Print Savings Accounts � � � � 

     Print HUD Certification Stamp � � � � 

     Void Checks � � � � 

     Assigned Escrow Report � � � � 

     Closing Report � � � � 

     Deposit Slips � � � � 

     Daily Receipts Journal � � � � 

     Daily Disbursements Journal � � � � 

     Wire Out Journal (if Dual Auth enabled) � � � � 

     Wire Out Audit (if Dual Auth enabled) � � � � 

          
Utilities � � � � 

     SQL Error Log     
     View Clear Locks     
     Copy Naf (must be NAF admin)     
     Check Template     
          
Title � � � � 

          
MIS � � � � 

          
Accounting Export � � � � 

      

Invoice Export � � � � 

      

Income Export � � � � 

      

Reconveyance Tracking � � � � 

      

Batch Processor � � � � 

      

Wire Monitor � � � � 

      

Print Test � � � � 

      

Archive Viewer � � � � 

      

Order Desk � � � � 
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The Ltd Practicing No  field is where the Limited Practicing Officer Number is entered, if the escrow 
officer has one (requirement in state of Washington). 
 
The Employee ID  field will hold up to 20 characters. This feature can be used for reporting purposes. 
 
Type of User Box :  This boxed area contains several unrelated items.  There are five (5) types of 
users and the appropriate box(es) should be “X’d” for each user. In addition, there are controls for 
disbursement rights and, for Accounting access-coded users, a file lock control. If a box is checked, 
some specific functionality is enabled as discussed below. The user types are Escrow Officer , Title 
Officer , Document Administrator , Processor , and NAF Administrator . More than one box may be 
checked if appropriate.   
 
• If Escrow Officer  is checked, the user’s name will appear in the drop down box as an available 

escrow officer within the branch of the user. Users will only see escrow officers assigned to the 
branch the file is assigned to. Some reports are generated by “Escrow Officer”. 

• If Title Officer  is checked, the user’s name will appear in the drop down box as an available 
internal title officer. Users will only see the Title Officers assigned to the title branch(es) available 
to the escrow branch of the file. Some reports are generated by “Title Officer”. 

• If Document Administrator  is checked, the user will have Document Maintenance  as an option 
under the Documents  menu. The user may have both escrow and title document maintenance 
access if they have an access level that allows multiple module access. Users that have this 
functionality will require special training. 

• Processors  are escrow assistants or central processing staff members. If checked, the user’s 
name will appear in the drop down box as an available processor. Some reports may be 
generated by “Processor”. If Processor is checked, the Escrow Officer, Title Officer, and 
Document Administrator options are not available for selection. 

• Checking the NAF Administrator  box will permit the user to edit the Name and Address File 
(NAF). Generally, a company will want to limit the number of individuals who can edit the NAF to 
prevent the file from being filled with inconsistent and redundant entries. This works in 
conjunction with the Setup Options relating to the NAF. 

• If the Add/Modify Disbursements  box is checked, the user will have access to the 
disbursements menu in Escrow, if their access level will permit it. 

• If the Print Checks  box is checked, the user will be able to print checks, if their access level will 
permit it.  

• If the user’s Access Level is Accounting or Accounting Manager, the control for Lock/Unlock File  
will appear.  This will enable the ability for the user to block accounting activity on specific files. 
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If Dual Authorization is enabled in Utilities > Setup Options > General > Enable Dual 
Authorizations for Wire Outs , Dual Authorization Access  will appear next to the Type of user  
selection. There are two (2) rights associated with this access: Wire Out Approver  and Wire Out 
Self Approver. Wire Out Approver  requires another approver’s interaction. Wire Out Self Approver 
does not require a second approval. 
 

If the setup option Hud/Worksheet Stamp  (General tab) is enabled, a user with an access level of 
Escrow Officer, Escrow Secretary or Escrow Manager will have a secondary tab in the Password set 
up/modify screen labeled  Hud/Worksheet Stamp .  This is where a small bitmap (<64K BMP) image 
file can be assigned to the user.  This image file will appear on the HUD and Settlement Statements if 
the print option Include the Certification Stamp  is selected.  Settlement Statements, being 
customized by system, must be modified for the stamp to appear.  Click on the Select Image  button 
to open a Windows Explorer window that will let you browse to the location of the BMP file to be used 
as the certification stamp for the user.  These BMP files are created by the client, not DSI.  If the 
selected image should no longer be used, use the Delete Image  button to de-select it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the OK button to save the settings established for the new user or click on Cancel to return 
to the Password File introductory screen without saving the new user’s settings. 
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MODIFY  
The Modify button is used when you wish to view or change the settings for an existing user. 
Highlight the user on the Password File  screen and click on Modify . The same screen presented 
above (in the Add  section) will be displayed with the settings for the selected user. At this point, you 
can view and/or change the settings. Click on the OK button to save the modified settings for the user 
or click on Cancel to return to the Password File  introductory screen without changing the existing 
settings. 

DELETE 
The Delete button will cause the system to try to delete the user highlighted on the Password File  
screen. Impact will not delete a user that has files assigned to their initials. You will need to re-assign 
files to another Escrow Officer’s (or Title Officer’s) initials before being permitted to delete the Escrow 
Officer (or Title Officer) from the password file. If you have created a user in error or a user has not 
been assigned to any files, then you can delete the user from the file with the Delete button. 

When any employee departs the company, their Access Code  should be immediately changed to 
Terminated Employee.  Then, if they have files assigned to them, those should be re-assigned, if so 
desired, before deleting the user is attempted. Non-escrow officers or title officers can be deleted 
immediately, but should be flagged as Terminated Employee  at a minimum upon their departure so 
they cannot access Impact/SQL.  Escrow and Title officers that have been assigned to files can be 
marked Terminated Employee , and they will remain assigned to the files they are assigned to, until 
the assignments are changed, but will not appear on the EO and TO dropdown lists, so they cannot 
be assigned to new files. 

CANCEL 
The Cancel button will close the Password File  screen and return the user to the main Utilities 
screen. Changes that were already saved by clicking on OK will not be cancelled. 
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FILE TABLE 

The File Table  function is used to establish the locations and size restrictions for the storage 
provided for document files relating to legal descriptions, prelims, policies, and MS Word documents 
– both for escrow and direct order files. Generally, these settings are established by USA Digital 
Solutions at setup and do not need to be adjusted. The system administrator may wish to check on 
the number of files that are being stored in each location for each type, which can be done here.  
 
Impact/SQL utilizes 10 sub-directories for each type of file per database. This permits files to be 
spread across several drive mappings. A maximum number of files per sub-directory is identified in 
the Max # of Files  field. Depending on the operating system in use and the drive space available, the 
Max # of Files  setting may be relatively small or large. Initially, files are assigned to the first identified 
sub-directory until it has reached the maximum count then the next sub-directory is utilized. As files 
are deleted and the counts within sub-directories fall, files will be assigned to the first sub-directory in 
the list with space, then to the next with space available, and so on. The document deletion function 
in the Batch Processor can be set to remove documents from some of  these directories to free up 
disk space. 
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BRANCH 

The Branch  function under System Files  provides for the entry of new branches into the system and 
for the editing of settings for an existing branch. This module is the same as that found in the Impact 
Accounting module under Misc. > Set up Branch . Generally, the function in Utilities would be used 
by the system administrator or Digital Solutions when setting up the system the first time and then 
Accounting staff would use the function within Accounting on an on-going basis.   
 
Banks are assigned to branches and the manner in which reference numbers related to accounting 
transactions (for receipts, checks, deposits and wires out) are assigned is configured herein. Note: 
bank escrow trust accounts are added to the system through the System Files > Bank  function, in 
Impact Utilities or Misc. > Set up Bank s function in Impact/SQL Accounting. Information about the 
savings month-to-date accounting is also located here. The Title Departments available to a branch 
are assigned with this function, if the system is configured for multiple Title Departments. 
 
Important notes:   

• The original Title office is always assigned the br anch number ‘099’ (not ‘99’, but ‘099’). 
• The Accounting Department (Escrow Accounting, not F inancial) is always assigned 

the branch number ‘999’. 
• The branch number ‘998’ is generally reserved for a  “Training Branch”. 
• ALL bank accounts must be assigned to branch ‘999’ (Accounting), in addition to the 

branch(es) that use them. 

 
 

When the function is selected, a Branch File  screen is displayed presenting the branches that have 
already been set up in Impact/SQL. The branch Number , Name, and Address  are presented along 
with the same Print , New, Modify , Delete, and Cancel  buttons seen on the Password File screen.   

PRINT 
The Print  button will generate a report of all of the branches defined in the branch file. The report will 
present the branches’ numbers, full addresses, phone and fax numbers, counties, as well as banks 
assigned to each branch. It is recommended that the branch report be printed out routinely and 
reviewed for accuracy. 
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NEW 
The New button will bring up a blank form into 
which you will enter information about a new 
branch. There are three or four tabs across the top 
of the screen representing screens of information 
about each branch (see screen shot). The settings 
established on these screens are very important 
and should be done with care. The four screens 
are: Branch Information , Bank I nformation , 
Savings Information,  and Title Departments  
(only shown for Escrow branches and when 
multiple title branches have been established). 
Each of these will be discussed in detail below. 
 

 

 

BRANCH INFORMATION 
The Branch Information  screen (shown above) is the first screen presented and is where the basic 
information about each operating unit is established. While it is called Branch Information , Title and 
Accounting units are also established as branches. Generally, a training branch (998) will also be set 
up by USA Digital Solutions to facilitate user training. 
 
The first field on the screen identifies the Branch Type . There are three types of offices: Escrow , 
Title , and Other . Use the drop-down to select the type being established. 

• Escrow  – this type is assigned to normal escrow branches and to the Accounting 999 office. 
It provides for the routine escrow functionality within Impact. This setting permits receipts and 
disbursements to be generated under the number established for the office in addition to 
income tracking. The Accounting office is set up as an escrow office. Sub-escrows need to be 
established under an escrow branch. 

• Title  – this type should be assigned to pure title offices; those producing Direct Orders and 
title work for escrow branches. No receipts or disbursements are permitted under this type of 
branch. Note : if a Title Department is going to generate receipts and track income, then 
establish a separate escrow type branch for this purpose.  

• Other  – if an office is being set up as a control branch, it should be designated with the Other  
type. A control branch is one established solely for the purpose of managing the check, 
receipt, deposit, and wire-out numbers issued across a range of branches when the numbers 
are not assigned across all branches using the same bank but are to be common across a 
subgroup of branches. This function is seldom used.  

The Branch Number  is established next. The number is three positions long, zero-filled from the left, 
if less than three non-zero numbers. Note: the number “099” is reserved for the primary Title unit and 
the number “999” is reserved for the Accounting unit. As noted above, “998” is generally used as the 
“Training Branch”. Therefore, there are 996 available office numbers. 
  
The Name of the office should be accurate and descriptive. The identifier will appear on most reports 
and may or may not appear with the branch number. The names should be unique to prevent 
confusion in cases where the number is not presented. 
 
The Address  information is for the physical location of the branch and will appear on letterhead 
documents – so do not use the same address for all branches unless they really are in the same 
location. The Phone Number  and Fax Numbers  should also be for the specific office. 
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The Manager’s Initials  field should only be filled in if all escrows opened in the office should be 
assigned to that person. The initials should be a valid set of user initials as set up in the Password 
File. This field may be left blank and normally is. If this option is filled with manger’s initials, once the 
file is opened, the Escrow Officer can be changed. 
 
The name entered into the County field will be the default value loaded into the county field in each 
escrow file opened under the branch number being established. It can be changed in each escrow file 
if need be. Usually, transactions opened by an office will relate to properties from the surrounding 
area. If that is not the case, then the county entered should be that from which most files originate. 
This field may be left blank. If the Enable Washington State Requirements  (Setup Options > 
General ) is on, a Municipality Type  field will also be presented for entry of a default. 
 
The Last EOM Date   (End-of-Month) is identified to specify the “as-of date” for the “EOM” data on the 
Bank Information  and Savings Information  screens (below). This is the starting date from which 
Impact will aggregate data at each posting until the Close Month  function is performed, rolling the 
new end-of-month figure up to be the new starting figure for the next month’s aggregations. For a new 
system, enter the previous calendar month-end date for each branch that is established. 
 
If the Use Alternate Company Name  box is checked, a field will be presented next to it in which to 
enter another company name to be used on letterhead and other documents for this specific branch, 
rather than the name established for the database-wide company (through System Files > XREF ). 
 
The Default Underwriter  for the office is selected near the bottom of the screen. If an underwriter is 
selected here, it will automatically be loaded on the Initial Questions Dates/Transaction Information 
screen after an escrow file is opened. The default underwriter can be changed before the order is 
sent to Title from Escrow. If 0-None  is selected on the Branch Information  screen, then the default 
underwriter established under System Files > Setup Options > General  (for the entire database) 
will be loaded into the Initial Questions Dates/Transaction Information screen. Up to ninety-nine 
underwriters can be set up in Impact/SQL. They are set up in the Impact Title module under 
Documents > Document Maintenance > Edit > Underwrit er Menu Table . 
 
The Email address  field is used for e-mailing of title orders. This enables routing to one or more 
persons or to a department (with an e-mail distribution list). To use this option, enable it first by going 
to Utilities > Setup Options > General  tab (not in Batch Processor options) and enable the option 
Do not print the Title Instructions Email Instead . An e-mail account will need to be configured for 
use by the Batch Processor session. The e-mail address entered on the Branch Setup  screen is for 
the recipient(s) in the Title Branch(es).  
 
The Branch Active  Yes/No  radio button is used to “turn off” a branch if it is closed. The No setting 
will prevent users from creating new escrows within the branch, but will not prevent users from 
working files that have already been opened in the branch. Reconciliations can continue to be done  
for escrow trust accounts that involve transactions originated at the “turned off” branch. This toggle 
also permits the system administrator to set up branches in advance of their “go live” date (by 
creating them, but making this setting “No”) and then switching them “on” at the appropriate time. 
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BANK INFORMATION 
The second tab of branch information relates to the 
escrow trust account(s) (called “Banks” in Impact) 
used by the branch and the numbering sequences to 
be used for checks, receipts, deposits, and wires out 
for each branch/bank account combination. On an on-
going basis, this screen (shown to the right) will also 
present the aggregate month-to-date posted 
accounting balances for each branch/bank account 
combination.   
 
Before a bank account can be related to a branch, the 
bank account must be established within Impact. This 
can be done in Utilities > S ystem Files > Banks > 
New or Accounting > Mi sc. > Set Up Bank  > New. 
The assumption will be made here that the bank has 
already been set up. 
 
To relate a bank account to a branch, click on the Add  
button under the Banks assigned to (###) branch 
name  section of the screen. A listing of candidate bank accounts will be presented. Select the desired 
bank account from the list presented by clicking on it and clicking OK. If you clicked on Add  in error, 
click on Cancel  on the Banks  screen to return to this screen. Up to five accounts may be assigned to 
an escrow branch and all bank accounts must be assigned to the Accou nting “999” branch .   

Normally, one bank is tagged as the Default bank for this branch  with the check box of that name. 
Regardless of the default selected, the bank account selected for the first receipt entered into a zero-
balance file sets the bank account for the escrow ledger.  

Once a bank has been related to a branch, the next step is to assign starting numbers for the 
numbering of Checks, Receipts, Deposits, and Wires Out . To enable edits in the number 
assignment area and to see current running totals, a bank must be highlighted in the Banks 
assigned to…  area and the Modify  button clicked. 

There are three options for governing how numbers are assigned to these items: by branch, by bank , 
or by a check control branch. The radio buttons indicate your selection.  

Beginning with Checks , the first tab in this section, the alternatives are: 

• By Branch : this selection can be appropriate if you have separate accounts for each branch, 
but the “by bank” option will serve in that instance as well. This option is a holdover from the 
time when Impact was designed for “remote-main” processing and it was more difficult to 
share information across the full company. With the use of a SQL database, this problem is 
gone and the need for a By Branch  option is minimized, but it is still available. Should your 
company be using pre-numbered checks out of a dot-matrix printer (not recommended), you 
may still want to use this option. If multiple branches are using one account, great care must 
be taken to space your starting check numbers sufficiently apart from branch to branch to 
prevent one branch from “running into” another. If this selection is made, enter the starting 
number in the field to the right of this radio button. As the account is used (checks are 
issued), the number that appears in this field will increment up. The first check printed will be 
numbered one higher than the number entered here. 

NOTE: while the field for check number can hold up to 15 digits, many banks are limited to 12 digits 
(or less) for their check numbers. Confirm your bank’s limit before determining the numbering scheme 
for your company. 
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• By Bank : this is the most common and recommended setting in the SQL environment, with 
laser printers, using MICR toner, to generate checks on blank check stock. Whether you have 
separate accounts for each branch or not, using this setting will govern the administration of 
check numbers across all offices that are using the account. If this selection is made, the 
starting number entered in the field to the right of the radio button will be set with the first 
branch set for that bank and then should be auto-filled for all subsequent offices assigned to 
the account. This field will reflect the last number used as checks are issued. 

• By Check Control : this option should be selected ONLY if you are using one account for 
multiple branch numbers AND have other branches that are also sharing the account which 
will have unique sequences assigned to them. In this situation, you cannot use the By Bank 
option, as not all of the sharing units will be pulling the next available number from a single 
point. This is most applicable to physical locations that may have multiple operating units 
(‘branches’) within them and which are using pre-numbered checks printed out of a dot-matrix 
printer (not recommended) and where not all of the branches are to pull from the same 
starting number. For those offices that are sharing a number sequence, select the control 
branch option. Rather than entering a starting number under this option, you will enter a 
branch number, the check control branch. The Check Control Branch  will need to have 
already been set up and, within its configuration, the bank account will have been selected 
with the By Branch  option and a starting check number. This may be a “real” branch; it does 
not need to be a “dummy” branch number. However, it is recommended that a “dummy” 
branch number be used, as there are fewer potential complications than if an active branch is 
used (if, for example, the base branch is closed or merged with another office). The name of 
the dummy branch should indicate it is a control branch – making its purpose obvious. 

 

The Receipts  tab is identical in presentation. The considerations in assigning numbers to receipts are 
also similar. The By Bank option is common and recommended in most instances as this prevents 
the chance of duplicate numbers being assigned to receipts within one bank. It also permits a 
Receipts Journal to be run by bank so that missing receipts can easily be identified (when 
troubleshooting issues). Some companies wish to tag their receipt numbers with the branch number 
in the leading digits (for example: “0562000000000001”, for branch 562’s first receipt). This helps the 
Accounting staff to identify the branch responsible for a receipt quickly. In this instance, you would 
need to use the By Branch  or By Check Control  options. As each company’s environment is 
unique, how the numbers are to be assigned is left to each company, but the options should be 
carefully considered before a decision is made. 
 
The Deposits  tab is also identical in presentation and the considerations are similar to receipts. The 
By Bank  option, again, is recommended in most instances. 
 
The Wire Out  tab, again, is similar. Wires out are considered disbursements in Impact/SQL (since 
version 5.4), but the banks generally do not track the originator’s numbering (as they do with checks), 
so the numbering scheme is for internal use only. Again, the By Bank option is recommended in 
most instances. Wires out are numbered regardless of whether the Wire Out Processing feature is in 
use or not. 
 
The month-to-date aggregate information, shown in the bottom left of the screen once an account has 
been highlighted, is of use when troubleshooting issues. As daily posting is completed, the “buckets” 
are incremented up by the total amount for each type of transaction for the branch/bank account 
combination. When the Close Month  function is run, the final Current Balance  will be moved up to 
the EOM Balance  and the other buckets will be cleared out in anticipation of the new month’s data 
coming in. The Current Balance  should match your Trial Balance total for the branch/bank 
combination. On rare occasions, these figures might need to be altered, but that should only be done 
under DSI direction. The Accounting Audit tests these figures verses the Trial Balance. 
 
The Delete button is used to remove a bank from a branch. It does not delete the bank from 
Impact/SQL. 
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SAVINGS INFORMATION 
The screen under the Savings Information  
tab presents the aggregate month-to-date 
totals of savings activity for the selected 
branch. When creating a new branch, these 
figures will be zero and nothing need be done 
on this screen unless a starting balance is 
required when switching from another system 
to Impact. The Current Balance  should reflect 
the total of the Savings Trial Balance as of the 
current posting date. 
 

 
 
 
 
 
 
 
 

 

TITLE DEPARTMENTS 
Impact can be configured to permit more than 
one Title Department to be made available to 
the branches. However, at least one title 
“branch” must be set up before branches can 
have it assigned to them. If more than one title 
branch is set up, this screen will be made 
available.   
 
A branch designated as a “Title” branch will 
not have the Title Departments  tab presented 
in the Branch  configuration module. 
 
The Title Departments  tab presents a listing 
of the previously selected title units, if any, 
available for use by the branch being 
configured. This will be blank for a new branch 
setup. There are Add,  Delete, and Set as 
Default  buttons on this screen. Clicking on the Add  button will bring up a window from which you will 
select a title unit. Highlight the desired title unit and click on the OK button. Repeat if there is more 
than one title unit available in the database and you wish more than one to be available to the branch 
in question. Click on OK, at the bottom of the screen, to indicate you are finished with selecting title 
units for the branch, and wish to save maintenance done on the other tabs. If multiple title units are 
available to a branch, one can be set as the default by clicking Set as Default. This will automatically 
highlight the default title branch for the escrow user. 
 
Once one or more title units are assigned to a branch, they will be available, within the Escrow 
module, with regard to where a title order should be directed. 
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MODIFY 
The Modify  button, when hit after a branch is highlighted, will present the user with the same set of 
screens discussed above under System Files > Branch > N ew, but now there will be data in the 
fields. This function is used to update branch configurations and to view the month-to-date figures for 
each branch/bank account.  
 
Care should be taken when changing some settings (such as how check and other item numbers are 
assigned) once they have been in use.    
 
The Branch Active Yes/No radio button is used to turn off a branch if it is closed, merged with 
another, or sold, for example. The No setting will prevent users from creating new escrows within the 
branch, but will not prevent users from working files that have already been opened in the branch. 
Reconciliations can continue to be done that involve transactions originated at the “turned off” branch.   

DELETE 
The Delete  button will only be effective if no activity has occurred with a branch that had previously 
been configured (if it was set up in error, for example). Once a branch has activity, it cannot be 
deleted. 
 

CANCEL 
The Cancel  button closes the Branch function and returns the user to the main Utilities screen. 
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BANKS 

The Banks  function, under System Files , provides for the entry of new escrow trust accounts (called 
“banks” in Impact) into the system and for the editing of settings for existing bank accounts. This 
module is exactly the same as that found in the Impact/SQL Accounting module, under Misc. > Set 
up Bank . Generally, the system administrator or USA Digital Solutions, when setting up the system 
the first time, would use this function in Utilities and then the Accounting staff would use the function 
within Accounting on an on-going basis.   
 
NOTE #1: When a new bank account is established, USA Digital Solutions must create the laser 
check and laser deposit slip report template files. Please give DSI as much advance notice as 
possible of plans for utilizing a new account.  
 
NOTE #2: The bank’s specifications for its reconciliation export and positive pay import files must also 
be forwarded to Digital Solutions so DSI can confirm that the filter programs already in existence will 
work properly or create new filter programs as needed (at least if you intend to use a bank download 
in the reconciliation process and/or intend to upload check issue data to the bank for positive pay 
processing). 
 
When this function is selected, a Banks  screen is displayed presenting the bank accounts that have 
already been set up in Impact/SQL. Within Impact, the word “bank” is used to mean escrow trust 
account.  Every escrow trust bank account will be assigned a separate number within Impact/SQL 
even if at the same bank. The bank number (within Impact), name, and account number are 
presented along with similar New, Modify , Delete , Print,  and Cancel  buttons seen on the Password 
File screen and the Branch File  screen (discussed above).   

 

 

 

 

 

 

 

 

 

 

Once a bank account has been established, it must a lways be assigned to the Accounting 
branch “999” and to each branch that will be using th e account. 
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NEW 
To add a bank account into Impact, click the New button and the screen below will be presented. 
Note:  that the next sequential bank number is automatically selected as the next number to be used. 
You may not change this selection. 
 
When a bank account is initially set up, you may wish to make it inactive (Bank Active: No  radio 
button) until the real “go live” date is reached. (Accounting users still have access to the bank 
account.) Then, at the time you wish to make the bank account available to users, you will click on the 
Bank Active: Yes  radio button. 
 

  
The Name of the financial institution 
and its Address  are entered in their 
respective fields.   
 
The Account Number  is entered into 
its field. Note:  if bank downloads are 
used with the reconciliation process 
(with the Outside Services  function) 
the account number entered here 
should be in the same format as seen 
in the bank download. You do not 
have to worry about this initially, but if 
the import in the reconciliation fails 
with a message that the “File Format 
is Invalid”, you may need to change 
the account number format here. For 
example, the bank export may have a 
number of leading zeros before the 

account number that would need to be entered here. This field can be altered without impacting 
checks as they do not get their number from this field (for security reasons). 
 
The Last Statement Date  and Last Statement Balance  fields are used by the reconciliation module 
as starting figures. They should be left blank for a new bank set up. 
 
The Overhead Fee Escrow No  is used if the system is configured to use overhead fee accounts 
(Utitlies > System Files > Setup Options > Accountin g > Enable Overhead Fee Account ). If so 
configured, this is the escrow file into which the company’s fees (“:T” payee) would be automatically 
transferred upon disbursal at closings. The fees can then be taken, en masse, from this escrow on a 
periodic basis (daily is recommended). A separate escrow file per bank account must be set up and 
the number / name of the escrow is entered in this field. The overhead fee escrows must be set up 
under the Accounting branch “999”. As the ledger’s for Overhead Fee Accounts can get very large, 
you may wish to create new files for each account once a year. 
 
If the Incoming Wire Processing  and/or Outgoing Wire Processing  functions are enabled, there 
will be a field for Max Length of Other Wire Reference  in which a figure is entered to limit the length 
of the Other Wire Reference  field seen in those functions. 
 
Wires at the bank will stop being initiated at the Cutoff Time  specified here. This time will print on the 
wire forms. The time entered will not impact the entry of wire information within Impact/SQL. 
 
The Date Closed  field will reflect the date the escrow trust account was “closed” within Impact.  This 
field would be left blank for a new account setup. 
 
Click on OK to save your entries or Cancel to close the form without saving your entries. You will 
return to the Banks table.  
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MODIFY 
To view the detail on an existing bank account or to change the existing information, highlight an 
account on the Banks  listing and click on the Modify  button. The same screen shown above under 
the New discussion will be presented, but with the fields filled with the previously entered data. The 
current (last reconciled) bank statement date and balance will be in their respective fields.   
 
You cannot change the bank number. 
 
You can change the Bank Active status if you are “turning on” an account or “turning off” an account. 
If a bank account that has activity against it is made inactive, no new escrows will be permitted to be 
assigned to the bank, but existing files with balances may continue to be worked off. Postings and 
reconciliations will continue to post to the account. 
 
You can change the Bank Name and Address  information and, if needed to accommodate a bank 
export reconciliation file, you can change the Account Number’s number of leading zeros or 
punctuation (see the discussion above under “NEW”). 
 
You would enter the date the account was closed, in the Date Closed  field, once all outstanding 
items have cleared the bank and the account has been reconciled to zero. 
 
Click on OK to save your entries or Cancel  to close the form without saving your entries.  

DELETE 
A bank account can only be removed using the Delete  button if there has not been any activity on the 
account. Activity includes receipts, checks, wires in, and wires out. If a bank account were set up in 
anticipation of use, but was not used, it can be deleted. 
 

PRINT 
The Print  button will generate a report of all of the bank account information sorted by bank number.  
 

CANCEL 
The Cancel  button will return you to the main Utilities  screen. 
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IRS REPORTING ENTITIES 

The screens under System Files > IRS Reporting Entities  must be completed to provide accurate 
information on all 1099-S forms issued out of the system and to identify the transmitter information for 
reporting 1099-S information to the Internal Revenue Service. 
 
The screen is presented below. The Name and Address  of the company should be entered along 
with the Tax ID Number (TIN) of the firm. Do not include the “-“ (dashes) in the TIN fields. Make sure 
to enter the contact information as well. If a different firm is responsible for transmitting the data to the 
IRS annually, then the information on the right side of the screen will be different from that on the left. 
Otherwise, it will be the same, with the addition, at the top of the screen, of the transmitter’s TCC 
Number (received from the IRS).  
 
Multiple reporting entities can be set up in Impact/SQL. The appropriate reporting entity for each 
branch is selected on the Branch Information  screen. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
USA Digital Solutions, Inc. is the transmitter of 1099-S information for many of our clients, there is a 
fee for this service , and in that situation, the information on the right side of the screen would be 
USA Digital Solution’s. (What is shown above is sample data.) 
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ESC/DO NUMBER 

During initial setup, the starting escrow number to be used by the system needs to be established, if 
automatic assignment of numbers is turned on in System Files > Setup Options > General . 
Automatic escrow numbers may be assigned within a branch or system wide, again a setting 
controlled in Setup Options . Depending on which setting has been selected, when you select 
System Files > Esc/Do Number , you will see one of the following two screens: 
 
Escrow Numbers Assigned by Branch              Escr ow Numbers Assigned System Wide 

 
By Branch:  if this is the configuration option selected, you will need to enter a Branch Number  and 
then the starting and ending escrow numbers to be used by the system for that branch. If you enter 
the Title “099” branch number, you will be entering the range for Direct Order (DO) numbers. You will 
need to enter a range for each branch in the system. The Next Escrow Number  field will increment 
up as files are opened. The numbers assigned by branch cannot overlap. The numbers can be up to 
eight positions and may be all numbers or a combination of alpha and numeric. The Last Escrow 
Number will limit the automatic numbers issued to the range specified.  
 
System Wide : if this is the configuration option selected (recommended), you will enter only the 
starting number for each type, Escrow Number / Direct Number , or just one number if you check 
the Escrow/Direct the same box . The number(s) will increment up as files are opened. The 
numbers can be up to eight positions and may be all numbers or a combination of alpha and numeric. 
 
Once an entry has been made, click on the OK button to accept it or Cancel  to quit without accepting 
the change. 
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UPDATE TITLE FILE NUMBER 

This System Files menu option will only appear if in 
Setup Options > Title  > Enable Title File 
Numbering  option is selected. This option is used if 
Title wishes a different numbering scheme used on 
escrow files to represent the Title File Number . This 
is not used with Direct Orders. If this option is 
enabled, then it will present the screen displaying 
the next Title File Number  to be assigned. This 
number can be changed from this screen.   
 
This applies to each of the three options presented under Setup Options > Title  > Enable Title File 
Numbering > Assign Title File Number at :  When File is Opened , When File is Ordered , and 
Manually . 
 
 
SET POSTING INFORMATION 

The starting information on this screen is entered at the original configuration of the system. The 
information will increment as transactions are entered (Transaction Number ), as postings are done 
(Date Last Posted ), and as the Close Month function is performed (Current Posting Month ).   
 

 
 
These values should NOT be changed except 
under USA Digital Solutions’ direction. 
 
 
 
 
 
 
 

 
 
SET NEXT INVOICE NUMBER 

During system configuration, the starting invoice and pre-bill 
numbers will be established on this screen. The values will 
increment up as invoices and pre-bills are generated. ‘Pre-
Bill ’ is an option for invoices that presents estimated 
charges for work to be performed. Different invoice forms are 
designed for pre-bills than for regular invoices. 
 
Care should be taken in changing these numbers once they 
have been established to prevent duplications. 
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PRINTER SETUP 

Each workstation or user’s work session must have printers defined within Impact/SQL AFTER 
printers have been established through Windows or the network operating system. Impact/SQL does 
not simply utilize the default Windows printer. Generally, two printers are defined: one Documents / 
Report Printer  and one Check P rinter  (also for deposit slips). Generally, both printers are laser 
printers and the check printer is loaded with MICR toner so that its output can be “read” by bank 
check processing equipment.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As most users do not have access to Utilities, this function is also available under the Misc.  menus in 
the Escrow, Title, and Accounting modules.  The printers presented are those configured for the 
user’s Windows session. 
 
The document printer to be used is selected by highlighting it. The paper source selection boxes are 
normally set to Auto Select , but can be fixed to specific trays. Click on the second tab to select the 
Check P rinter . 
 
Click on the Cancel  button to quit without saving any changes. Use the OK button to save and exit. 
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SETUP OPTIONS 

The primary configuration of all of the Impact modules is done through System Files > Setup 
Options . The settings established here are based in large part on the Configuration Worksheet 
completed by the company prior to installation of Impact/SQL and the settings will be made by USA 
Digital Solutions personnel. 
 
Extreme care should be taken when making changes to  these settings, especially after the 
system has been in operation, as they can have dras tic ramifications to the behavior of the 
system. Changes should be discussed with USA Digita l Solutions prior to being made if there 
is ANY doubt as to the effect of the change. 
 
There are six categories of setup options.   The categories are: General , Escrow , Title , Accounting , 
Word and Email  Options. Each of these will be discussed in detail below. A “check” in the box in front 
of each option means it is enabled. 
 
 

GENERAL 
The Genera l options relate to functionality that crosses modules and so are not put on the Escrow 1, 
Escrow 2 , Title  or Accounting  tabs. The General  tab is presented below and details about each 
setting follow. The examples shown should NOT be considered “typical”; each company’s 
configuration will be unique, as there are many options and every company operates in different ways 
from others.  
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File Numbers Assigned by Each Branch : This option is used in conjunction with having file 
numbers automatically assigned. If checked, then the number ranges for files at each office must be 
set under System Files > Esc/Do Number . See that section of this manual for a discussion of that 
function. The alternative is file numbering with one sequence across the database. 
 
Enable Tracking : This option controls the Tracking function that provides a place where dates can 
be recorded relating to the start date and completion date of various requirements of each file. For 
example, some items might include: demand for the payoff for the 1st mortgage, the appraisal, and 
the termite inspection. A default tracking table can be established under Utilities > User Tables > 
Tracking Descriptions > Escrow (or Direct Order) for both Escrow and Title. The tables may be 
customized by file as well. The entries of the Date Ordered  and Date Received  are made manually 
through the Escrow and/or Title modules. 
 
Shut Down Word on Exiting : When checked, this option will cause MS Word to close every time a 
user exits Impact/SQL. It is generally not recommended that this setting be selected, as MS Word will 
close even if a non-Impact document is loaded. 
  
Enable Alphanumeric File Numbers : Allowing alphanumeric file numbering permits users to use 
letters in their file numbers as opposed to just numbers. This can come in handy when establishing 
Project files or naming files for training purposes where the “name” of the file is a handy reference 
rather than the users having to remember a specific file number. In the normal course of business, 
however, if automatic file numbering is turned on, most file numbers will be numeric and sequentially 
issued – only a manual assignment would be done alphanumerically. 
 
Enable Incoming Wire Processing : This option controls whether the incoming wire processing 
functionality of Impact/SQL is turned on. With this function turned on, Escrow users fill out an 
incoming wire screen on an anticipated wire, which is then reviewed by Accounting. The funds 
associated with that wire are not receipted into the escrow file until Accounting has provided a Fed 
Wire ID upon confirming the physical receipt of the wire at the bank. This can help limit overdrafts as 
the receipting of wired funds is more controlled, as wires should not be receipted into multiple files. 
The option to Prompt for E-mail on Wire In is made available if incoming wire processing is turned 
on. This option will result in a prompt asking the Accounting user if they want to e-mail a notice going 
to the originator of the information on the incoming wire screen and the escrow officer on the file (if 
not the same person) as opposed to just having that option available from the print control screen 
after modifying the wire. 
 
Enable Outgoing Wire Processing : The outgoing wire processing functionality is separate and 
distinct from incoming wire processing. Some companies may use one, but not the other, depending 
on their structure and distribution of responsibilities. This process has the Escrow user complete an 
outgoing wire screen detailing information about the wire they wish to send. The funds are 
immediately withdrawn from the balance in the file. Accounting is then notified of the desired wire and 
when they execute the wire and get the bank confirmation it has gone out (indicated by the provision 
of a Fed Wire ID), a notice is returned to the originator of the request. There is a similar Prompt for 
E-mail on Wire Outs  option as discussed above (Incoming Wires). Another sub-option is Enable 
Holds on Wire Outs . This allows the user to create a wire out request in advance and place a hold 
on it, thereby not releasing it to Accounting. If the file is to be overdrawn by the wire out and overdraft 
protection is turned on, the user will be prompted for the overdraft password. (With the MFS Wire 
Integration  option turned on, the user will not be prompted about the overdraft until the wire out is 
released from the hold.) The last sub-option is Enable Manual Wire Outs in Accounting . This 
option will permit Accounting users to complete the outgoing wire screen rather than just Escrow 
users.   
 
Enable Dual Authorization for Wire Outs : An option to provide for dual authorizations of wires out 
has been developed. There are three variants of this feature, two are for specific clients and one is for 
all clients’ use. This option, when enabled, will provide a Wire Approval screen and users must be 
configured as either a Wire Out Approver  (requires another approver’s interaction) or Wire Out Self 
Approver (does not require a second approval) in the Password  file.   
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Enable MFS Wire Integration : (This is only applicable to ex-Mercury Companies, Inc. 
subsidiaries.) When MFS Wires Integration  is checked, the following changes are made to the 
basic wire processing systems:  
 

1. Wires Outgoing  - Modify and Delete  are only available when a wire has been put on 
hold; 

2. Wires Incoming  - the following fields are set to N/A and are not shown on the form: Wire 
Reference, Bank Name, ABA, and Customer Name. The Account Number is set to the 
bank account number of the escrow bank account;  

3. When creating a wire and placing it on hold, the account can be overdrawn even if 
overdrafts on wires is disabled; and, 

4.  The Held Wire Out report has been modified to include the hold reason and the notes to 
Accounting. 

 
Enable Automatic ID Numbers in NAF : The NAF (Name and Address File), with this option turned 
on, issues a unique ID number for each entry in it. This can be useful when integrating data from the 
NAF with other, non-Impact systems such as a general ledger accounts receivable package. 
 
Central NAF File : Having a centralized NAF, where all users share the same file, when combined 
with a limited number of NAF administrators, can greatly enhance the effectiveness of the NAF. This 
will help limit redundant entries, making it easier for the users to find and select the correct entry, and 
can make managerial reporting of more use by limiting data-splitting across the redundant entries. If 
this option is not turned on, there will be a separate NAF established for each branch number. 
 
Allow Automatic Escrow Numbers : Turning this option on, which will then require completing the 
System Files > ESC/DO Number  screen, will provide for automatic and consecutive numbering of 
escrow and direct order files. If not selected, then the user will be forced to enter a unique file number 
manually. 
 
Allow Manual Escrow Numbers : If the company wishes to permit the users to enter manual 
numbers, even if automatic numbering is turned on, this option should be checked. This is useful, for 
example, when transferring from another system to Impact/SQL and you wish to be able to enter 
numbers already established on the other system as you transfer file information to Impact/SQL. This 
option will also be required to be turned on if you want the users to have the ability to enter 
alphanumeric file names for Projects, Overhead Fee Accounts, or training files, for example. 
 
Allow Automatic Direct Order Numbers : This is similar to automatic escrow file numbers above, 
but for direct orders. Note:  in the System Files – ESC/DO Numbe r screen, you can tell Impact/SQL 
to use the same automatic numbering scheme for both escrow and direct order files. Also, if Direct 
Orders are not used by the company, Automatic Direct Orders  will be enabled as a default. (One 
type of Direct Order setting is required.) 
 
Allow Manual Direct Order Numbers : This option is similar to manual escrow numbers above, but 
for direct orders. 
 
Enable Documents by State : if a company operates in several states and is using a common SQL 
database for those operations, Impact/SQL can customize the Escrow menu for master documents 
with documents unique to each state. This is driven by the state identified on each branch definition 
screen. This option should not be turned on and off as that can cause major problems with the 
Escrow document menu. 
 
Enable Multiple Title Departments : this option permits the existence of more than one title 
department branch. If turned on, each escrow branch that is set up must be linked to one or more of 
the title departments that are established. See Branch Setup > Title Departments  tab. 
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Print Deposit Slips on the Check Printer : if turned on (recommended), this option will route all 
deposit slips to the check printer where they will be printed on the blank check stock with MICR toner. 
Also, the encoding will be done in the MICR font. This will result in an item that can be “read” by 
banks’ item processing equipment. Users will then not need to prepare a deposit slip manually and 
the company will not have to purchase pre-encoded deposit slips. This may limit deposit slip errors 
and enhance reconciliation efforts. 
 
Enable Washington State Requirements : For Escrow, this option brings up a different HUD1100 
screen, which allows Escrow users to do the tax calculations on each line item. For Title, this brings 
up a different prelim entry form, which allows Title users to enter or calculate the taxes on the 
premiums. It also provides additional DDE fields that are specific to taxes to be used in documents for 
Escrow and Title. The User Tables > Excise Tax Table  will be enabled if this option is enabled. On 
Escrow files, Government and Recording fees includes an excise tax calculation. 
 
Retain Check Stub Information : when turned on, this option will provide for full check stub details to 
be retained and presented on the Final Disbursement report. This is opposed to the information just 
being available on the Preliminary Disbursement report prior to checks being issued.  
 
Enable Sub-Escrow : This functionality was created for use in the Southern California market 
primarily. Both the Title and Escrow modules will reflect changes if this functionality is turned on. In 
the Title module, screens have been made available on a three-tab window for the Title Officer to 
enter Title, Recording, and Additional charges. Within the Escrow module, a set of menu options 
dedicated to “sub-escrow” behavior has been created consolidating existing functions together for 
ease of use by the “sub-escrow” user. A special user level access of Sub-Escrow  has been created 
and only those users will see the changes. 
 
Enable warning message when accessing a closed file : When this option is enabled and a user 
tries to access a closed file, a pop-up notification will be received similar to that received when a 
cancelled file is accessed. 
 
Default Underwriter : Up to 99 underwriters can be set up in Impact and established in the Title 
module, under Document Maintenance . One of the underwriters is identified in this field as the 
default underwriter for the entire database. This underwriter will appear on the Initial Questions 
Dates/Transaction Information screen when a file is opened. Escrow or Title users may override the 
default underwriter, file-by-file, as necessary. The default underwriter set here can also be 
superseded branch-by-branch with the selection of a different default underwriter on the branch setup 
screen. 
 
Configure Interfaces : This option is used by the USA Digital Solutions staff to configure various 
Impact/SQL integration interfaces.  
 
Use Central Archive : Archiving of Impact data is currently not an option in Impact/SQL. When it is 
made available, this option will allow the function to be used. The accompanying fields will identify 
where the archived data will be stored and how it can be accessed (user name and password). Older 
versions of Impact (pre-SQL) provided for the archiving of escrow data, ledger data, prelims, policies, 
and legal descriptions. An archive search mechanism would permit, for example, Title to search the 
archive file for a base. Accounting could search for and reprint ledgers. Escrow might search for and 
reprint a HUD or Settlement Statement. 
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Enable File History Log : Certain events that occur within Impact/SQL when you access a file are 
now tracked and written to a history log when this option is enabled. If enabled, you can select the 
File > View Escrow History  menu in Escrow or the File  > View File History  menu in Title to display 
the History Log screens. Tracked events may only pertain to certain modules of Impact/SQL, as 
listed in the table below. 
 

Escrow Module  
File initially opened 
Change of file status (cancelled, closed) 
Title Instructions printed 
HUD printed 
User opens a file 
Change entry type 
File copied (escrow) 
Title Module  
File initially opened 
Change of file status (cancelled, closed) 
Title Instructions printed 
Commitment typed 
Commitment released 
Policy typed 
User opens a file 
File copied (direct order) 
Accounting Module  
Change of Branch ID 

 
 
Enable USPS in NAF : This option is not available at this time.  
 
Do not print the Title Instructions Email Instead :  
 Send Email to Title Officer 
 Send Email to Title Department 
This option allows The Title Instructions to be routed to one or more persons or to a department 
instead of being printed. An e-mail account will need to be configured for use by the Batch Processor 
session or DSI Service. An e-mail address for the recipient(s) is entered on the Branch setup screen 
for the Title Branch(es).   
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Prompt for Automated Title Search : This option is only available if DSI Messaging is installed, with 
title providers. If not, this option is grayed out.  
 
HUD/Worksheet Stamp : This option enables the ability to add an image/stamp, to a user’s Password 
setup, that will appear on the HUD or Settlement Statement.  The image files should be a small  
(<64K) bitmap (BMP) file.  See the Password section earlier in this manual for image assignment 
details. 
 
Allow Invoice Date to be Changed :  When un-selected, the system will be set to only allow the 
current system date to be used on new invoices and no invoice dates will be permitted to be edited. 
 
Print Full Legal on Title Instructions :  This option, combined with properly configured Title 
Instruction report templates, can be used to control whether the full legal description is presented on 
the Title Instructions.  This trigger is combined with a process change that moved the preparation of 
the full legal for use in the Title Instructions from the Batch Processor’s routine to the time of ordering 
of title work. 
 
Click on the Cancel  button to close Setup Options  without saving your changes or click on OK to 
save your changes and close. It is a good habit on these screens to click on Cancel  if you were just 
viewing settings just in case a setting was changed by accident. Only click on OK when you definitely 
want to preserve a change. 
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ESCROW 1 
This is the first of two configuration screens for the Impact/SQL Escrow module. The tab of Escrow 1  
options is extremely detailed. The range of options provides for the establishment of quite different 
operating environments for users of the Impact/SQL Escrow module. The example shown should 
NOT be considered “typical”; each company’s configuration will be unique as there are so many 
options and every company operates in different ways from others. Each option will be explained 
below. 
 

 
 
Worksheet Entry Only : Some companies prefer a Worksheet  entry format, like a settlement 
statement layout, with the buyer and seller debit and credit columns all presented at once and insist 
on it being the only option. If this is the case in your firm, then the HUD and Worksheet Entry  would 
be unchecked and this option would be checked. 
 
HUD and Worksheet Entry : With this option enabled, it is up to each user what form of data entry is 
preferred. The Default: sub-option of which type of entry form is to be used, HUD or Worksheet , will 
pre-suppose for the users which format they will use, but they can still pick the format they prefer. The 
HUD entry form reflects each line number of the standard HUD. Again, regardless of the manner of 
data entry, either the Settlement Statement or HUD can be generated. Note: Once the form of data is 
selected on each file, it can be changed – this is a new feature with 7.0.  
 
Close Escrow File on Issue of Fees : When this option is enabled, it will cause the date of the fee 
check/fee slip to be entered into the Close Date  and Recorded Date  fields within Impact/SQL 
Escrow. The “fee check/fee slip” is identified as the check/slip issued to the “:T” payee (read “colon 
T”, for Title Company). If the company’s policy is to issue fee checks on the day of closing, then this 
option helps to guarantee that the files are properly tagged with the correct closing date. If fees are 
routinely, by company policy, taken before or after the formal closing date, then this option should not 
be turned on. If turned off, the escrow staff must be trained to routinely enter the appropriate date(s) 
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into the Close Date  and Recorded Date  fields or reporting that keys off of those dates will be 
meaningless. When this option is turned on, the Allow Escrow to Close Files Manually  option 
within Escrow can be disabled so the only way a file can be flagged with a Close Date  is with a fee 
check/fee slip being issued. The only way to change a Close Date  if being forced from the fee check 
is through Utilities > Tools > Update Escrow Information  if the Allow Escrow to Close Files 
Manually  option is disabled. The Close Date  appears on the Trial Balance report and on some MIS 
reports in addition to being stored in the ledger. 
 
Allow Escrow to Close Files Manually : if this option is turned on, the user can, or must, if the 
previous option is not turned on, enter the close date for a file without involving the fee check/fee slip 
process. This option adds Close File  to the Escrow Disbursements  menu. Note:  the Close Date  in 
Initial Questions is not the same field; it is just an estimated Close Date. It does not close the file. 
 
Allow Overdrafts with Password : there are two methods available to the company for handling 
overdrafts (caused by a check): (1) with passwords or, (2) the company may choose to forbid 
overdrafts completely. Leaving this option unchecked will prevent overdrafts caused by a check from 
being permitted in any instance. Checking this option permits overdrafts with two different safety 
mechanisms: dynamic or static passwords. The sub-option Dynamic Password , when checked, will 
trigger the use of a two-step password routine if a user tries to disburse more funds than are in a file. 
The user will be presented with a “key” (set of numbers) and will be prompted to call the responsible 
Accounting user for the password that goes with the key presented. The Accounting user will enter 
the key provided by Escrow into the password module in Accounting and a unique key will be 
returned which is then given to the Escrow user to be entered into that system. This password will 
permit the file to be overdrawn. A log of all of the instances of overdrafts being authorized through this 
mechanism is maintained in the system and can be printed out. If Dynamic Password  is not 
checked, but Allow overdrafts with password  is checked, then another field will be presented on 
the screen into which a static (unchanging) password is to be entered. Selected users will need to be 
given this password with which they can permit a file to be overdrawn. As static passwords tend to 
get pretty wide distribution quite quickly, the dynamic approach is safer, but it takes more time in 
execution at each overdraft. If a static password approach is taken, routine changing of the password 
is highly recommended and serious training on limiting its distribution is necessary. 
 
Require File Balance = 0 Prior to Disbursement : If this option is enabled, it will require 
disbursements to completely exhaust the funds in a file each time they are made. Checks and/or 
wires out must exactly total all of the funds receipted in the file at the time of the generation of checks. 
This will prevent held funds from being an issue, but can raise some difficulties in practice. 
 
Fee Options: Check or Transfer Slip : With the selection of the Check  option, a check must be 
physically generated out of each file to provide for the collection of company fees (escrow, title, and 
miscellaneous). The company check is identified by the use of the “:T” payee (read “colon T”). When 
“:T” is entered in the payee field during data entry on the HUD or worksheet, it means the funds are to 
be issued to your company. These checks must then be endorsed and deposited into the operating 
account.   
 
The Transfer Slip  option can be a great timesaver and involves no negotiable instruments. If there is 
only one bank account involved with each branch or only one being shared by several (or all) 
branches, then you can select this option with two alternatives for how fees are tracked for transfer to 
the operating account and stop the generation of fee checks file-by-file. In lieu of checks, transfer 
slips (aka fee slips) will be issued, when the “:T” payee is used, on the document printer and the fee 
information (dollars by income code by file) will be entered into the Income Analysis system. 
Reporting from that system can support the routine transferring of funds from the escrow trust 
account(s) to the company’s operating account. The funds may also be transferred to an “overhead 
fee account” (another escrow file) should the company desire to see the funds retained on the Trial 
Balance until physically moved to the operating account. (See Setup Options > Accounting > 
Enable Overhead Fee Account  for more information).   
 
However, should multiple accounts be used at a branch, the reporting out of the Income Analysis 
system cannot be relied upon to support the transfers until a “Bank” break is added to the report. 
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Overhead fee accounts can be used in that situation in conjunction with fee transfer slips; there must 
be an Overhead Fee Account (OFA) for each escrow trust account. With the use of overhead fee 
accounts, the funds are either disbursed by check from the overhead fee accounts, after being 
collected there via the transfer slip function, by wire out disbursement, or negative receipt in the case 
of a bank transfer.   
 
Voids of fee transfer slips are managed smoothly by passing the reversing entries to the Income 
Analysis system and overhead files, if used, thereby netting down subsequent transfers to reflect the 
voiding of a previously taken fee. 
 
The Set Number  option is required. When this option is clicked, it will ask for the next fee ticket 
number. The number cannot be 0, and the numbering sequence must not conflict / overlap with the 
check numbering sequences of any of the banks set up in Impact.  Generally, a high starting number, 
with many more digits than those of the banks’ check sequences, is utilized. 
 
Allow Escrow to View/Print Income : The company can control whether they wish Escrow module 
users to be able to view and/or print their own income information from the Reports  menu. The 
Escrow manager will be permitted to print income data for the entire branch while individual escrow 
officers will only be permitted to print their own information. If management does not want this data to 
be available for such access, then this option should not be checked. All income reporting would then 
come out of the Accounting and MIS modules. 
 
Default Print HUD Without Certification : the certification page of the HUD is where the parties to 
the transaction certify that they have reviewed the HUD and concur with what it presents. This option 
determines whether the default setting, when printing the HUD, is for this page to print or not. 
Regardless of this setting, the certification page can be printed, or not, each time the HUD is 
generated. This option just makes the most desired choice the default, thereby speeding up the 
user’s interaction with the system. 
 
Print Sub Agents on Listing/Selling Comm. Checks : To reflect any reductions made to the Listing 
and Selling Agents commissions, through payments to sub-agents, on the commission checks,  this 
option should be turned on. The payments will be noted as line items beginning “(Less) sub-agents 
name” and showing the amount paid as a negative number, reducing the primary agent’s gross 
commission down to the net paid on the check. Up to five sub-agents may participate in each Listing, 
Selling, or Other Broker check. A separate check is issued for each sub-agent’s commission. 
 
Require 1099-S Prior to Disbursement : this option, if selected, will require the 1099-S process to 
have been completed prior to any funds being disbursed from the file. If the file is flagged 
Reportable , the information for one or more 1099-S forms must have been completed and the 
form(s) generated. If the file is flagged Non-reportable , this flag is ignored. This option may enforce 
compliance with the 1099-S process, but may introduce an undesired hurdle for pre-closing 
disbursement items. Impact/SQL is designed for 1099-S forms to be distributed at closing, not for 
mass mailings after year-end. 
 
Remind to do 1099-S after Disbursement : After a user has printed the revenue check, a message 
is displayed if the file is marked as Reportable  and a 1099-S has not yet been completed. The user 
is then given the opportunity to enter their 1099-S information. It is recommended that this setting be 
enabled. 
 
Enable Marketing Reps #3 and #4 : normally, on the Initial Questions > Dates / Transaction Info  
screen, fields are presented for two marketing representatives per file. This option expands the field 
set to four marketing representatives and allows for all four to participate with split percentages. The 
primary rep’s percentage is inferred as 100% less the percentages identified for the others. Marketing 
representatives are established in the system through Utilities > User Tables > Marketing Reps . 
 
Allow Escrow to do Receipt Corrections per DOC Regs : this setting is only applicable to 
companies that fall under the jurisdiction of the California Department of Corporations (DOC); 
“Escrow Only” companies in California. The regulatory requirement is that if funds are receipted into 
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an escrow file and it is determined at a later date that the funds should have been entered into a 
different file, correcting receipts, with the same receipt number on each, are to be entered into the 
original file (with a negative amount) and into the correct file (with a positive amount). This setting 
automates the procedure by allowing the user to answer a few questions (original escrow number, 
receipt number, and new escrow number) and then the system will automatically generate the 
needed transactions. Both escrows must be on the same bank account and the correction cannot 
cause an overdraft in the original file. If turned on, the menu item Receipt Correction  appears under 
the Escrow > Receipts  menu. 
 
Allow Escrow to do Receipt Transfers : turned on, this setting will provide a menu item Transfer 
Funds  on the Escrow > Receipts  menu. This option makes it easier to transfer funds between 
escrow files that share the same bank. Rather than the users having to enter two receipts, they must 
simply identify the two file numbers and the amount to be moved. The system will generate the 
receipts. The receipt type “TRF” must be established through Utilities > User Tables > Receipt 
Types . It should NOT be made a “depositable” receipt type. 
 
Allow Escrow to do Outgoing Wires : the System Files > Setup Options >General > Enable Wire  
Out Processing  option must be turned OFF for this option to be available for selection. If this option 
is enabled, Escrow users will be permitted to enter wire out disbursements. If the option is not 
enabled, only Accounting will be permitted to enter outgoing wires. This option would be applicable if 
Escrow personnel were communicating wire out information directly to the bank. 
 
Allow Escrow to Void Outgoing Wires : With this option, you can determine whether Escrow users 
are permitted to void outgoing wires via the Misc. > Void Outgoing Wire  menu. The user will be 
required to enter the wire number. Once the wire is identified, the user will have the option of voiding 
the wire out or canceling the operation. As it can lead to duplicate disbursal of funds if voids are done 
improperly, care should be taken when providing this function to a wider range of users than just 
Accounting. However, in a smaller environment where Escrow staff handles all of the interactions with 
the bank(s) on wires, this setting might be appropriately turned on. 
 
Allow Wire Outs to Overdraft with Password : this option behaves similarly to the Allow 
Overdrafts with Password option above, but relates specifically to outgoing wires as opposed to 
checks. The two alternatives of password protection discussed above (dynamic and static) are 
applicable here as well. Please refer to the discussion above for further details. 
 
Payoffs: Default NAF to Payoff Lenders : this option will pre-select the Payoff Lenders  category on 
the NAF search screen when the user is entering information about payoffs. This simply saves a 
mouse click or two, but does speed up use of the system. This option should only be enabled, 
however, if the business routinely categorizes appropriate NAF entries as Payoff Lenders.  
 
Use HUD1109-1110B for Rate Calc. Title Charges : When using the rate calculator, normally the 
system uses HUD 1108 to show the total charges paid by the buyer and seller and shows the policy 
liability amounts on 1109-1110B (with no dollar amounts in the buyer and seller columns). If the 
option is enabled, then HUD 1108 shows the payee for the title charges (no buyer/seller 
amounts) and 1109-1110B show the policy liability amounts AND the amount paid by the buyer and 
seller. 
 
Enable Title Fee Breakdown : if the company routinely splits title fees between itself and other title 
companies, such as when out-of-county policies are sold, then it may want to turn on this option. It 
provides a mechanism at the bottom of the title fee detail screen for generating a split of title fees 
based on a percentage and for identifying the payee for the split. A check will be generated to the 
payee identified. The detail of the split will be shown on the fee slip detail as a reduction to the 
company’s fees. 
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Enable Escrow Prelim Distribution : this option turns on the preliminary title report distribution 
tracking function. The Prelim Distribution List screen is called from the Escrow module via Edit > 
Initial Questions  and provides a place where the escrow officer or support staff can track the 
number of copies of the Prelim, the CC&R’s, and sets of documents, which could be sent to a wide 
range of pre-identified parties (seller, buyer, lender, broker, etc.). Space is also provided to identify 
some recipients not identified elsewhere. This listing can also be used to trigger the generation of 
opening letters after the prelim/commitment has been issued if the sub-option Create Distribution 
Letter for Escrow  is selected. The methods of delivery (Via) dropdown provided on the user screen 
in Escrow are pre-established through User Table > Prelim Distribution Via . 
 
Print Company name in HUD box H : Box H on the HUD page 1 contains the name of the settlement 
agent and the place of settlement (address of the settlement agent). This will be automatically filled 
with the Company Name  identified on the XREF > Page 2 screen, if this option is checked. If the 
majority of closings are handled by the company at the company offices, this box will normally be 
checked. 
 
On Refi’s copy seller name to buyer name : Transaction types, which are established in Utilities 
User Tables > Transaction Types , can be designated as Refinance  or not. If they are so 
designated, Impact/SQL uses the information on the Buyer Names  screen for the “Borrower” 
throughout the process and on documents. Therefore, it is important that the information about the 
borrower be entered on the Buyer Names  screen. It has been found that during data entry in Initial 
Questions , as the Seller Names  screen appears before the Buyer Names  screen, users will often 
enter the borrower’s data on the Seller Names  screen before realizing they should be entering it on 
the next screen. This option was created because of this issue. During the first pass through data 
entry (only), if the transaction type selected has been designated a “refinance” type, all data entered 
on the Seller Names  screen will be mirrored on the Buyer Names  screen. The user will then see that 
data when they click on the Next  button from the Seller Names  screen. 
 
Allow Escrow to delete receipts : Errors can be made during receipt entry. The issue is whether the 
company wishes all receipts to be retained in order to provide an audit trail of all activity, with 
sequential receipt numbering, or permit a receipt to be deleted by Escrow users prior to posting. The 
alternative to deleting a receipt completely is for the user to zero out the amount of the receipt. 
Turning this option off will deny Escrow users the ability to delete a receipt. They can only zero it out 
prior to posting. The system will check that the file involved will not be overdrawn by the change in 
amount and the user may be prompted for an overdraft-authorizing password before proceeding. If 
the option is turned on, a requested deletion that will cause an overdraft will have the same effect. It 
is not recommended that this option be turned on. 
 
Allow Escrow to void checks : Errors can be made during check entry. The issue is whether the 
company wishes all Escrow users to be able to void checks or whether that action should be limited 
to Accounting users and, potentially, the Escrow Manager – see below. Limiting the voiding of checks 
to Accounting users will require a greater degree of communication between Accounting and Escrow 
and will require Accounting to be prompt in response to Escrow in order to prevent a bottleneck. 
Some companies insist on Accounting authorizing and performing every void. This option is provided 
for them. 
 
Allow Escrow to reverse voids : Impact will permit the reversing of a void. This may be required if 
the wrong check was voided or a check was voided legitimately (it was lost) and then was found to be 
truly outstanding (it cleared the bank). Such items can complicate reconciliations and therefore some 
companies want only Accounting users to be able to reverse voids so they can be made aware of the 
item and be prepared to give it the attention it needs. This option will restrict Escrow users from 
reversing voids if not enabled. 
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Restrict voiding of checks to Escrow Manager : If the company wishes to restrict the voiding of 
checks from most Escrow users, but permit users designated as Escrow Managers (System Files > 
Password > Access Code = Escrow Manager ), in addition to Accounting users, to be authorized to 
void checks, then this option should be turned on. This can ease the bottleneck discussed above 
(Allow Escrow to Void Checks ). 
 
Restrict voiding of checks to Current Day only : Another alternative to completely restricting 
Escrow users from voiding checks is to limit the checks they can void to current day items only. 
These are most likely checks cut in error and which are most likely still in the possession of Escrow 
personnel limiting the risk of them clearing the bank along with re-issues. Check this option to give 
this flexibility to Escrow users. 
 
Allow Escrow to Void Fee Slip, Allow Escrow to Reve rse a Voided Fee Slip, Restrict Voiding of 
Fee Slips to Current Day, and Restrict Voiding of F ee Slips to Escrow Mgr : These four options 
are similar in nature to the check options discussed above. They are only relevant if the company is 
using fee slips for collection of escrow and title fees with the “:T” payee instead of checks. As fees 
can be a sensitive issue and the changing of fees after they have been approved might need to be 
noted by someone other than the Escrow Officer, these options give the company a wide range of 
flexibility with regard to the voiding of fee slips. 
 
Allow Escrow to do manual checks : In normal operation, checks are issued out of Impact/SQL to a 
laser printer on blank check stock. This functionality ensures that information about checks is 
captured by the system through their generation. There can be, however, instances where manual 
checks might need to be issued: the check printer(s) might be disabled, the entire system may be out 
of commission, and there is demand for an immediate check. In this case, the company should have 
a policy governing who will issue manual checks (Escrow or Accounting) and will need to have some 
pre-printed check stock at the disposal of the appropriate people. After a manual check is prepared, 
data about the check (payee, amount, escrow file, date) will need to be entered into Impact/SQL. This 
option allows for that information to be entered by Escrow users in addition to Accounting users. 
Generally, as these are “special events” and will have potential positive pay processing and/or 
reconciliation impacts, Accounting needs to be aware of the existence of manual checks and so often 
the entry of that data is restricted to Accounting users. It may be that the physical issuance of manual 
checks is also restricted to Accounting users, but that is outside of Impact/SQL’s reach. Manual check 
entry also allows for the entry of address information. 
 
Allow Floaters w/Check Write to do manual checks : One category of users, controlled by Access 
Code  in the Password  file, is Floaters - with Check Write  ability. As these individuals may be in and 
out of many branches, the company may wish to restrict their functionality a bit more than an Escrow 
user permanently assigned to one branch or, conversely, expand it if they are “power” users. If the 
option is selected permitting Escrow users to do manual checks, Floaters - with Check Write  ability 
can be restricted if the company so desires or the company may only want these users to do manual 
checks and not all of escrow. 
 
Allow Escrow to enter invoices : When this option is enabled, users in the Escrow module will have 
an option, File > Create & P rint Invoices,  to enter invoices for fees. While invoicing historically has 
been a Title function, this option permits Escrow users to issue invoices. 
 
Enable Custom Reports : While most custom reports, written in Crystal Reports, are available 
through the MIS module, the company may wish for some to be made available to Escrow users. If 
so, this option should be enabled. Then, while in the Escrow module, users can generate custom 
reports that have been established for them or even develop their own depending on the 
configuration of the system. When turned on, the users will find the reports under Escrow > Reports 
> Custom Reports . 
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Enable Impact Express : The Impact Express function provides for the quick entry of a number of 
new escrow files over a range of consecutive numbers with a minimal amount of requested 
information initially. As an escrow number cannot be “unused” once selected for use, the company 
may wish to turn off this function to prevent the erroneous use of a large number of file numbers by 
accident. 
 
Require Reason on Overdrafts : In addition to requiring a password in an overdraft situation, a 
reason for the overdraft can be required. This option forces a reason to be entered. This reason will 
be printed on one version of the Trial Balance and on the Overdraft Report if available.  
 
Allow Escrow to Post Date Checks up to 5 Days : This option will permit Escrow users to advance 
date (post date) checks by up to 5 days. Checks that are post-dated will Post  to the ledger(s) (move 
from “in process” to “posted”) with the posting (in Accounting) of the check date(s), not the date of 
creation. 
 
Allow Escrow to Enter Reason Funds Held on Open Fil es: If this option is selected and funds 
remain in the escrow file after the fee check/fee slip is generated, the user will be prompted to enter a 
reason for holding the funds. A version of the Trial Balance can be printed that presents the reasons 
entered on these files. This can make it easy to document why funds are held and to prompt follow-up 
action on those items whose reasons no longer seem valid. It is recommended that a follow-up date 
be provided in the reason field. 
 
Calculate Commissions Based on % of Commission Base : This option has been added to allow 
the calculation of agent commissions to be based on a percentage of the base commission, as 
opposed to a percentage of the sales price.  
 
Allow Escrow to do Deposit Slips : Receipts coded with “depositable” type codes will not appear in 
reconciliations; they must be tagged for inclusion on a deposit slip, if either this Escrow option or the 
Accounting equivalent is checked. If neither is checked, all receipts will appear individually in the 
reconciliation file. Depending on who is preparing and making the physical bank deposits of 
depositable items (checks and cash) the company may want to turn this option on. If Escrow 
personnel are performing this function, then the option must be turned on. This will allow Escrow 
users to tag receipts generated with a “depositable” type code into deposits and to generate deposit 
slips out of the system, precluding the need to prepare a deposit slip manually. If the Accounting staff 
is preparing the deposits, there is no need to turn this option on. If Escrow is permitted to prepare 
deposit slips, the deposit options available are Allow Manual Deposit Slips, Allow Void Deposit 
Slips, Restrict Access by Branch, and Allow Backdating of Deposit Slip. 

 
Enabling Allow Manual Deposit Slips  is an option that is used when a company is switching 
from not using Impact-generated deposit slips to using them. Outstanding deposits would be 
entered manually so they will appear in the next reconciliation. 
 
As deleting a deposit slip is no longer an available option in Impact/SQL, voiding is an option 
and leaves an audit trail where deleting did not.  
 
Restrict Access by Branch  refers to the user only being able to see receipts from their 
branch in the deposit slip preparation screen. This option is highly recommended so deposits 
are not mixed up across branches. Accounting users will still see all receipts on the deposit 
slip preparation screen.  
 
Escrow users can be given access to backdate a deposit ticket. 

 
Default HUD size to: Legal (8 ½ x 14) or Letter (8 ½  x 11): The HUD can be printed in either legal-
sized or letter-sized format. This option merely selects which format should be pre-selected by the 
system. Various clients have differing requirements and so this flexibility is made available. The letter-
sized format will only print lines that have buyer and/or seller dollar amounts on them. The legal-sized 
format will print all standard lines, whether used or not.  
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On HUD form show POC Paid By : If the company’s policy is to present the payer (Buyer or Seller) 
of “paid outside closing” (POC) items, then this option should be turned on. The payer will be 
presented in the description field of the POC item along with the amount paid.  
 

Enable “Bill To” Screen : Under the 
Initial Questions  menu in Impact 
Escrow, a menu item Bill to Customer 
will appear if this option is enabled. If 
data has been entered in earlier data 
entry for the party identified by the radio 
button selected, it will automatically 
populate the fields presented. If not, the 
data for the party to be billed (for escrow 
and title fees) must be entered 
manually. 
 
While there is not an Accounts 
Receivable module within Impact/SQL, 
data on invoices that have been 
generated can be exported to external 
A/R systems for follow-up tracking. 
 

Require Receipt on Add’l Deposits : If this option is enabled, then on the Additional 
Buyer/Borrower Deposits  screen, in the worksheet style of entry, an Enter Receipt  check box will 
be displayed and allows the entries to be accepted only if a receipt is created for the deposit. The 
user can manually uncheck the check box in order to enter items into Impact/SQL without creating a 
receipt.  
 
Allow :E : This option will allow for the use of “:E” for Escrow charges to distinguish them from “:T” 
Title charges entered by the sub-escrow group in a situation where the sub-escrow functionality was 
in use. Both “:E” and “:T” entries will end up on the same fee slip/check. 
 
Show Commission in Initial Questions : If this option is enabled, then the Commissions  menu 
option will also be available on the Initial Questions  menu. If this option is NOT enabled, then the 
Commissions  menu option will be only available from the HUD Style Entry  and Worksheet Style 
Entry  menus. 
 
Update legal after acceptance : Escrow can now update a legal description after it has been 
accepted by Title if this option is enabled. Care should be taken in permitting this option. 
 
Allow Escrow to Print Trial Balances : Historically, the Trial Balance reports have only been able to 
be printed from within the Accounting module. The option to print Trial Balance reports from within the 
Escrow module is provided in Impact version 5.6 and higher. One consideration to be evaluated in 
turning on this option is the ready availability of listings of aged files with balances, which are at 
higher risk for fraudulent activity. Escrow users will only be permitted to generate Trial Balance 
reports for their specific branch. The “upside” of this option is that Escrow can use the Trial to work 
aged files without Accounting having to send them reports. 
 
Suppress ‘Printed by’ line on HUD : The Printed by  verbiage on the bottom of the HUD and 
Settlement Statement can now be disabled or enabled with this option. 
 
Enable Misc Escrow Data : A custom data entry screen, which can be utilized in Escrow, can now be 
defined in the Utilities module. The company can identity data fields they wish to collect on each file 
through this utility. If enabled, this screen is available from the Initial Questions  menu. Select the 
Misc Data Entry menu item to open the Miscellaneous Data Entry  screen. Also, a report can be 
printed from this screen.   
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ESCROW 2 
This is the second tab of Escrow Setup Options. 
 

 
Back Out Closed and Recording Dates Upon Void of Re venue Check or Fee Slip :  This option 
will remove the Closed and Recording Dates on a file when the fee check/slip is voided.   Normally, 
the Close Escrow File on Issuance of Fees  option is turned on (Escrow 1 tab) and the dates 
entered as a result of that option are the ones being removed when the void is done.  This may 
impact MIS and other reporting (based on Closed Date) if voids are done on prior month items. 
 
Do Not Allow Withhold Amount to Exceed Lending Amou nt : With this option selected, the user 
will be warned that an item being flagged withhold from lender’s funds (WTH) pushes the total being 
withheld over the available funds, and they will not be permitted to flag the item WTH. 
 
Show Pending Receipts/Receivables on Disbursement E ntry : For states that do table funding, 
this option will show the escrow user the amount that should be receipted into the file to cover the 
disbursements currently set up.  
 
Show MTG Broker Receivables and Disbursements : This option is only available if the Show 
Pending Receipts/Receivables on Disbursement Entry  is checked. The system will calculate the 
Mortgage broker’s check by deducting any items marked as POCB. If the Mortgage broker’s check is 
insufficient to cover the POCB items, then a receivables item is shown for the difference. 
 
Allow Editing of Receivable Items : The ability to add, modify and delete receivables is controlled by 
this option. 
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Prompt User for Full Address When Printing Checks : This option will trigger a prompt for a full 
address on any check about to be printed that is missing that information. 
 
Display Initials on HUD-C Report : the addition of “initial lines” on the bottom of each page of the 
HUD-C report is controlled by this option.   Some companies want each page of the HUD-C initialed 
by parties to the transaction.  
 
Allow Escrow to do Savings Transfers : The ability to transfer funds to/from Savings accounts in 
one step (as opposed to the SAV and STF receipt pairs historically entered) has been introduced with 
version 7.0, and this option extends that ability to Escrow users.  The transfer function is on the 
Receipts menu in Escrow (Transfer Savings ), if this option is enabled. 
 
Do Not Allow Fee Transfers on Invoiced Files : this option will result in the user being warned that 
an invoice exists for a file if a fee check/slip is being printed.  The user may still print the fee 
check/slip – the option is slightly mis-named. 
 
Allow Escrow to View Conversation Logs from Title 
Allow Title to View Conversation Logs from Escrow : these two options relate to a conversation 
log now available to Title on Escrow files, in addition to that which has been historically available to 
Escrow.  With these options, the two conversation logs can be shared in one or both directions. 
 
Show Approved by on Preliminary & Final Disbursemen t Reports :  When selected, this option 
will cause an “Approved by:” signature line to appear on the Preliminary and Final Disbursement 
reports. 
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TITLE 
This is the configuration screen for the Impact/SQL Title module. The tab of Title  options is not as 
detailed as the Escrow tabs, but the options are still very important. The range of options provides for 
the establishment of quite different operating environments for users of the Impact/SQL Title module. 
The example shown should NOT be considered “typical”; each company’s configuration will be 
unique, as there are many options and every company operates in different ways from others. Each 
option will be explained below. 
 

 
 
Allow Title to update ALL Escrow Information  
Allow Title to Update PARTIAL Escrow Information : The company must determine whether Title 
users should be permitted to edit all Escrow information, partial Escrow information, or no Escrow 
information. If the option Allow Title to update ALL Escrow Information is selected, all data 
entered by Escrow under the Escrow > Edit > Initial Questions  menu selection is made available 
under the Title > Opening Info  menu selection. If the Allow Title to Update PARTIAL Escrow 
Information  option is selected, the Title user is restricted to editing the Property Information  screen, 
the Sellers Names , Buyers Names , and Prelim Distribution  screens. If Title users are not to be 
permitted to edit any data entered by Escrow, with the exception of the Legal Description , then 
neither option should be selected. 
 
Allow Title to Update HUD1100 Title Charges : This option will only be available if one of the 
options above is selected. It will permit Title users to edit the data entered on the title charges line(s) 
of the HUD. The company must decide if this will do more good than harm, as it will permit Title to 
alter the balances on the HUD. Good communication between Title and Escrow personnel would be a 
necessity if this option were enabled. 
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Enable Endorsement Tracking : This option provides a sub-screen on the Policy Entry  screen for 
endorsement information to be entered. Endorsements entered here will be made part of the 
Underwriter’s Remittance Report. Generally, this option would be selected. 
 
Default Invoice to:  Regular Invoice  or Pre-Bill : If the company, in the normal course of business, 
issues “estimated cost” invoices on each order (pre-bills), then the Pre-Bill  option should be selected. 
Otherwise, the Regular Invoice  option should be selected. The numbering for each type is distinct 
and set under System Files – Set Next Invoice Number . 
 
Enable Title File Numbering : This option will provide for a separate file number for the title file than 
that used for the escrow file. This is not required; it is a business preference. There are three sub-
options that determine when and how the title file number is assigned. When File is Opened , if 
selected, will automatically assign a title file number when an escrow file is created. The title number 
will appear after the escrow number in the status box (lower left corner of the Impact screen). When 
File is Ordered , if selected, will not assign a title file number until the title order is generated. This will 
preclude numbers from being assigned that are related to escrow files that will not be involved with 
title or which are cancelled. Manually , if selected, will require the Title user to assign a manual 
number after the title search is ordered. The user will need to select the file using the escrow number 
assigned via Escrow > E dit > Update Search and Exam Info  and change the file number from the 
original escrow number to the desired number. Once that is done, both numbers will appear in the 
status bar. 
 
Allow Title to Delete Invoices : If selected, this option will permit an invoice to be deleted by a Title 
user. Because invoices are issued with automatic, sequential numbers, if the company wishes to 
preserve a record of each invoice issued, this option is not recommended.   
 
Default Approval Date to Date Typed : When this option is enabled, it will default fill the Approval 
Date field on the Policy Entry  screen to the current day as the policy is being typed. This will help 
ensure that the Approval Date  is filled, which is important, as this is the field that is used to 
determine if a policy will appear on the Underwriter Remittance report. The auto-entered date can be 
changed. Care needs to be taken when changing the date to make sure the date is not moved back 
earlier than the date for which remittance reports have already been run or the policy will never be 
reported. If the field is blank, the policy will appear on the Policy Exception Report. 
 
On Release of Prelim Send Email : Enabling this option will provide for an e-mail to be sent when 
the prelim is released by Title.  

Prompt for Email on Release : The notice of the release of the prelim can be e-mailed to 
multiple parties instead of just the processor and escrow officer if this option is enabled. Once 
enabled, the user will be prompted as to whether others should be notified and if the 
response is positive, the e-mail screen will be presented for more addresses to be added by 
the user.   

 E-Mail EO on Release of Prelim :  Yes or No.  
E-Mail Processor on Release of Prelim :  Yes or No. 
The e-mail addresses for EO and Processor are pulled from the  Password  file, so the data 
there must be kept up-to-date.   
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Allow Title to access Escrow Tracking : If enabled, the Tracking  screen maintained in the Escrow 
module is made available to Title users. This is handy as some of the items being tracked may be 
under Title’s control. When they complete the work, they can then record that fact which increases 
communication channels with Escrow. 
 
Auto Assign Policy Numbers : When this option is enabled, it will automatically create a policy 
number that matches the file number. If there are multiple policy numbers, they will be tagged with a 
dash and the count of the policy. For example, the first policy created for file number “00001234” 
would be “00001234-1”, the second would be “00001234-2”, and so on. This option would not be of 
use for companies whose underwriters pre-number their policy jackets. 
 
Enabled Release of Prelim after Edit : If this option is enabled, the prelim typist, upon exiting the 
editing of a prelim, will be presented a dialogue box asking if the prelim should be released to escrow. 
 
Enable MISC DO Data : A custom data entry screen, which can be utilized in Title, can now be 
created through the Utilities module. The company can identify data fields they wish to collect 
information in through this utility. If enabled, this screen is available from the Edit  > Opening Info  
menu for a Direct Order file. To utilize the Misc Data Entry menu item for an Escrow file (rather than 
for a Direct Order), the system must be configured to Allow Title to Update ALL Escrow 
Information . Select the Misc Data Entry menu item to open the Miscellaneous Data Entry  screen. 
Also, a report can be printed from this screen.   
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ACCOUNTING 
This is the configuration screen for the Impact Accounting module. The tab of Accounting  options is 
not as detailed as the Escrow screen, but the options are still very important. The range of options 
provides for the establishment of quite different operating environments for users of the Impact 
Accounting module. The example shown should NOT be considered “typical”. Each company’s 
configuration will be unique as there are many options and every company operates differently. Each 
option will be explained below. 
 

 
 
Include the following reports in the Analysis : There are two reports that can be added to the 
output generated when the daily work’s posting process is started. They are the Daily Receipts 
Journal by Bank  and the Daily Disbursement Journal by Bank . These are handy reports to have 
on hand to assist in researching posting issues that might arise. While the routine output generated 
contains the posting detail, these reports are formatted to make the data more readable, on a macro 
level. 
 
Auto-Clear Voids During Reconciliation : With this option enabled, checks that have been voided 
as of a date up through the date of the reconciliation being done will automatically be flagged as 
cleared and will not appear in the reconciliation when it is opened. Checks that are voided as of a 
date beyond the reconciliation date will still appear in the reconciliation with a Status  flag of “V”. 
These are referred to as “future voids”. If the option is not turned on, voided items will appear in the 
reconciliation and will have to be cleared by hand. It is recommended that the option be turned on. 
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Require Income Codes on Fee Checks and Transfers : Even though this option is on the 
Accounting  Setup option screen, it really affects Escrow users directly in day-to-day operation. If 
turned on, the option requires that every line item on a fee check or fee slip must be coded with an 
income code. While some lines may be coded by default based on their entry point on the HUD, not 
all lines will be. This option forces the users to edit the fee disbursements (those made out to the “:T” 
payee). The revenue check or fee slip will not be able to be printed until all items are coded. This is a 
highly recommended option as it ensures that all revenue data makes it into the Income Analysis 
database and that information reported out of that database is full and complete. This is mandatory if 
bulk transfers of fees are being done based on reporting from the Income Analysis database. 
 
Allow Positive Pay : This option depends on the banks used by the company for their escrow trust 
account(s). The Positive Pay feature generates a file of checks issued out of Impact, for transmission 
to the bank, to be matched against items presented for payment. Please refer to the Impact 
Accounting manual for a more complete discussion on Positive Pay. This option, when checked, 
makes the feature available to Accounting module users. The decision to use this function does not 
need to be made at the initial setup. 
 
Allow Reverse Positive Pay : As with Positive Pay, the need for this feature to be enabled is a 
function of the bank being utilized by the company. Some banks will not accept a Positive Pay 
upload, but will generate a file of items presented for payment that the company can then, through 
Impact/SQL, match against checks issued. The company will then notify the bank of items to be 
rejected. Please refer to the Impact Accounting manual for a more complete discussion on Reverse 
Positive Pay. This option, when checked, makes the feature available to Accounting module users. 
The decision to use this function does not need to be made at the initial setup. 
 
Allow Accounting to do Deposit Slips : If this option is enabled, Accounting users will have access 
to the deposit slip preparation screen. While Escrow users can be restricted to seeing only the 
receipts from their respective branches during deposit slip preparation, Accounting users will see all 
receipts that are available from all branches. The company may wish to turn this option on even if the 
bulk of deposits are prepared by Escrow users as there may be instances where Accounting may 
need to make a deposit for Escrow (for making deposits of loss fundings, for example, or just as a 
backup resource for Escrow). The options selected on the Escrow  tab under Setup Options  should 
be used in conjunction with this option to best “fit” Impact’s configuration into your company’s specific 
policies regarding deposits, specifically as Escrow users may not be permitted certain behaviors, 
which Accounting will then need to perform. 
 
Allow Accounting to do Receipt Corrections per DOC Regs : This setting is only applicable to 
companies that fall under the jurisdiction of the California Department of Corporations (DOC);  
“escrow only” companies in California. The regulatory requirement is that if funds are receipted into 
an escrow file and  it is determined at a later date that the funds should have been entered into a 
different file, correcting receipts with the same receipt number on each are to be entered into the 
original file with a negative amount and into the correct file with a positive amount. This setting 
automates the procedure by allowing the user to answer a few questions (original escrow number, 
receipt number, and new escrow number) and then the system will automatically generate the 
needed transactions. Both escrow files must be on the same bank account and the correction cannot 
cause an overdraft in the original file. If turned on, the menu item Receipt Correction  appears under 
the Accounting > Receipts  menu. 
 
Allow Accounting to do Receipt Transfers : If this option is enabled, it will provide a menu item, 
Transfer Funds , on the Accounting > Receipts  menu. This option makes it easier to transfer funds 
between escrow files that share the same bank. Rather than the users having to enter two receipts, 
they must simply identify the two file numbers and the amount to be moved. Then the system will 
generate the receipts. The receipt type TRF must be established through Utilities > User Tables > 
Receipt Types . It should NOT be made a “depositable” receipt type. 
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Enable Overhead Fee Account : (Please refer to the Fee Options  discussion under the Setup  
Options > Escrow heading above and the System Files > Banks section for more information 
related to this topic in making the determination whether to use this option.) If fee transfer slips have 
been selected to be used, the funds can be reflected as having been pulled from the escrow files. The 
Trial Balance will reflect a lower balance in total even if the funds have not yet been pulled from the 
escrow trust bank account. Alternatively, the funds can be reflected as having been pulled from the 
escrow files and transferred to an “overhead fee account”. There would be one overhead fee account, 
which is just an escrow file that will be continuously used for this purpose, set up for each bank 
account. If this function is turned on and a fee transfer slip is generated, the funds will be 
automatically receipted  out of the escrow file(s) and into the overhead fee account established for the 
bank account. The funds will remain there, and would therefore be reflected on the Trial Balance, until 
a check or transfer out was issued to remove the funds, which would then be deposited in the 
operating account and recorded in the general ledger of the company. A void of a fee transfer slip will 
flow through to the overhead fee account as a reversing entry and a reversal of a void will flow 
through with the appropriate re-crediting of the fee. The primary consideration for use of an overhead 
fee account(s) is whether the company wishes for fees to continue to be reflected on the Trial 
Balance until they are actually moved out of the escrow trust account(s). 
 
Enable Email to EO on Receipt of NSF : After Accounting personnel enter a receipt for an NSF item, 
when this option is enabled, an e-mail will be sent to the escrow officer whose user initials are linked 
to the file. The e-mail will let the escrow officer know that the item deposited was returned by the 
bank. This can improve the communication between Accounting and Escrow regarding NSF items. As 
with the e-mailing of notices from Title to Escrow, this option requires that the e-mail addresses for 
escrow officers be properly maintained in the Password  table. The NSF receipt type must be used to 
trigger this behavior.  
 
Mark zero dollar items as cleared in bank rec : When you perform a reconciliation, zero (0.00) 
dollar amount items, through the date of the reconciliation, are automatically marked as cleared when 
this option is enabled. 
 
Create auto adjustments for check issued/paid diffe rences : This option is utilized when using the 
Recon > Outside Service  menu in Accounting to build the reconciliation file. This feature 
automatically creates a bank adjustment, in the reconciliation, for any difference between the amount 
on the check issued, and the amount that was actually paid at the bank. 
 
Include undeposited total receipts in Bank Recon : The undeposited receipts automatic 
adjustment in the reconciliation, on the Book  tab, which was introduced in Impact/SQL 5.11, has 
been made optional. In addition, the receipts journals, when run for “undeposited receipts” only, now 
present the data, from the deposits details table, which is undeposited through the date of the 
reconciliation.  
 
Only Clear Deposit Slips by Ticket Number in Bank R econ : this option will require a match on 
both ticket number and dollar amount, when Outside Services are utilized in preparing a reconciliation 
file, before a deposit slip will be marked cleared.  Some bank downloads of cleared items now contain 
the deposit slip number, and this option utilizes that feature.  This aids in making sure that common-
dollar deposits are properly cleared – rather than just the first deposit for the dollar amount  that 
matches the download item. 
 
Prompt User to Print Reports Before Posting Recon : the reports that can be printed out of the 
Reconciliation function (Summary, Cleared and Uncleared) cannot be re-printed after a reconciliation 
is posted.  This option, to prompt the user to print the reports before posting of the reconciliation, is 
designed to ensure that the reports are printed.  This is helpful when there is turnover in the 
Accounting area and the habit of printing before posting is not ingrained in the personnel doing 
reconciliations. 
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Allow Transfer of a Negative Balance : file transfers, between branches and/or banks, will not be 
permitted for negative balance files, if this option is not enabled. 
 
Allow Accounting to do Savings Transfers : The ability to transfer funds to/from Savings accounts 
in one step (as opposed to the SAV and STF receipt pairs historically entered) has been introduced 
with version 7.0, and this option extends that ability to Accounting users.  The transfer function is on 
the Receipts menu in Accounting (Transfer Savings ), if this option is enabled. 
 
 

 

 

WORD OPTIONS 
This is the configuration screen for the Microsoft Word functionality integrated into Impact/SQL. 
Microsoft Word is used for documents generated out of Impact/SQL. These options will affect all 
Impact users that generate documents.  Versions of Impact/SQL prior to 7.0 utilized “switch files” to 
trigger specific behavior in the Word integration; these have been eliminated in 7.0 and the 
management of those behaviors has been moved into Word setup options. 
 

 
 
On All Exhibits, Clear Headers : Whenever Impact/SQL creates an Exhibit, this option controls 
whether the header from the previous section in the document will be copied into the new section 
created for the exhibited text. If this option is enabled, then the exhibited text will have a blank 
header. If this option is not enabled, then the exhibited text will use the same header as the previous 
section.  Enabling this option is recommended by DSI. 
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Paragraph Format Legal Descriptions : Legal descriptions are typically included in a document 
through the use of the INCLUDETEXT field. This is an active link to another Word document, which 
could have its own paragraph and character formatting. This option determines whether the linked 
text will keep its own formatting when placed into the User document or will it be reformatted to match 
the rest of the document. When this option is enabled, the legal description will be reformatted to 
match the main document. If it is not enabled, the legal description will keep its own formatting.  
 
On All Exhibits, Clear Footers : Whenever Impact/SQL creates an Exhibit, this option controls 
whether the footer from the previous section in the document will be copied into the new section 
created for the exhibited text. When this option is enabled, the exhibited text will have a blank footer. 
When it is not enabled, the exhibited text will use the same footer as the previous section.  Enabling 
this option is recommended by DSI. 
 
Only Update Fields in the Main Story, First Header and First Footer : When Impact/SQL opens a 
document, it updates all the fields linked to the database with the current information in the database. 
The Impact/SQL user may experience a delay while this processing occurs. This option controls the 
time spent updating these fields when the document is opened by skipping the fields contained in 
headers and footers outside of page one. If you use bookmarks and REF fields for information in 
these headers/footers, this option should be turned on. When this option is enabled, headers and 
footers outside of page one will not be updated when the document is opened. When this option is 
not enabled, all fields regardless of their location will be updated when the document is opened 
 
Leave Prelim Open as XXX.DOC When Doing policies : Impact/SQL opens the Prelim document 
when it is creating policies in order to copy information from one document into the other. When this 
process is finished, Impact/SQL normally closes the Prelim and the Impact/SQL user is presented 
with a list of policy documents to edit. This option controls whether Impact/SQL will leave the prelim 
document open as XXX.doc—a read-only document. The Impact/SQL user can then switch back and 
forth between the policies and the Prelim on their own. When this option is enabled, the prelim is left 
open as XXX.doc. When this option is not enabled, the prelim is closed after the polices have been 
created. 
 
Only Remove Fill-ins from the Main Story, not from Headers and Footers : Impact/SQL searches 
the document before printing or emailing and changes all unfilled Fill-Ins to hidden text. This means 
they will not show up on the printed page or in the emailed version of the document but can be 
brought back when the document is edited again. This option is similar to Option #4 for DDE Fields. 
Since it is very rare to find a Fill-In field in a header or a footer, this option could be set to Yes to 
speed up processing of the documents. When this option is enabled, only unused Fill-Ins in the main 
body of the document will be hidden during the printing or e-mailing processing. When this option is 
not enabled, all unused Fill-Ins in the document will be hidden during the printing or e-mailing 
processing. 
 
Special Policy Clause Processing (12 Bpoints Before , Old Style Clauses) : This option will only 
effect Policy documents. When clauses are inserted into the document, Impact/SQL can make sure 
there is one blank line before the clause. The first paragraph of the clause will be reformatted to 
include a 12 point line before the paragraph begins. This guarantees there will be a blank link before 
each clause inserted into the document. When this option is enabled, each clause inserted into the 
Policy will have a blank line before the clause begins. When this option is not enabled, there will be 
no blank lines inserted between clauses. 
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Force Legal Description Boldness to be 100% like th e doc’s Legal Descr Table : Impact/SQL can 
change the legal description’s formatting when it is inserted into the document. This option 
determines whether the Bold attribute should be changed to match the Master.  
 
If the legal description is within a table, Impact/SQL will look at how the table itself is formatted. If the 
legal description is not in a table, it will look at the paragraph formatting. If the table or paragraph is 
bolded, the legal description will be bolded when this option is set to “On”. The Bold attribute for the 
text in the legal description will be changed to match the formatting applied to the table or paragraph 
containing the INCLUDETEXT field in the Master. If this option is set to “Off”, the bolding will be 
untouched. Only the text that was initially bolded in the legal description will be bolded. The Bold 
attribute for the text in the legal description will not be changed from how it appears outside of the 
Master. 
 
Bookmark Styles Before Starting Prelims (for W95 Pr elims) : This option will effect only Prelims. 
Impact/SQL will search through the Prelim and place bookmarks around any text formatting with the 
following character “styles”: 

• Exceptions 
• Requirements 
• Restrictions 
• InsA, B, C, D 
• FeeType 
• Vested  

If this option is enabled, then the formatted text will have bookmarks applied. If this option is not 
enabled, no bookmarks will be automatically inserted. 

Enable DDE in Legal Descriptions : Impact/SQL will allow you to place DDE fields from a certain 
subset into your legal descriptions. These fields will be preserved when the legal description is then 
transferred into a User document. Be aware that only a subset of DDE fields work in the legal 
description so you need to be careful when you copy and paste text from other documents. If this 
option is enabled, any legal description DDE fields will be preserved when the text is copied into a 
document. If this option is not enabled, all DDE fields in the legal description are ignored by 
Impact/SQL.  Enabling this option is recommended by DSI. 
 
Add Fill-In After Exceptions Bookmark :  In the Prelim/Commitment master documents, the 
Exceptions bookmark contains the Fill-In field [=clause=]. This Fill-In opens the Insert Clause dialog 
box and makes it easy for the Impact/SQL user to add Exceptions to the document.  When they have 
finished selecting clauses, the Fill-In field is automatically removed and the clauses are inserted 
within the Exceptions bookmark. When the policy is created, all text within the Exceptions bookmark 
is copied from the Prelim into the Exceptions area in the policy. 
 

If the Add “=Clause=” Hot Stop sub-option is selected, Impact/SQL will insert the [=clause=] 
Fill-In instead of the normal [°°°°°] Fill-In. 
 
If the Add Blank Hot Stop sub-option is selected, Impact/SQL will automatically add a 
regular Fill-In field, [°°°°°], to the end of the E xceptions bookmark. This allows the 
Impact/SQL user to easily locate the position where additional clauses could be entered 
directly into the policy. 

 
 
Append Entries During Copy Base Operations :  This option will prevent the overwriting of any 
existing text within the Exceptions or Requirements bookmarks in the Prelim master document when 
it is combined with the text from a Subdivision Master.  The Exceptions and/or Requirements text in 
the Subdivision Master will be appended to the end of the existing text in the bookmark. 
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Do Not Rebookmark Styles During Copy Base Operation s:  It is recommended that this option be 
enabled.  The option prevents Impact/SQL from rebookmarking all areas of the Prelim document 
based on applied character styles.  Under normal operations, when the Prelim is used as a base 
document for the Copy Base operation, the default bookmarks, such as Requirements and 
Exceptions, are removed from the original file and redefined based on the current character style.  In 
other words, all text that has the Exceptions characters style will be within the Exceptions bookmark.  
Allowing the DOT to bookmark text automatically in this manner has resulted in too many errors.  This 
is because the Impact/SQL user will copy text from one location in a document to another not 
realizing they are also copying the character style.  If the Exception character style exists in several 
separate locations in the document, the DOT will automatically include all the instances within one 
Exceptions bookmark.  This caused unexpected results.  With this option enabled, the existing 
bookmarks in a Prelim will be left alone if the document becomes the base document for a Copy Base 
operation. 
 
Use Alternate Search Routine for Saving Docs :  This option is for client sites running Word 2002 
or higher.  The behavior of Word, when saving prior to printing of a document, changed with Word 
2002, so this option was developed to accommodate the change.  The DOTs use a ReplaceAll VBA 
routine to hide the square brackets associated with Fill-In fields when the document is printed. If there 
is more than one document open when this routine is run, Word tends to lose track of which 
document is the active document. If this option is enabled, the VBA will use the 
RemoveUsingAlternateReplaceAllMethod subroutine, alleviating the problem. 
 
Allow Email of 3 or more Docs at Once :  Some client sites have reported a problem when emailing 
more than 2 documents at a time.  If this proves to be the case, this option modifies the attachment 
routine to get around the environmental problem.  In most environments, there is not an issue with 
emailing 3 or more documents at once. 
 
Use MTS Client Services :  This option relates to a discontinued service and can be ignored. 
 
Do not Use Prelim Exceptions Style in Policies :  This option prevents the Exceptions character 
style in a policy document from being automatically changed to match what the current settings are 
for the Exceptions style in the Prelim.  For example, if the Prelim Exceptions character style is defined 
as Arial 10 and the Policy Exceptions character style is defined as Tahoma 12, the enabling of this 
option will make sure the Exceptions in the Policy are Tahoma 12. 
 
Allow Multiple Documents to Print at Once :  Under certain circumstances,  a setting of Yes for 
Background Printing in Word (Options -> Print tab) may contribute to automation errors when printing 
from a list of documents.  This option allows the Impact/SQL user to keep Background Printing set to 
Yes. 
 
Copy Fee Type Wording from Prelim to Policies :  This option prevents the VBA from deleting all 
text inside the ‘FeeType’ bookmark except for the words Fee Simple when it is copied from the Prelim 
to the Policy.  This option should be enabled. 
 
Do Not use Tool Tips :  Some Citrix environments have, historically, had a problem with Word 
reverting to the background and documents printing with the brackets still in place (“[  ]”).  It was 
determined that if Tool Tips were disabled, the issue went away.  This option should only be turned 
on if such behavior is being experienced. 
 
Run Hide Brackets Twice when Saving : This option was introduced to counter a condition in some 
environments that result in the square brackets (“[ ]”) for Fill-In fields being printed on the document.  
Under normal operations, they should have been marked as hidden text.  This switch will cause the 
routine to run a second time before documents are printed.  This option should only be enabled if the 
brackets are appearing. 
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Type of PDF Printer :  There are three PDF “printers” that Impact/SQL can work with to prepare email 
attachments in PDF form (as opposed to the MS Word default): Acrobat Distiller, Adobe PDF and 
Win2PDF.  The product available to the users should be identified (if any) in this box, via the selection 
of the appropriate product from the dropdown list.  This setting is used in conjunction with the settings 
on the Email  tab to replace the ‘EmlPrefs.dat’ file’s function in versions of Impact/SQL below 7.0. 
 

Location of Distiller ‘In Folder’ :  If Acrobat Distiller is selected in the Type of PDF Printer 
box, the location of the Distiller ‘In Folder’ should be identified in this field.  

 
 

EMAIL OPTIONS 
This setup option tab is introduced with Impact/SQL version 7.0, to replace the ‘EmlPrefs.dat’ file’s 
function in earlier versions of Impact.  These options manage aspects of the emailing of documents 
from within Impact/SQL. 
 

 
 
Add the Following Text to All Emails Sent Through I mpact :  This option provides for the addition 
of a Privacy Notice, or other message, to all email sent out of Impact/SQL.  The message to be added 
should be entered into the space provided. 
 
Display Email Password on Screen :  When email attachments are prepared in MS Word format, 
rather than PDF, they are most often password protected, so the recipient cannot change the 
document without the password.  This option will present the password to the user, so that they can 
know it and provide it to the recipient if they wish the recipient to be able to modify the document 
being emailed.  If this is done, understand that the default password will become common knowledge 
in short order. 
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Prefer PDF if it can be Created :  This option will default the option of what form an email attachment 
should take to PDF, but will make available the option to the user to select MS Word format 
alternatively at the time of the preparation of the email attachment.  A PDF “printer” (one of the three 
currently supported – see above) must be installed to utilize this option. 
 
Require the Attachment to be PDF :  Enabling this option will force all email attachments to be in 
PDF form, protecting them from being edited.  A PDF “printer” (one of the three currently supported – 
see above) must be installed to utilize this option. 
 
Allow User Control of Email Preferences :  
This option permits the user to see and 
change the email password (if they are 
sending an MS Word formatted attachment), 
and permits the user to select the format to 
be used (MS Word or PDF), if the Prefer 
PDF if it can be Created  option (above) is 
also selected. 
 
The screen shot to the right displays the 
screen the user will see if this option is 
enabled and the site also has PDF 
capability. 
 
 
 
 
 
 
 
 
 
 
 
 
Default Email Password (or blank) :  If the site is going to email attachments in MS Word format, the 
default password to be used to protect the attachments is entered into this field. 
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LICENSE MANAGER  

The License Manger changed radically with Impact/SQL 6.0.  Automated routines have been 
integrated into the License Manager, which will communicate with a licensing server at USA Digital 
Solutions, to register and activate new licenses.  In addition, product licenses (applications and 
integration services) are now managed via the License Manager.  Unused user licenses can be 
automatically freed up, upon a period of inactivity, and are made available to new users.  Access to 
the Internet from the client network is required. 
 
Administrators with Utilities access will open the License Manager via the Utilities > System Files > 
License Manager  path.  The first screen presents the currently licensed products  on the site (shown 
below).  As you can see from the screen below, some product licenses are managed by user counts 
and others simply by site. 
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USER LICENSE MANAGEMENT 
The primary routine activity in the License Manager is managing user licenses for Impact/SQL.  The 
following discussion will detail that functionality. 
 
Note that only products with a 
License Method of “User” have an 
Action dropdown arrow on the 
right side of the screen.  Clicking 
on the Action arrow for the 
product to be worked on will show 
you three options: Change 
Options, Purchase Licenses 
and View Details . 
 

 
 
 
 
 
 
 
 
 
 
 
Change Options 
 
Selecting Change Options will present the following screen, where you have the opportunity to modify 
the user license purchasing options.  For Impact/SQL, your options are AutoRegister, 
AutoPurchase  and Manual .  

 
The AutoRegister  license option will provide 
for the system to automatically purchase 
individual licenses when a user logs in, if there 
are no unused licenses available to be 
assigned.  This option is the most automated 
but does require the system administrator to 
be on top of terminations and prompt new 
hiring, as the system will not auto-unregister 
licenses for up to 45 days from the date of last 
use.  If an employee no longer needs access 
to Impact/SQL (from termination, for example) 
their license should be “unregistered” in the 
License Manager, so it will be available for a 
new user to pick up (this is discussed below). 
 
The AutoPurchase  license option will permit authorized personnel at each site to purchase one or 
more licenses without calling DSI.   This forces some manual intervention so that in the event the un-
registration process is not kept current, licenses will not be ordered when they are not needed. 
 
The Manual  license option is similar to that in place in earlier releases.  The administrator will initiate 
the addition of licenses and will call DSI for a license authorization key. 
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Purchase Licenses 
 
Moving back to the License Manager screen, if the Purchase Licenses  “action” is selected, and the 
AutoPurchase  option (or AutoRegister ; but if so configured you would seldom order licenses this 
way) is “on”, the Purchase Licenses  screen is presented.   

 
The system will check on the total number 
of licenses purchased, and the number that 
are registered to users.  In the example 
screen shot on the left, 7 of 10 total 
licenses are available to be registered to 
users.   
 
 
 
 
 
 
 
 
 
 
 

 
 
If the Purchase  button is clicked, a 
screen is presented asking how many 
licenses are to be purchased.   Enter 
the number and click on the Purchase  
button.  The licenses will be made 
available, and DSI will automatically 
receive notice that new licenses have 
been acquired and are billable.  
Should any of the newly-acquired  
licenses be considered non-billable by 
the client, for whatever reason, DSI 
must be contacted with that 
information, and DSI will adjust our 
records appropriately.  
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Manual Purchase 
If the Manual  purchasing option is “on”, the user will receive the same informational Purchase 
Licenses screen that indicates the total number of licenses and the number available for use, as 
shown above, but when Purchase  is clicked the user will be taken to a screen like that below, where 
they would enter a key received from DSI, after calling for licenses and identifying the number to be 
added.  The number to be added is not entered on the client side under this option, just the key. 
 

 

 

 

 

 

 

 

 

 
View Details 
If the View Details  button 
(on the Action menu) or the 
View Licenses  button (on 
the Purchase Licenses 
screen) is hit, the License 
Detail  screen is presented 
(shown here).  The Days 
Since Last Verified column 
(which here is presenting 
atypical data) reflects the 
number of days since the 
site’s License Manager was 
validated against the DSI 
Licensing Server.  There is 
a rolling process of license 
validations, so not all day 
counts will be the same, but 
should not be over 30 days.  
If a user name is tagged as 
Temporary, the license has 
been activated, but not yet 
reported to DSI. 
 
 
 
This screen can be utilized to unregister a user from their license, freeing it up for another user.   
Click on the box(es) for the user(s) to be unregistered, in the Unregister column, then click on the 
Unregister Users  button.  This will free up their license immediately for use by another. 
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Workgroup assignments 
can also be made from the 
License Detail  screen, by 
clicking on the Update 
WorkGroups  button.  
Workgroups are handy for 
grouping users into various 
categories (Admin, 
Accounting, Escrow, Title, 
etc.).  You can search for a 
particular user from the field 
at the top of the screen.  To 
assign a workgroup, check 
the user or users, enter a 
workgroup name in the field 
at the bottom of the screen, 
and click the Apply  button. 
 

 

 

 

 

 
The View Report  button, on the License Detail  screen, will generate a User Details  report, like that 
shown below.  
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Product Activation 
If a new product is installed, it must be “Activated”.  An e-mail notification will be sent to the Product 
License contact, on record at DSI for the database, with the Activation Key  in it.  Click on the 
Activations  button, on the License Manager primary screen, to open the Activations screen (shown 
below), highlight the product to be activated and enter the Activation Key to complete the process. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Normally, new product activation would be managed by DSI staff. 
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USER TABLES MENU 

There are many lookup tables and dropdown lists that appear throughout Impact/SQL. The values 
that appear on most of those lists are entered and maintained in the User Tables . The contents of 
these tables, if carefully considered in advance of their entry, and if carefully maintained as business 
conditions warrant, can make the users of the system much more efficient and reporting out of the 
system can be extremely valuable in decision-making situations. The initial loading of data into these 
tables will generally be made by DSI, in conjunction with the company’s representatives. Company 
representatives must be involved, as only they know the company’s mode of operation and unique 
naming conventions and product offerings.  The User Tables  menu routinely has twenty-four items 
on it, as presented below. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note : The Sales Tax Tables  and Excise Tax Tables  appear on the menu if the Setup Options > 
General > Enable Washington State Requirements  is turned on (not shown here). 
 
Many of the maintenance screens for user tables are common in form, and so in the explanation of all 
of the tables that follows, only differing examples will be shown, after a detailed discussion in the 
Marketing Reps section. 
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MARKETING REPS 

The marketing representative listing is maintained in this table. The marketing representatives listing 
is utilized in a list box in the Initial Questions  data entry area of the Escrow module. As was noted 
above, in the System Files > Setup Options > Escrow1,  the base number of marketing reps per file 
accommodated by the system is two, but that can be increased to four per file by enabling the option 
Enable Marketing Reps #3 and #4 . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Each marketing representative is assigned a two-digit code. There must be an item coded “00” with 
the description “None” in the table and is now a default in this table. And, as of Impact/SQL version 
5.12, the description of None, on Marketing Rep “00” can no longer be changed. The codes are used 
internally by Impact/SQL rather than storing the full name on each file. Therefore, changing the 
numbering on existing marketing reps will invalidate historic reporting. It is recommended that if a 
marketing rep leaves, their code and name combination be left intact for a sufficient period so that 
any reporting done by marketing reps is completed and will not need to be re-generated.  The 
departed marketing rep’s entry can be marked “Inactive” and will then not appear to be able to be 
assigned to new files. 
 
When this menu item is selected, the screen above will be presented. As was mentioned in the 
introduction to the User Tables  section, this screen is common in form to many of the user table 
maintenance screens. It will be explained in detail here and then examples of other tables will only be 
shown if they differ substantially in structure. 
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The standard user table maintenance screen has a listing of existing entries on the upper left side of 
the screen and command buttons down the right side. Unique codes are required. The command 
buttons and their functions are: 
 

• Add : Click on this button to create a new entry to the table. A data entry screen, like the one 
shown here will be presented.  

 
 
 
 
 
 
 
 
 
 
 
 
• Enter a new Code , the new Name, Email  address, and Employee Id of the new marketing 

rep. If the entry is acceptable, click on the OK button and it will be saved. If you change your 
mind and want to close the data entry screen without saving your entry, click on the Cancel  
button. 

 
• To modify an existing entry, click on the item in the listing, then click on the Edit  button and 

you will be able to modify the data.  Alternatively, double-click on the entry to be edited and 
the data entry/modification screen will be presented. 

 
• Delete: If you wish to delete an entry from the table, you should click on the entry you wish to 

eliminate and then click on the Delete button. The code “00” cannot be deleted as it is a 
system defined code. 

 
• Move Up & Move Down : The order of presentation of the table on this screen is the same 

that will be seen in the list box displayed for the user in the Escrow module. If you have a 
preferred order of display, you can use the Move Up and Move Down buttons after clicking 
on a particular entry to reposition it in the table. The order of initial entry is not important as 
the list can be re-arranged with these buttons. As an alphabetical sort is not always the way 
companies wish to see such data presented, this approach has been selected to provide the 
most flexibility for the users. It is recommended that the most frequent selection(s) be placed 
at the top of the list to speed up the user involvement with the dropdown list.  

 
• Print : To generate a formatted report of the codes and entries associated with them, click on 

the Print  button. It is recommended that the person responsible for maintaining the user 
tables keep a copy of the current contents of each table handy for reference. All of the tables’ 
contents should routinely reviewed for accuracy and relevance. 

 
• Cancel : To close the Marketing Reps user table maintenance screen without saving changes 

that have been made, click on the Cancel  button in the lower right corner of the screen. 
 
• OK: To save changes that have been made through the Marketing Reps user table 

maintenance screen and close the screen, click on the OK button in the lower right corner of 
the screen. 
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HOLD TITLE AS 

The entries to this table (Hold Title As ) are pre-established vesting clauses. Some examples would 
be: “husband and wife”, “husband and wife, as community property”, and “as tenant in common”. 
These phrases are used to fill the vesting description fields associated with each buyer and seller 
name (labeled Hold Title Code  on the Buyers’ Names  and Sellers’ Names  screens). The user may 
override an entry selected from the list box and enter a vesting clause of up to 255 characters, per 
name.  
 
Each clause is assigned a two-digit code, as were the marketing representatives. These code/clause 
combinations, once used, must not be changed or the information that already exists in the database 
will be invalid. A blank entry with the code “00” is required in this table. If the blank entry is selected 
by users from the list box, they will need to enter a customized clause manually. 
 
The maintenance screen for Hold Title As  has the same structure as the Marketing Reps  screen, so 
please refer to that section for a detailed explanation of the functionality of the screen. 
 

TRANSACTION TYPE 

Transaction types are used to distinguish categories of escrows providing a mechanism for grouping 
them for statistical reporting, for automatic ticklers (through the Automatic Ticklers  table), and for 
customizing of tracking routines (through the Tracking Descriptions  tables). The number of types 
created and the categorizations made are very dependent on the individual company’s product set 
and market. Some examples of transaction types might include “Residential Sale”, “Residential 
Refinance”, and “Commercial Sale”. Again, some companies will have very short lists of transaction 
types and some will have longer lists. Two points to keep in mind when establishing the types are: 
what kind of management reporting will be expected and to what extent does the company want 
customized workflow tracking structures established for different types of escrows.   
 
Transaction types, in addition to their two-digit code and name, carry a flag related to whether 
escrows of each type might be reportable to the IRS, with regard to the 1099-S process. If the type is 
generically flagged IRS Reportable , on the maintenance screen, the function within Escrow that is 
used to definitively identify a specific transaction as reportable or not is made available. If the 
transaction type is not generically flagged as reportable on the maintenance screen, the user will not 
have the ability to mark any escrow assigned that type as reportable to the IRS. 
 
There is also a flag associated with each transaction type that identifies whether the type is 
exclusively refinance related. If this flag is set, then the setup option to push data entered under the 
Sellers’ Names  screens to the Buyers’ Names  screens for refinance transactions will be effective. 
 
The maintenance screen for transaction types is similar to the tables discussed above, with the 
addition of the two flags IRS Reportable and Refinance .  Below, the maintenance screen is shown 
superimposed on the table listing screen. 
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TITLE RATE DESCRIPTIONS 

The information maintained through this menu item is used to identify the policy or polices that are 
being purchased through each file. It also can be used in conjunction with Rate Chart  data to 
compute rates within Impact/SQL. The user will see the listing on the first Initial Questions  screen 
under the field heading Premium Rate . The Title Rate Descriptions  are maintained in a series of 
tables, one for each underwriter established in the system. The underwriters must be created in the 
system, prior to Title Rate Descriptions  tables being set up, through Title > Documents > 
Document Maintenance > Edit > Underwriter Menu Tabl e.   
 
Each description has a unique two-digit code  within each underwriter. Once a code/description 
combination has been used, it cannot be changed without affecting what is seen in the files. NOTE: if 
the Title Rates Descriptions  table is modified, the Title Order Sheets, which a re Crystal 
Reports, must also be modified. 
 
The various policies offered by each underwriter and the combinations of policies that might be sold 
are used as the factors in determining the items to be entered on these tables. For example, you 
would have items for each type of owner’s policy offered, for each lender policy offered, and for the 
various combinations of owner and lender’s policies offered. The descriptions are to be stylized with 
the description of the owner’s policy first (if any) and then the lender’s policy or policies (up to three), 
if any.  
 
There are also four fields, for each description, which are used to categorize the policy or policies 
identified in the descriptions as “Standard” (S) or “Extended” (E). These four fields are on the Escrow  
Title Rates  maintenance screen. NOTE: the first of the four fields refers to the Owner’s policy type 
only, so if there is no owner’s policy being issued that position will be blank. The second field is for 
the first lender’s policy, the third for a second lender’s policy and the fourth for the third lender’s 
policy. When the descriptions and codes are combined, they tell the user (in text) and the system (in 
codes) what they need to know to identify the policy(ies) being issued and, if so configured, the rates 
to use. Some examples will help: 
 
Code:  01 
Name: Owner’s Policy and ALTA Lender’s 
Policy   
Type fields: S E _ _ 
 
Code: 02     
Name: Owner’s Policy    
Type fields: S _ _ _   
  
Code: 03 
Name: Lender’s Policy 
Type fields: _ S _ _ 
 
Code: 04 
Name: Extended Owners, ALTA Lender’s and Standard Lender’s 
Type fields: E E S _ 
 
The same codes and descriptions can be used for each underwriter, if appropriate. 
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RATE CHART 

Impact/SQL can compute Escrow and Title charges for the users for a fixed dollar range of 
transactions if rate tables are established for the underwriter(s) that have been set up in the system. 
Each Rate Chart  is comprised of five tables. A Loan Rate chart can also be set up. This chart is used 
for re-finance transactions only and is the same format as the Rate Chart . Discounts can be used 
instead of setting up loan rate charts.  
 
Note:  In the names below, the “#” sign is replaced with the underwriter number assigned when the 
underwriter was established in Impact/SQL: 
 
 Ratechart#.tbl  this is the primary rate table for the underwriter 
 Bldresc#.tbl   builder’s escrow discounts 
 Bldrttl#.tbl  builder’s title discounts 
 Develpr#.tbl  developer’s title discounts 
 Othrate#.tbl  simultaneous issue rates 

Ratecharta#.tbl this is the rate table for the underwriter when using the ‘Loan Escrow’ 
option 

 
All of the “*.tbl” files are “flat files” that are edited with Notepad or another ASCII editor. They are fixed 
position files and so the editing of the tables must be done with care. The line and position of each 
item is critical to the programs within Impact/SQL that read the files. They can be viewed and edited 
under this menu heading. When this menu option is selected, Notepad is loaded. You then use the 
File > Open  steps to get to the Windows browsing tool to locate the table you wish to edit. The tables 
(*.tbl) are located in the “DATA” directory of the Impact/SQL installation. 
 
The primary table is the “Ratechart#.tbl”. It is made up of five parts that are all laid out in one “flat file”. 
 

• Part One: consists of the minimum and maximum insurance levels to be covered by the table 
and the increments it will be priced in. 

• Part Two: is comprised of seven “levels” of rates; the rate increments are consistent within 
each level. 

• Part Three: details the rate increments within the levels identified in Part Two. 
• Part Four: consists of descriptive heading information for the columns of the rate schedule 

that follows in Part Five and the effective date of the rates. 
• Part Five: is the actual rate table for the range identified in Part One. The last entry in this 

part is the cutoff for the first “level” identified in Part Two. 
 
The charts below show the starting and ending positions for each column in each section of the table. 
 
NOTE: Care must be taken to align these columns properly.  
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Part One  makes up the first seven lines of the table. Line 1 contains the starting dollar amount of title 
insurance on the base table. Line 2 contains the ending dollar amount of title insurance on the base 
table. Line 3 identifies the increments between escrow fees. Line 4 identifies the maximum 
transaction dollar amount for escrow fees on the base table. Line 5 identifies the title increment. Line 
6 identifies the maximum transaction amount covered by the base table. This is generally left as 0 so 
that the rate chart can go to infinity. Line 7 is the maximum size of manual entries. This is the same 
number as line 2, Table End. The column headings identify the record position numbers used for 
each column; they are not included in the table. 
 

POS: 1 to 18 (=@18) 19 blank 20 to 26 figures Beyond 54 ;Comment 

  Table Start       =   28000 
  Table End         = 1000000 
  Escrow Increment  =    1000 
  Max for Increment = 1000000 

  
Amount Increment  =    1000 
Calculation Max   =       0 

  1000000      ; max size of manual entries 
 
In this example of Part One, the base table starts with a $28,000 insurance amount and caps out at 
$1,000,000 of insurance, incrementing in $1,000 steps. 
 
Part Two  makes up the next seven (7) lines of the table. Each line represents a cutoff level where 
charges for escrow fees and title insurance may begin to increment at different rates from the level 
below. If the company’s rate chart does not reflect seven distinct rate increment changes, duplicate 
the last level, as many times as needed until there are seven rows of information. The seven levels 
have five columns of data and a comment. The columns are the escrow fee, the basic owner’s policy 
rate, the combination ALTA lender’s policy rate, the standard lender’s policy rate, and the rate for the 
ALTA lender’s policy. The comment on each line identifies the maximum transaction amount for that 
level. Begin each comment with a semi-colon “;”. 
 

  Escrow 
Basic 

Owner's  
Combo ALTA 

Lender's  
Std 

Lender's  
ALTA 

Lender's  Max Trans Amt. 
POS: 8 to 16 17 to 24 27 to 34 37 to 44 47 to 54 Beyond 54 

  900.00 2907.00 947.10 2325.60 3197.10 ;to 1,000,000 
  1400.00 4907.00 1757.10 3925.00 5397.10 ;to 2,000,000 
  2600.00 8657.00 3257.10 6925.00 9537.10 ;to 5,000,000 
  2600.00 8657.00 3257.10 6925.00 9537.10 ;to 5,000,000 
  2600.00 8657.00 3257.10 6925.00 9537.10 ;to 5,000,000 
  2600.00 8657.00 3257.10 6925.00 9537.10 ;to 5,000,000 
  2600.00 8657.00 3257.10 6925.00 9537.10 ;to 5,000,000 
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Part Three is made up of seven lines of information detailing the increments at each step within each 
level identified in Part Two. The first column identifies the maximum insurance amount at each cutoff, 
except for the first line. The first line is the minimum insurance amount. The last line is the maximum 
amount of the table. The second column then details the cost increase, in dollars, per increment 
defined in Part One for escrow fees. The third column is the incremental cost increase for the basic 
owner’s policy. The fourth column is the incremental cost increase for the combination ALTA lender’s 
policy. The fifth column is the incremental cost increase for the standard lender’s policy. And the sixth 
column is the incremental cost increase for the ALTA lender’s policy. 
 

  Max Amt. Escrow 
Basic 

Owner's 

Combo 
ALTA 

Leader's 
Std 

Lender's 
ALTA 

Lender's  

POS: 1 to 8 9 to 14 18 to 24 28 to 34 38 to 44 48 to 54 

  28000       
  1000000 0.50 2.00 0.81 1.60 2.20 
  2000000 0.40 1.25 0.50 1.00 1.38 
  5000000 0.40 1.20 0.48 0.96 1.32 
  5000000 0.40 1.20 0.48 0.96 1.32 
  5000000 0.40 1.20 0.48 0.96 1.32 
  5000000 0.40 1.20 0.48 0.96 1.32 

 
Just as the last line of Part Two needed to be repeated to ensure seven rows of data, that pattern 
must be followed in Part Three. 
 
Part Four  consists of commented lines (beginning with semi-colons “;”) that give headings to the 
columns to follow and identify the effective date of the rates. This date will appear on the rate chart 
printout, so should be nicely formatted.  
 
Note: There is not a limit to the number of commented lines for part four. 

      Align to Your Preference           

;Amount    Esc    Owners     Combo    Std Ln     ALTA       

;EFFECTIVE DATE 10/01/06  Sample Title Company Name - UNDERWRITER: Your Underwriter Name 

 
Note:  It can be helpful to enter the underwriter name after the “effective date”, especially if you have 
multiple underwriters. 
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Part Five  is comprised of a detailed chart of all of the values within the first level of rates, as identified 
in Part Two. This data must be entered manually or loaded to a text file from MS Excel. The rates for 
the subsequent levels are computed based on the transaction amount and the incremental cost 
increases identified in Part Three. The table consists of six columns, following the pattern of Part 
Three, with the first column being the title insurance amount at each increment. Again, care in 
aligning the data is critical. 
 

  Max Amt. Escrow 
Basic 

Owner's 

Combo 
ALTA 

Leader's 
Std 

Lender's 
ALTA 

Lender's  
POS: 1 to 6 12 to 19 22 to 29 32 to 39 42 to 49 52 to 59 

  28000 178.00 250.00 175.00 200.00 275.00 
  29000 179.00 256.00 175.00 204.80 281.60 
  30000 180.00 262.00 175.00 209.60 288.20 
  31000 181.00 268.00 175.00 214.40 294.80 
  32000 182.00 274.00 175.00 219.20 301.40 
  - - - - - - 
  - - - - - - 
  997000 898.50 2901.00 945.30 2320.80 3191.10 
  998000 899.00 2903.00 945.90 2322.40 3193.30 
  999000 899.50 2905.00 946.50 2324.00 3195.50 
  1000000 900.00 2907.00 947.10 2325.60 3197.70 

 
Once all of the data is entered into these five parts of the Ratechart#.tbl for a specific underwriter, the 
rates can be tested with the rate calculator by going to Escrow > Misc. > Rate Calculator  and then 
clicking Print.  It will ask for a beginning and ending increment amount 
 
Below is an example of what the rate chart will look like once completed: 
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The formats for the other four tables are as shown below. Note : Care should be taken with the 
descriptions, as they are the only labels shown in Escrow and Title: 
 
BLDRESC#.TBL: drives escrow fee discounts (or additions) for builders. The discounts (or additions) 
are a percentage of the escrow fee. The positions 1-34 are for the description, positions 35-37 are for 
the value, and position 38 is for the “%” sign. A sample would be: 
 
70% Invest Broker Dev              70% 
 
BLDRTTL#.TBL:  drives title premium discounts (or additions) for builders. The discounts (or 
additions) are a percentage of the title premium. The positions 1-34 are for the description, positions 
35-37 are for the value, and position 38 is for the “%” sign. A sample would be: 
 
1 to 100 units                        70% 
101 or more units                  65% 
 
DEVELPR#.TBL: drives title premium discounts (or additions) for developers. The discounts (or 
additions) are a percentage of the title premium. The positions 1-34 are for the description, positions 
44-46 are for the value, and position 47 is for the “%” sign. A sample would be: 
 
80% Title Re-Issue                                 80% 
65% Developer Discount                        65% 
 
OTHRATE#.TBL: drives other discounts/additions to title premiums and escrow fees. The 
discounts/additions are a percentage of the fees or a fixed amount. The positions 1-25 are for the 
description, position 26 is blank, position 27 is for the “=” (equal) sign, position 28 is blank, and the 
value begins in position 29. Note : the records must be in the order shown or erroneous calculations 
are possible. A sample would be: 
 
Owners Extended Rate         =  150% 
Lenders Extended Rate         = 120% 
Simultaneous Standard Fee =  50.00 
Simultaneous Extended Fee =  50.00 
Simultaneous Combo Fee     =  50% 
Simultaneous Escrow Fee     =  40.00 
Buyer Escrow Fee Percent    =  50% 
 
Note:  The Simultaneous Standard, Simultaneous Extended, and Simultaneous Escrow fees shown 
are in dollars, not percentages. 
 
RATECHARTA#.tbl: this chart is used for the Loan Escrow option. The format for this chart is the 
same as the RateChart#.tbl. This is the only chart used for the “Loan Escrow” as the Buyer and Seller 
Discounts are not available for this option.  
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MULTIPLE RATE CHARTS 
Impact will support multiple rate charts for the same underwriter, segmenting by State and County, 
using the following naming convention. 
 

Description File Name Spec 
Rate Chart Ratechartusscccc .tbl 
Builder Escrow Discounts Bldrescusscccc .tbl 
Builder Title Discounts Bldrttlusscccc .tbl 
Developer Discounts Develprusscccc .tbl 
Other Rates OthRateusscccc .tbl 

 
Where:  

u- Underwriter number 
ss- State abbreviation 
cccc - County Name 

 
If using multiple rates for the same underwriter, make sure to have corresponding file names for all 
charts. For example, if you have a RateChart1AZPima.tbl, make sure that you also have 
Bldresc1AZPima.tbl, as well as any other discounts used, in order to access the discounts.  
 
When calculating a rate without a specific file loaded and the system detects multiple rate charts for 
the underwriter you selected, the Rates For  drop down is displayed (as is shown below). You can 
choose the State or State/County Combination you wish to use. If only one State or State/County file 
is found, it will be selected for you and the Rates For drop down will be disabled. 
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PROPERTY DESCRIPTIONS 

There are five menu choices under this heading that provide maintenance screens for tables of 
commonly used Cities, Subdivisions, Counties, Municipality Types,  and Property Types . Each of 
these will be explained below.   

 

CITIES 
The Cities  user table is the maintenance location for the City  field on the Initial Questions > 
Property Information  screen. The cities most commonly involved in transactions the company 
handles should be listed in this table to speed data entry by Escrow personnel and to ensure 
consistency of spelling on documents. The user may enter a city that is not on the dropdown list. The 
data in this lookup table is also used in the Transfer Tax  table and the Tax Stamp  table, therefore, 
this list should be entered before the Transfer Tax  table, and Tax Stamp  tables are addressed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
There are three dropdown lists on the add/edit screen, which present lists, two of which are also 
maintained through other entries on the Property Descriptions  menu: Municipality Type  and 
County . Those lists, if prepared first, will speed data entry of this list.  The State  listing is the third 
dropdown. 
 
The format of the maintenance screen is similar to those for Marketing Rep  and Transaction Type  
with the only difference being the fields of information being entered for each city. The Cities add/edit 
screen is shown here, presenting the full set of data to be entered. 
 
Besides the name of the city or town, Municipality Name , Municipality Type , County , and State  
fields are available. The municipality fields are primarily used by Alaskan companies, but are 
available to all. The County  field must be filled from the dropdown list that is populated via the 
Property Descriptions > Counties  screen. The State  field has a dropdown list also, which is pre-
populated with all of the states. The information here is used in conjunction with the tax tables. If a 
city straddles more than one county, the county field should be left blank. 
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SUBDIVISIONS 
The Subdivision  table also provides data for a dropdown list on the Initial Questions > Property 
Information  screen. If the user selects a Subdivision Name  from the list box and then clicks inside 
the Brief Legal  field, this field will be filled with the Tract , Map Book,  and Map Page  information 
stored for the particular subdivision. The Legal Clause  value is the file name of the master document 
prepared under Escrow > Documents > Document Maintenance > Legal C lauses.   
 
The format of the maintenance screen is the same as those for Marketing Rep  and Transaction 
Type  with the only difference being the fields of information being entered for each subdivision. The 
Subdivisions maintenance screen is shown here, presenting the full set of data to be entered. 
 
 
 
 
 
 
 
 
 
 
 
 

COUNTIES 
The counties most commonly involved with the company’s transactions are maintained in this table. 
The list feeds the City , Transfer Tax , and Tax Stamp  table maintenance screens and more 
importantly, feeds the County  field on the Initial Questions > Property Information  screen, 
ensuring consistency of spelling on documents. The table has only one field: County . 
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MUNICIPALITY TYPES 
Predominantly used by USA Digital Solutions’ Alaskan customers, the Municipality Types  lookup 
table feeds the field of that name on the Initial Questions > Property Information  data entry screen.  
It has only one field, the officially recognized description of each municipality type in the state. 
 
 
 
 
 
 
 
 
 
 
 
 

 

PROPERTY TYPES 
The Property Type field, in the Initial Questions > Property Information , can be filled with values 
from this table. The descriptions entered are used in Management Information System (MIS) reports 
to segment the company’s business by property type (for example: 1-4 Family Residential).   
 
Each description has a unique one or two digit code. Once a code/description combination has been 
used, it cannot be changed in this table without affecting what is seen in the files.   
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RECEIPT TYPES 

The Receipt Types  are very important to the workflow processes in Impact. Depending on which 
type code is assigned to each receipt, different behaviors will be triggered in Impact/SQL. There are 
several settings associated with each receipt type that prompt these differences, as will be explained 
below. The receipt type that is assigned to each receipt is presented in the Ledger  for each file. 
Receipt Journal reports can be sorted by receipt type. The receipt type dropdown list is used on the 
Receipt Entry  screen. 
 
While each company may create and utilize the receipt types they need for their business process, 
there are some codes which are required for proper execution of Impact/SQL’s programs and which 
cannot be altered or deleted. These are: 
 

• WIN: Wire In – used by incoming wire processing. 
• SAV: Savings – used with the savings (interest bearing) account ledgers to add or remove 

funds manually. Receipts of this type only affect savings ledgers.  The SVD and SVC receipt 
types relate to the more automated savings transfer action. 

• INT: Interest earned – used to record interest earned within the savings ledgers only. 
• SVC: Debit Escrow, Credit Savings – used by the system with the automated savings transfer 

function to move funds from an escrow ledger to a savings ledger. 
• SVD: Credit Escrow, Debit Savings – used by the system with the automated savings transfer 

function to move funds from a savings ledger to an escrow ledger. 
• TRF: Transfers – used if funds transfer between files with the same branch and bank has 

been permitted through the setup options for Escrow and/or Accounting. 
• NSF: Non Sufficient Funds – in the event of an NSF being receipted an e-mail notification can 

be sent to the escrow officer of the file, if  the setup option to e-mail escrow officers is 
enabled. 

• FST: used for fee slip transfers from escrow ledgers. 
• FSV: voids of FST’s. 
• FSR: fee slip reversal of a FSV. 
• TBB: Transfers with change in Branch and Bank. 
• TBK: Transfers between Banks. 
• TBR: Transfers between Branches. 
 

Note : WIO: Wire Out – outgoing wires are considered disbursements within Impact/SQL and this 
code will not appear in the code table and should not be added to it to avoid the erroneous use of the 
code. 
 
The BCF Balance Carried Forward receipt type, while not mandated, can be used and it will return 
zeroes for the receipt number and is used during a conversion to reflect a starting balance in an 
escrow that was originated in another system. 
 



 

Impact Utilities Manual for version 7.0.0 Page 82 

There are four configuration parameters for each receipt code entered in the table: Allow  Escrow , 
Depositable , Math Sign  and Applies To . 
 

• Allow Escrow : this check box identifies whether the code will be made available to Escrow 
module users or whether the code will be limited to Accounting users. 

• Depositable : if a receipt type is configured to be depositable, each receipt tagged with the 
code will appear on the Deposit Slip  screen and will not appear directly within a 
reconciliation. This flag should be used for receipt codes that are to be assigned to items that 
are physically deposited at the bank, either singly or in aggregate, along with a deposit slip 
whether prepared within Impact/SQL or manually. If depositable, the receipt will appear on 
the Deposit Slip  preparation screen until included in a deposit.  

• Math Sign : receipt types can be configured to accept a positive value only, a negative value 
only, or either type of value. This can help reduce data entry errors. 

• Applies To : there are three options: RCT – Receipts , WIN – Wire In , and WIO – Wire Out . 
This setting identifies which particular functionality the receipt code is involved with. This 
setting is used to sort receipts by broader categories in the reconciliation module. 
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AUTOMATIC TICKLERS 

Automatic Ticklers  are pre-determined 
reminders that can be established for any 
one or all Transaction Types  based on a 
specific number of days from the date the 
escrow was opened or before the 
expected close date. They can be 
triggered based on the presence of a 
value in one of five fields: Lender #1 
Name, Lender #2 Name, Lender #3 
Name, Buyer Payoff #1 , or Seller Payoff 
#1.   
 
Selecting this menu item opens up a 
listing of existing tickler items, if there are 
any, and provides buttons to Add , Delete , Modify  or Cancel . If you are adding an item, just click on 
that button. To delete or modify an item, first click on the item, then the appropriate button. To leave 
the screen, click on Cancel . The screen above shows the next screen that appears if Add  or Modify  
are selected.  
 
A specific Transaction Type or ALL  is selected. The Date to Base  on  is chosen, Date Opened  or 
Date Closed . The Private  checkbox is used to limit exposure of the tickler items to the company 
only; the items marked Private  will not be displayed to Impact Online users. The Number of Days 
from/to  base  should be entered as a positive number to reflect the number of days after the opened 
date or a negative number to reflect the number of days before the estimated closing date that the 
tickled item will reflect as due on under Escrow > Ticklers > Reminders ( and Select & Edit) . The 
Description  is the actual tickler message that the user will see. The Based On Presence of  field can 
limit the tickler to only appear if there is a value in one of the five fields identified above. If left blank, 
there is no restriction. 
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INCOME ACCOUNT NUMBERS 

Escrow users, when coding the fee check or fee slip detail lines, use the Income Account Numbers 
(Codes)  entered in this table. The codes must be numeric, can be up to five digits long, and can have 
leading zeros. It is most typical to have the codes match up with the account numbers used in the 
company’s general ledger system for the various revenue items and pass-throughs being tracked 
(Title Premiums, Escrow Fees, Delivery Fees, etc.). There is a limit of 300 income codes that can be 
defined. 
 
The Income Code Table Maintenance  primary screen, shown below, presents the Income Codes , 
their Descriptions  and whether they are Active  or not.  Inactive codes will not be available for use on 
fee slip or fee check line items.  The listing can be filtered to show only active, only inactive or all 
codes, via the Show  filter dropdown in the upper left corner. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
To add a code, click on the Add button.  To modify a code, click on the Edit button.  The add/edit 
screen is presented here. 
 
 
 
 
A Liability From option can 
be set for income codes, for 
reporting purposes only. This 
will not have an effect on 
anything else in Impact/SQL. 
 
 
 
The coded income entries, once posted, are passed to the Income Analysis file and are then 
available for reporting. Once the codes are established, USA Digital Solutio ns will need to 
initially configure the Accounting Income Analysis reports and will need to edit any income 
reports whenever codes are changed or added to the system. 
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TRACKING DESCRIPTIONS 

The tracking function, turned on or off under Setup Options > General > Enable Tracking , relies on 
the entries created here under two broad categories: Escrow  and Direct Order . The direct order 
tracking descriptions are used for Title Order only transactions, created through the Title module, 
where no escrow is involved.  
 
The tracking function provides a place where dates can be recorded relating to the start date and 
completion date of various requirements of each file. A default-tracking table with the descriptions of 
these various requirements can be established for all files and specific tracking items can be 
designated for specific transaction types. See the Transaction Types  section above for a discussion 
of transaction types. For example, some items might include: Demand for the payoff for the 1st 
mortgage, the appraisal, and the termite inspection. The tracking requirements can be specified for all 
files or files of a specific Transaction Type. A default tracking table can be established for both 
Escrow and Direct Orders. The users may customize the tracking items by file as well. The entries of 
the Date Ordered and Date Received are made manually through the Escrow and/or Title modules, 
for each item on the tracking table, for each file. 
 
Selecting the Tracking Descriptions  menu item leads 
to a second menu level of Escrow  or Direct Order . 
Below either of those, a selection list of Transaction 
Types  is presented with {Default}  as the first choice. 
Click on {Default}  and then the OK button to get to the 
actual screen where all items to be tracked for all files 
are to be identified. Select a specific Transaction Type  
and click OK to get to the listing of tracking items for that 
particular transaction type. In either case, the destination 
is a screen with two field entries for each Tracking 
Description , as shown below. Each tracking description 
has fifty-three character positions, including spaces, 
available.   The Event Code column is utilized with the 
Track My File integration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In practice, the Escrow or Title user will see a screen accessed via Escrow > File > Tracking . Users 
will enter dates in the Date Ordered  and Date Received fields as items are dealt with. The column to 
the right of the Date Received  field is used for comments up to 50 characters in length. As was 
mentioned above, users can customize the tracking detail for each file, once established, through that 
screen. 
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TITLE OFFICER NAMES 

All outside title officers that the company works with may be listed in the Title Officer Names  table, 
maintained through this menu item. The entries here are simply the full name of the title officers, an 
employee id and a inactive flag. Entries can be re-arranged in the table with the Move Up and Move 
Down  buttons, on the initial listing screen, to enhance selection speed for the users if there tends to 
be a higher frequency of selecting one or more TO’s over others.    
 
The Add/Edit buttons will take you to a maintenance screen like that shown here. 
 
 
 
 
 
 
 
 
 
 
 
 
The table is used for the lookup list on the Edit > Initial Questions > Title Information screens in 
both the Title and Escrow modules. This is not  the listing of internal title officers identified on the 
Initial Questions > Dates/Transaction Information  screen. Care should be taken in training so the 
two fields are not confused.  
 
The inclusion of an Employee ID field in this listing was made to accommodate clients who wanted to 
use this table for internal title officers, but, again, this listing is normally of outside title officers. 

 
 

SETTLEMENT STATEMENT HEADERS 

This maintenance screen is used by the company to rearrange the groupings of charges on the 
Settlement Statement to meet the company’s preferred manner of presentation. There is a fixed set of 
ten (10) heading categories and while all ten lines must always be displayed in the maintenance 
table, the entry descriptions can be changed or blanked out, if desired, to re-group lines. For this 
reason, you will not see the Add  and Delete  buttons on this screen, only the Move Up and Move 
Down  buttons. To edit a description, click on Edit, and a maintenance window will be presented.   
 
When the headings are 
rearranged, the detail charge 
lines under each heading will 
move with the headings. 
 
The full screen is shown here 
with one category’s 
description blanked out. The 
standard Title Charges and 
Escrow Charges entries 
have been combined.  
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INVOICE DESCRIPTION 

The Invoice Description  table entries are used to provide standardized selections for users when 
preparing an invoice. A dollar amount can be assigned to each invoice item. This can make 
preparation of an invoice a very quick and accurate process. During invoice preparation, the users 
can edit descriptions selected from the list. They can edit both the text and the dollar amount. 
 
The Invoice Codes  maintenance 
screen is shown to the right. Each 
description is given a Code  of up 
to three digits. The Description  of 
the invoice item is entered in that 
field and will pull to the Invoice  
Entry  screen when that particular 
code is selected from the 
dropdown list during invoice 
preparation. The Hud Line  and 
Code  fields can provide for a 
value to be printed on a customized invoice. The G/L # field, which is populated from a dropdown of 
the Income Account Numbers , can also be used on the invoice, if so customized. The Amount , if 
entered, will pull to the Invoice Entry  screen and to the printed invoice. 
 
Impact/SQL does not have an Accounts Receivable module, but invoice data can be exported to an 
outside package (see Impact/SQL Invoice Export). USA Digital Solutions can create custom filter 
programs for the export module if the current filters are inadequate. 
 
 
CLOSING STATEMENT CATEGORIES 

Two category groupings are maintained under this 
menu item: HUD and Settlement Statement . 
Depending on whether the company utilizes both 
documents, you may or may not need to edit both 
tables. It is recommended that you keep both the 
same for consistency. However, depending on the 
verbiage norm in your market place, they may be 
different. The purpose of these two listings is to 
provide a heading for the HUD and Settlement 
Statement documents that indicates which version of 
the document is being printed. The listings will show up under Print 
Options  when the documents are generated. The value selected will 
appear right above Line C on the HUD and under the main title on the 
Settlement Statement, as shown in the samples. The same HUD is 
used for all choices.  Settlement Statements can be customized so 
each Category could present different verbiage, if desired. 
 

 
 
The maintenance screens for both are 
very similar with the addition of a 
Form Type  field on the Settlement 
Statement categories table details 
section. This is used to trigger which 
document to generate.  
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TRANSFER TAX TABLES  

There are two sets of setup screens that are used to support the system’s ability to compute transfer 
taxes, for those locales that have such taxes, from within the HUD or Worksheet data entry areas for 
Recording Expenses. Both County Transfer Tax  and City Transfer Tax  can be computed and the 
setup screens are identical except that one identifies the county that the setup is for and the other 
identifies the city. The counties and cities listed in the User Tables > Property Descriptions > 
Counties  (& Cities ) tables are available in these setup screens via dropdown menus. The county 
and city identifiers on each escrow are used to select which configuration to use when the taxes are 
called upon to be calculated. The transfer tax will be calculated based on the sales price.  
 
Within each set, there are two mutually exclusive types of calculations available: non-tiered and tiered 
calculations. A checkbox controls which type of calculations will be defined. If tiered calculations are 
selected, up to four tiers are provided for. The two versions of the calculation setup screens are 
shown here.  To begin editing, select a County  or City  from the dropdown listing (depending on the 
table being worked) and hit the TAB  key. 
 
 
 
The non-tiered screen asks for the tax 
Amount , the Per increment, how the 
rounding will be done, and who the cost is 
applied to by default. Exemption 
information can also be identified. 
 
 
 
 
 
 
 
 

 
 
 
 
 
The “tiered” screen asks for similar information for 
each of the four “tiers” of sale prices. 
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TAX STAMP TABLES   

There are two sets of setup screens that are used to support the system’s ability to compute tax 
stamps for those locales that have such taxes from within the HUD or Worksheet entry areas for 
Recording Expenses. They are County/City Tax Stamp  and State Tax Stamp. Both County/City and 
State tax stamps can be computed and the setup screens are identical except that one identifies the 
county that the setup is for and the other identifies the state. The counties listed in the User Tables > 
Property Descriptions > Counties  tables are available on this setup screen via a dropdown menu. 
The county identifier on each escrow is used to select which configuration to use when the taxes are 
called upon to be calculated. The tax stamp can be calculated based on the sales price or mortgage 
as required. 
 
The screen for County Tax Stamps  is presented here (the State screen is the same). There are two 
sections to the screen: on the left side, the Deed Calculations  section provides fields for the 
parameters required and, on the right side, the Mortgage Calculations  section does the same. The 
Amount  to be charged and Per increment (for example, per 1,000.00) are identified, then the Round  
field is filled with up  or down  and the amount to Round to Nearest  is specified. The Default Charge 
to  field is filled with either buye r or seller . Radio buttons are used to identify whether the tax stamp is 
to be Based on Sales Price  or Based on Mortgage . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the locale from the dropdown box and hit the TAB  key to begin data entry or editing; or, once 
the locale is selected, click on any data field to begin data entry or editing. 
 
Click on Cancel  to quit without saving your changes. Click on OK to save and quit. You can generate 
a report of settings with the Print button and if the settings for a specific county or state need to be 
removed, select the locale and click on Delete .  
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RECORDING FEES 

The company will use this screen to set up the parameters for computing the recording fees for the 
Deed of Trust, Mortgage, and Release. They can be entered for all of the state and county 
combinations that the company’s offices do business with. When the Escrow users are in the 
Government Recording  and Transfer Charges  section of the data entry screens, they will see a 
check box to Calculate  the fees and if the state and county combination for the transaction involved 
is configured here, the system will display a screen of the calculated charges. The user can edit the 
calculated data if so desired. If the particular state and county combination involved has not had 
parameters set for it, an alternate screen will appear to the Escrow user stating that fact and asking 
the user to enter the fees applicable to the buyer and seller. 
 
As shown below, the setup screen has sections for each of the three document types and fields for 
the charges in the customary manner computed: Amount: $x.xx for the first x pages . Additional 
pages at $x.xx per page.  If surcharges are collected, they are provided for and whom the charge 
should default to (Buyer  or Seller ) is identified. Dollar signs and commas should not be entered 
during setup. 
 

 
Select the State and County from the dropdown boxes and hit the TAB  key to begin data entry or 
editing. 
 
Click on Cancel  to quit without saving your changes. Click on OK to save and quit. You can generate 
a report of settings with the Print  button and if the settings for a specific county and state need to be 
removed, select the locale and click on Delete .  
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PRELIM DISTRIBUTION VIA 

If the Enable Escrow Prelim Distribution  option has been turned on (System Files > Setup 
Options > Escrow1 ), then the process of entering the method of distribution for each document is 
sped up and standardized through the use of the Via lookup table, the contents of which are entered 
through this screen. Similar in nature to many of the other lookup table maintenance screens, the 
listing table and entry/edit screens look like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A character Code  for each distribution type is identified and the full name of the method is entered in 
the Description  field. 
 
 
MANDATORY FIELDS 

The company may wish to make some fields on data entry screens used by Escrow and Title (Direct) 
mandatory. The user will not be permitted to exit the screen until a value has been entered into all of 
the mandatory fields. A Missing Information  message box will pop-up, identifying which field must 
be completed. The setting of mandatory fields is managed here. 
 
There are several data entry screens for each module (Escrow and Title) that have fields which can 
be made mandatory. The screens/fields that can be made mandatory are presented on the following 
pages. 
 
Once the category (Escrow or Direct) is selected, the screen dropdown is used to specify which 
screen’s fields are to be managed. Then, a listing of available fields is presented with a checkbox that 
is used to make the field(s) mandatory. Once a change is made, the Save button will be activated and 
must be hit to preserve any changes. The Print  button will generate a report of all settings for either 
Escrow  or Direct , depending on which is selected. Once all settings/changes have been made, the 
Cancel  button will close the screens. 
 



 

Impact Utilities Manual for version 7.0.0 Page 92 

 

ESCROW 
Mandatory Field Options 

First: Screen Selection: 
 

Then: Field selection. 
 
 
 
 
 
 
 
 
 

                                           
 
 
 

Property Type Code      is 
also an option on Initial 
Questions 2. 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Note : This is the 
“outside" title officer.
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DIRECT 
Mandatory Field Options 
 

Screen Selection: 
 
 
 
 
 
 
Then field selection. 
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CHECK TEMPLATE 

The Check Template  entries are used by the system to pre-process data in the system before check 
generation. While actual checks are generated via Crystal Reports files, the data is collected and 
consolidated by payee based on the settings in this table. This permits re-naming of fields for the 
purpose of their presentation on checks and associates specific fields with specific parties to the 
transactions. These settings can provide for some very company-specific configurations. These 
settings, as they are universal to the database, are critical and once set should not be modified, 
except by knowledgeable USA Digital Solutions staff. 
 
USA Digital Solutions staff, in conjunction with 
company management, will determine what the 
settings should be on these fields and they should 
only  be altered by USA Digital Solutions 
personnel.  
 
The initial screen presented contains a listing of 
payees, the descriptions of the disbursement items for 
each, and income codes associated with them, if any. 
These are items that have already been defined. An 
example is given to the right: 
 
Adding an item is initiated with the Add  button. To 
alter settings for an item, the Modify  button is hit. Both 
will present a screen like that to the right, which details 
the parameters set for each dollar item. If an item must 
be removed, it should be highlighted and then the 
Delete  button is hit. The Cancel  button will close the 
Check Template Maintenance  screen. 
 
Once Add  or Modify  is selected, the following screen 
is presented (this one is related to the highlighted item 
in the screen above). 
 

• The Sort Code is utilized on payoff-related 
items to order them into a standardized 
presentation. 

• The Comments  field is for information only and is not available for printing on a check. 
• The PID parameters are prompt identification numbers and are used to make an assignment 

of a system field for each of the various categories for the disbursement item being defined. It 
may be that not all of the settings will be utilized for each possible check detail item. If 
multiple disbursement items are being defined, in separate entries, for one Pay to PID, the 
address PID’s need only be defined for one of the items.   

• A default value may be specified for some of the items. One example is common with the 
Income PID . If a specific line on the HUD is to be related to a specific Income Code, that 
code is entered in the Default  field. The user may override it at the time of check creation. 

• If the company does not like the description for an item on the HUD, a default value could be 
entered in the Default  field on the Description PID  line. 

• The Memo PID  is generally used for the Loan Number, Tax Parcel Number, or any other field 
label the company wishes to appear on the face of the check. The memo line is generally 
formatted to print under the City, State, and Zip  line on the check. 

 
Again, the values entered through these screens are  very detailed, company specific, and 
must not  be edited except by qualified USA Digital Solution s staff. 
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DISBURSEMENTS HOLD REASON 

Disbursements can be placed on Hold  which will reduce the File Balance , but will not reduce the 
Available Balance  and the items on hold will not appear In Process . When a disbursement is placed 
on Hold, a Reason  box is made available for the user to select a pre-defined hold reason or enter a 
reason of their own choosing. The pre-defined hold reasons are entered through this maintenance 
screen, which is similar in format to many of the others. The Hold Reasons add/edit screen contains 
just the field for the Description  of the hold reason. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PAYOFF DESCRIPTIONS 

The breakdown information for each payoff has a description and an amount for each charge (beyond 
principal and interest). There can be an unlimited number of charges listed. The user can select a 
pre-determined description from the table maintained here or may enter their own. Selecting from a 
well-thought-out listing can be a big time-saver. The Payoff Detail Descriptions  add/edit screen is 
similar in format to many of the others, with only the Description  field  as shown below. 
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USER DEFAULTS  

PAYOFFS - The company can set the 
default Days in the Year  factor for 
computing payoff interest to either 360 or 
365 days on this screen.  
 
 
 
 
 
 
 
 
RENT SCHEDULE - The company can set 
the default Days in the Year factor and the 
default term over which rent prorations are 
defined on this screen. The same 360 or 
365 days in the year option, as found in 
Payoffs , is presented and a Days in period  
option is available. The Term  options are 
Daily, Monthly, Quarterly, Semi-annual, 
and Annual  as shown below. 

 
 
 
 
Once the selections have been made, hit the OK 
button to save any changes. Click on the Cancel  
button to close the screen without saving any 
changes. 
 

 
 
DYNAMIC DATA ENTRY 

 
The Escrow option is enabled by 
choosing the Enable Misc Escrow 
Data under the Setup Options > 
Escrow1  in the Utilities module. The 
Title option is enabled by choosing the 
Enable Misc DO Data  option under 
Setup Options > Title . The ability to 
add company specific data collection 
fields was added in version 5.11. Data 
Types for the Misc Data Entry screen   
are set up under this option. Either 
Escrow, Title, or both can be enabled to 
fill these data fields. The field set is 
common to both. 
 
The data entered by users is available 
for reporting, but not for use in 
documents. 
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TOOLS MENU 

There are several tools built into Impact/SQL, which are available to a restricted set of users that can 
be used to correct problems that may arise or to perform functions that are not routine and can have 
major impacts on data in the system. The full Tools  menu, available only to users with the access 
codes System Administrator  or Digital Solutions , contains these items: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The items that can be “seen” by a user with the access code of Utilities are indicated on the list 
above. They will not see the other items. 
 
 
LOAD ABA ROUTING NUMBERS 

If the company has turned on the use of Wire Out Processing, Impact/SQL will compare the ABA 
numbers entered by users with those in a table filled with a download from the Federal Wire 
Directory. If a match is not found, the wire out will not be permitted. This download should be done at 
least once a month to ensure it is kept current. Should the system tell you that an ABA number is not 
correct and you are reasonably sure it is, the first step to take would be the updating of the routing 
number table with this function. 
 
Note : While the Name and Address File (NAF) can store the ABA Routing Number for a bank, that 
field will not be updated through this function. 
 
 
 
 
 
 
 
 
 
 
When selected, the screen above will be shown. On it is a reminder as to the Web site from which the 
file containing the data can be downloaded (using Internet Explorer). 
 

1. Open the Federal Reserve web page located at - 
http://www.fedwiredirectory.frb.org/download.cfm.  On this web site, which must be accessed 
outside of Impact/SQL via Internet Explorer, there is a link near the middle of the page named 
“Receive all Fedwire Participants”.  Right-click on this link and select the option “Save Target 
As…” . 
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2. Navigate to the location where a file can be saved. The desktop is selected in this example 

and is usually a good location as it can be easily located later. Leave the file name as is, 
fpddir.txt, and click Save to execute the download. 
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3. Once the download is complete, in the 
Impact/SQL Utilities module, select Load 
ABA Routing Numbers  from the Tools  
menu. 

 
 

4. Click Browse  on the Load ABA Routing 
Numbers  screen. 

  
 
 
 
 
 
 
 

5. Navigate to the location where the file was 
saved in step 2 and double click on it. 

 
 
 
 
 
 
 
 
 
 

 
6. The location selected will be now appear 

in the Load from File:  field. Click OK and 
when prompted to confirm the update, 
click Yes. 

 
   
 
  
 
7. You will be notified when the update is complete. 
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UPDATE ESCROW INFORMATION 

This function is available to both System Administrator and Utilities  access code levels. 
 
This function is rarely  used. This function can be used to update escrow information if the ledger or 
savings balance on an escrow has been corrupted or if the Close Date  &/or Recording Date  are 
incorrect (they are generally set by the issuance of the “:T” payee check). Lastly, it can be used to 
change the IRS 1099-S reporting status if the Transaction Type  of the file is set to a reportable type. 
When called for, the user will be prompted for the escrow number and then will be presented with the 
screen shown below. 
 

This screen is to be used only when proper 
procedures available through the Escrow and 
Accounting modules are not resolving a 
problem. Improper modifications made through 
this screen can have the effect of creating 
Accounting errors rather than fixing them.  
Therefore, any issue that is being worked 
through this screen must have undergone quite 
thorough research beforehand. 
 
If the screen is pulled up just to check on the 
status of a file or if no changes are to be made, 
use the Cancel  button to close the screen. If 
changes have been made and you wish to save 
them, click on the OK button. Both buttons will 
close the screen and return you to the main 
Utilities screen. 

 
 
 
COPY NAF BRANCH 

If the database is configured for NAF by Branch (not Centralized), this option will be available on the 
Tools  menu.  It is used to make a duplicate of the NAF entries from one branch for another branch.  
When selected, the screen below will be presented. 
 
 
 
 
 
 
 
 
 
 
 
 
The dropdowns should be used to select the Branch to Copy From  and the Branch to Copy To .   
Click on OK to execute the copy, or Cancel  to return to the Utilities desktop. 
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 FIX REGULAR LEDGERS 

In rare instances, it may be necessary for the system administrator or a USA Digital Solutions staff 
member to add, modify, or delete an entry in an escrow ledger. This should be considered drastic 
action and should only be undertaken when all possible “front end” procedures have been evaluated 
to fix the issue at hand and the situation has been well researched and documented. Please consult 
USA Digital Solutions staff before utilizing this function. 

 
The first screen presented, when this function is 
called, asks for the escrow number to be worked on. 
While the Search  function is available, you really 
should know what escrow you intend to alter if you 
are using this function. Click on Cancel  to terminate 
the function. Click on OK to continue once the 
escrow number has been entered. 
 
 

 
The next screen presented will be the posted ledger for the selected file. Unposted items can be 
corrected through the front end. Initially, no record is selected. A line item (transaction) can be 
inserted into the ledger with the Add  button or if a record is to be altered, it should be clicked on and 
then the Delete  or Modify  buttons used to perform those functions.   
 

 
 
NOTE: if an item is deleted, the branch balances will need to be updated through Utilities > System 
Files > Branch  to reflect the missing transactions or an audit error will result. It is always a good idea 
to run an accounting audit before and after making any changes through the Fix Regular Ledgers  
function. 
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With either Add  or Modify being clicked, the user will be presented with one of the following  
maintenance screens through which a new transaction can be created or an existing record altered 
within the ledger (not to be confused with the open check file). 
 

 
 
Either a receipt or disbursement item can be entered/modified through this screen. Again, it is very 
important that you are clear on what you are changing and have exhausted all other methods for 
correcting the situation before resorting to using this function. Document the ledger before and after 
any changes and keep good notes on what was done and why. If a new record is being entered, the 
fields will largely be blank; if modifying an existing item, they will be filled. 
 

• The Date of the item is entered in the first field. This can be any historic date (up to the latest 
posting date). 

• Post Order will be auto populated by the system. This number cannot be edited. 
• The Initials  of the user entering the transaction should be entered here. It will not default to 

the user logged in when adding a new transaction. When modifying a transaction, the initials 
of the user that created it will be listed in this box. 

• The Escrow Name will be filled, as the escrow has already been identified. 
• The Payor  (on a receipt) is entered in the next field. If modifying a check, this field will be 

blank. 
• The Cleared status of the item is identified and can be changed. The item will appear in the 

applicable reconciliation if changed from Yes (cleared) to No (uncleared). 
• The Receipt Number (all zeros if a check) is presented. 
• The Receipt Type can be identified/altered next. 
•  If a Savings Account is involved with the transaction, SAV and  INT receipt types only, it is 

identified next. 
• The next field is the Hold  flag linked to the receipt. As these are posted items only, a held 

check would never appear here. 
• If an existing check, the number would appear in the Check Number field. 
• The bank involved with the transaction is identified in the Bank Number field. 
• If it is a manual check that is being modified/entered, that is indicated in the Manual  field. 

NOTE: this is NOT the normal routine for entering a manual check, which is through 
Accounting > Disbursements > Manual Check Entry.  

• Finally, the Amount  of the transaction is entered/modified in that field. It will generally be 
positive for a receipt and negative for a check. Correcting receipts and voids will be counter 
to that. 
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FIX SAVINGS LEDGERS 

This function behaves in the same manner as Fix Regular Ledgers , but involves only posted savings 
transactions. 
 
 
FIX OPEN CHECK FILE 

There are two menu items listed under the Utilities  > Fix Open Check File menu option , Add a 
Check  and Change Status of a Check . These functions will, as indicated, permit the addition of a 
check into the Open Check File or change the status of a check that is already in the system. As with 
the Fix Ledger functions, these functions are only to be used after extensive research and 
consultation with USA Digital Solutions staff. 
 
While this may sound similar to the discussion above for Fix Regular Ledgers,  it is different. This 
section relates to checks in the open check file. The Ledger is a separate and distinct data set from 
the Open Check File. While both contain information about checks, that information is kept in two 
different tables. An item may be in the ledger, but missing from the open check file, or visa-versa and 
so you may need to use one utility or both to correct an issue with a check. 
 
Add a Check : If a check is in the ledger of an escrow, but has been deleted out of the open check file 
or has never made it there for some reason, it can be added back through this screen. Identify the 
Escrow Number  and the Bank  for the check. Then enter the Check Number  and the Check Date . 
Finally, enter the Check Amount  and Pay to Name  (Payee).   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Three status checkboxes are at the bottom of the screen:  

• Manual Check  – check if it was a manual check originally; 
• Income Check/Fee Slip  will be activated and checked if “:T” is entered in the Pay to Name  

field. 
• Submitted for Positive Pay  – check if you do not wish the check to appear in the next 

Positive Pay upload file (if it was already sent).   
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Change Status of a Check: There may also be very rare occurrences when the status flags on a 
check fail to maintain their correct setting(s). If this is the case, you can change their status through 
this screen. When initially called up, just the first bank in the bank table will be listed.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the correct bank for the check to be examined and then enter the check number. The system 
will load the check information into the fields on the screen. You can then check, or uncheck if 
checked in error, the Cleared , Void , and/or Submitted for Positive Pay  status boxes. The date(s) of 
clearing or voiding can be updated or cleared as needed. 
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CHANGE DATE ON UNPOSTED BATCH  

A situation may arise where an Accounting batch has the incorrect date on it. This can happen if a 
local workstation or a Citrix or terminal server environment has an incorrect system date on it and an 
escrow user on that machine/system creates receipts and/or disbursements, an Accounting batch will 
be created with that machine’s incorrect date.   
 
The Accounting user responsible for posting should notice that there is a batch with an unexpected 
date and should bring it to the attention of the system administrator. The system administrator can 
use this tool to correct the date on the file containing the Accounting data after investigation 
determines that is the proper course of action. There are times when backdated transactions are 
legitimate and those will result in backdated batches, which would not be adjusted. 
 
When selected, the screen below will be presented. The records displayed will be of all the unposted 
batches. The date of the batch, the bank involved, the source branch, the branch name, the type of 
transactions contained in the batch, and the total amount of the transactions within the batch are 
detailed. Prior to changing the date on an unposted batch, it is a good idea to generate a report of the 
unposted listing in its original state by clicking the Print  button. This will generate the listing of all of 
the unposted batches. It does not contain the detail of each batch. The Receipt Journal and the 
Disbursement Journal should also be printed from the Accounting module before changing the date. 
To do this, login to the Accounting module, go to Receipts > Print Daily Receipt Journal  for the 
receipts and Disbursements > Print Daily Disbursements Journal  for the disbursements. 
 
Click on a specific record and then click on the Modify  button to be taken to the screen where you 
can change the date on the batch. Enter the correcting date in the field provided and click OK to 
complete the change. All transactions within the batch will be re-dated. Click on Cancel  to quit 
without making a change. 
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VIEW FILE STATISTICS 

This function is available to both System Administrator  and 
Utilities  access code levels. 
 
There are times when troubleshooting issues that the System 
Administrator or USA Digital Solutions staff would like to know 
the number of records in one or more of the system tables that 
make up the full data set of the Impact/SQL installation at the 
site. This menu selection is used to do just that. When opened, 
a screen like that shown is displayed. 
 
The table names and the number of records in each are listed 
in alphabetic order with a scroll bar down the right side. The 
Refresh  button is used to monitor changes to the record 
count(s) for one or more tables as the system runs. This might 
be used to observe the progress of a posting cycle, for 
example. This is also a good tool to use to see if features of Impact/SQL are being fully utilized. For 
example, it is evident in this screen that the users are using conversation logs. 
 
 
VIEW/CLEAR RECORD LOCKS 

SQL database systems rely on record locks to control access to data that is in the process of being 
altered, or potentially may be altered, based on where a user is viewing the data from. Should a user 
have a lock on one or more records (including those in the Documents table) and their computer 
freezes up or they get kicked out of Impact/SQL for some reason, the locks may not be released as 
they would normally be when a user closed the Impact/SQL module they were using or if they saved 
the file.   
 
This utility is provided to enable a System Administrator to monitor the locks as they are placed and 
released and to clear a lock that has not been properly released. When selected, the system will grab 
a snapshot of the current locks that are in place and display them on a screen like that shown below 
(usually there will be far more displayed). The file number involved, the user, the lock origination 
date/time, server, and the table involved with the lock are all presented. 

 
The Refresh  button will 
present an updated list of 
locks that are in place at 
the moment the button is 
hit. As locks are placed 
and released constantly, 
the listing can be updated 
every few seconds or 
minutes to aid in 
researching an issue, for 
example.  
 
To release a lock that 
persists after a user 
closes all Impact/SQL 
modules they were logged 

into, highlight the record containing the lock detail by clicking on it and then click on the OK button. 
You will be prompted to confirm that you wish to remove the lock.  
 
To close the screen, use the Cancel  button. This will not affect any locks displayed. 
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VIEW IMPACT/SQL ERROR LOG 

Impact/SQL maintains a rolling error log, of a controlled size, of SQL errors generated by the system 
in response to unexpected user actions or data / system conditions that are unanticipated. The error 
log has a size limit that will prevent it from becoming too large. Once the size limit is reached, the 
oldest items in the log will roll off as new errors are logged. This tool will generate a report of the 
current contents of the error log. 
 
Many of the errors will be reported at the time they occur to the user, on their screen, but not all of 
them are.   
 
The report identifies the date and time of 
the error, the user initials or login ID (if 
NT driven), the file and routine names 
involved, the application and form 
loaded, the escrow number (if one was 
involved at the time of the error), and 
the error number and description. Many 
of these details will be meaningful only 
to the USA Digital Solutions staff that 
will use this report to track the 
occurrences of a specific error reported by the user(s) in the research effort on an issue. 
 
 

DSI MESSAGING QUEUE MANAGER 

The Message Queue Manager work-screen, shown below, is only applicable to sites with integrations 
installed that utilize the DSI Messaging service.  The operation of this work-screen will be discussed 
in other documentation. 
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ABOUT MENU 

The only item on the About menu displays a splash screen of information about the current 
installation of Impact/SQL, like that shown below. When a call is placed to USA Digital Solutions 
about a service issue, you may be asked to refer to this screen for the version and build number. The  
“build number” is the number in parenthesis after the version number. Similar screens are available in 
each Impact/SQL module and build numbers may NOT be the same for each module. 
 

 
 
 
The OK button will close this screen.   
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IMPACT/SQL BATCH PROCESSOR 

The Batch Processor is a standalone Impact/SQL module that runs 24 hours a day, 7 days a week,  
in its own session, and is configured to perform specific tasks on a routine basis. Specifically, the 
Batch Processor can be configured to: 

• print title orders routinely throughout the day 
• print incoming wire notifications routinely throughout the day 
• print outgoing wire notifications routinely throughout the day 
• delete escrow and/or title documents that are over a certain age nightly 
• generate Positive Pay files nightly 
• run the Accounting Audit nightly 
• generate the Accounting Overdraft report nightly 
• clear non-current SQL locks that might hinder operations nightly 

 
The Batch Processor runs continuously on a server or within its own Citrix or Terminal Server 
session. It should be “checked on”, preferably on a daily basis, to make sure it is running and 
performing properly. Normally, the Title or Accounting staff will notice if the Batch Processor is not 
working, as they will not be receiving output that they normally would. 
 
LOG IN 

A user with System Administrator rights should log into the Batch Processor when it is initially opened 
if the system is not configured for NT login. If configured for NT login and if the user that is logged into 
the session is authorized, the Batch Processor will load and begin operation when the icon for it is 
double-clicked from the desktop. 
 
Once the Batch Processor is up and running, the small interface screen is displayed. It has four menu 

categories and presents the current 
system time and the time the Batch 
Processor is configured to begin its 
nightly processing cycle. As it is 
processing items, the space next to 
the Processing  label will reflect what 
it is doing. Generally during the day, 
the items being processed are worked 
so quickly that the descriptions just 
flash momentarily. If errors are found 

in a processing cycle, the count of them is displayed as well. Generally, this screen is left open on the 
machine or session that is running the Batch Processor for easy reference by the System 
Administrator. The session that the Batch Processor is running under should be disconnected, not 
logged out, so that it continues to operate unattended. 
 
FILE MENU 

There is only one item under the File  menu option: Exit . This option should be the method used for 
closing the Batch Processor rather than the X in the upper right-hand corner. 
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OPTIONS MENU 

There are three menu selections under the Options  menu and all of the configuring of the Batch 
Processor is done through them. The options are Batch Tasks , Auto Print Title Instructions , and 
Printer Setup . Each will be described below. 
 
 
 
 
 
 
 
 
 
 
 
 
BATCH TASKS 

This is the primary configuration screen for the Batch Processor’s functions. Some of the functions 
run throughout the day, while others execute in a “batch” which begins at the time entered in the 
Select Start Time  field. The Save Transaction Log Files  checkbox can be checked if the Batch 
Processor transactions log data is to be retained for previous days; otherwise, the transaction log will 
only reflect the most recent processing cycle. 
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DOCUMENT DELETION: The documents created within Impact/SQL are MS Word doc files. These 
files can take up quite a bit of space on the system and are of questionable value after considerable 
time has passed. The company can decide that it does not want to delete any document files or it can 
utilize this function to purge the system of specific escrow and/or title documents or all escrow and/or 
title documents “X” number of days after the last modified date of each document.   
 
Clicking on the Document Deletion  box and entering a value in the # of Days Retention  box will 
turn on the deletion process. A decision must then be made as to whether the All Escrow 
Documents  or Specific Escrow Documents  option should be chosen. If Specific Escrow 
Documents  is selected, click on the Configure  box and a screen with a list of master documents will 
be presented from which the specific documents to be deleted may be selected. The same options 
are available for title documents. Note:  As the master document menu is changed (documents 
added), if selected Document Deletion  is being used, as opposed to “All”, this configuration should 
be updated to include/exclude the new document types.  
 
Prelims, policies, and endorsements linked to polic ies are never deleted.  
 
CREATE POSITIVE PAY FILES : The checkbox for Create Positive Pay Files will trigger the Batch 
Processor to prepare positive pay file(s) nightly from the data on checks issued during the day. Using 
this option will preclude the need for accounting users to generate positive pay files interactively the 
next day. The files will be prepared and will be waiting for the Accounting staff to upload to the 
respective banks the next morning.   
 
The generation of positive pay files requires the use of a filter that is customized for the specific bank 
involved. Several filters already exist, but it may be necessary for USA Digital Solutions to write a new 
filter(s) for your company’s bank(s). Please 
discuss your company’s specific banks with 
USA Digital Solutions staff. 
 
The Configure button, activated when the 
checkbox for this option is checked, will 
present a screen on which you will identify the 
positive pay files to be prepared nightly. You 
can group several accounts for the same bank 
into one positive pay file using this process, 
which cannot be done in the interactive 
process, thereby simplifying the upload effort 
the next day. 
 
 
AUDIT ACCOUNTING DATA : When this checkbox is turned on, all of the audit tests will execute 
nightly and the Audit results report will print on the Print Other Reports To printer identified under the 
Printer Setup screen. Generally, this would be a printer in the Escrow Accounting area. Then, each 
morning, the Accounting staff can check the report and address any errors that are identified. If this 
habit is established, problems can be identified and addressed promptly. 
 
ACCOUNTING OVERDRAFT REPORT : This checkbox, when turned on, will run the Accounting 
Overdraft  Report  every night and send the report to the same printer that the audit report is sent to. 
The Accounting Overdraft  Report  identifies every escrow with a negative posted balance. This can 
help bring overdrafts to Accounting’s attention so they can pursue funding of the deficiencies. 
 
PRINT INCOMING WIRE REQUESTS: This option, if wire processing is being utilized, will provide for 
the generation of a printed notice of each wire requested, in addition to the information being 
presented within the Accounting module, as they are requested. This option is run throughout the 
day. The Configure  button will present a screen asking which printer to utilize for these notices. The 
notices can be printed from within the Accounting module as well. 
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PRINT OUTGOING WIRE REQUESTS: This option performs as the Print Incoming Wire Request  
function does. They are two separate options, as not all companies use both the incoming and 
outgoing wire-processing modules, and /or may not want notices from both to print. 
 
CLEAR SQL LOCKS : SQL database systems rely on record locks to control access to data that is in 
the process of being altered, or potentially may be altered, based on where a user is viewing the data 
from. Should a user have a lock on one or more records and their computer freezes up or they get 
kicked out of Impact/SQL for some reason, the locks may not be released as they would normally be 
when a user closed the Impact/SQL module they were using.  
 
This option is provided to automatically clear all locks over an hour old that have not been properly 
released, nightly, when the Batch Processor kicks off its batch tasks. This can be handy, as the 
posting process run by Accounting, usually early each morning, may hang up if there is a stray lock in 
place. If this option is not turned on, the system administrator will need to use the Utilities > Tools > 
View/Clear Record  Locks  function to release the errant lock(s). This may still be required if a new 
errant lock occurs after the Batch Processor runs and before the posting cycle is started. 
 
 
AUTO PRINT TITLE INSTRUCTIONS 

This option will cause title orders to automatically print every “X” minutes on the title printer. If there is 
more than one title department, each one will have a printer defined within the Batch Processor for 
printing orders. Having title orders appear on a printer automatically is a nice trigger to remind title 
staff that there are new orders. 
 
If this option is turned off, the Impact/SQL 
Title module users will need to print newly 
received orders manually if they are not set 
up to have the title instructions e-mailed. If 
there is a printer problem that Impact/SQL 
does not detect, orders will have to be 
reprinted out of the Title module.  If the title 
instructions are set to be e-mailed out, this 
option can be turned off. 
 
Click on the OK button to accept any 
changes made to this screen or Cancel  to 
close without saving changes. 
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PRINTER SETUP 

This screen is used to tell the Batch Processor which printer should be used in each Title Branch for 
the printing of the title orders, if auto printing was turned on, as described in the discussion above. 
There is a dropdown list of all of the Title Branches (each should be selected in turn) and a printer 
assigned to each if multiple Title Branches is enabled (Utilities > System Files > Setup Options > 
General ). The printers are presented in another dropdown list fed by the printers defined to the 
server/session in use. 
 
The Print Other Reports to  field is used to 
identify where the other reports (Audit, 
Overdraft, Wire Notification) should print. 
Generally, this is the Accounting printer. 
 
 
 
 
 
 
 
 
 
 
If only one Title Branch is used, this screen will be displayed when choosing Printer Setup: 
 
Click on the OK button to accept any 
changes made to this screen, or Cancel  to 
close without saving changes. 
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LOGS MENU 

There are three menu selections under the Logs 
menu. They are used to view and print listings of 
error messages related to the Batch Processor 
activity and the transaction log(s) of Batch 
Processor activity. It also can be used to view 
the schedule of Batch Processor activity. Each 
will be described below. 
 
 
 
ERRORS 

The Errors log lists problems that the Batch 
Processor has locating wire in or wire out reports 
when trying to print those notices if so configured. 
 
The File  menu on the Batch Processor Error 
File  screen has options for printing the error log 
and for clearing it out. 
 

 
 
 
TRANSACTION 

The Batch Processor Transaction log, accessed 
through this screen, either will present the listing of 
activity for just the previous batch run, the nightly 
run of the processor, or will present many days of 
history of the processor’s activity. This is 
dependent on whether the Save Transaction 
Logs  checkbox is checked or not on the Options 
> Batch Tasks  screen. The Transaction Log can 
be reviewed to confirm that all tasks that were 
scheduled actually were performed. Details of 
what occurred during each task are also 
presented. An example of the Transaction Log is 
displayed. 

 
As with the Error Log, the Transaction Log can be printed or cleared from the File menu. 
 
SCHEDULE 

The Schedule Log option simply presents a 
screen of the scheduled tasks, when they last 
ran, and when the next run is. Assuming there 
are nightly tasks scheduled and automatic 
printing of title orders and/or wire notifications 
throughout the day, the screen will look like the 
one presented here. 
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HELP  

The About  menu item is the only listing under the Help menu heading. It, as in all Impact/SQL 
modules, presents the splash screen that displays the version and build number for the program 
installed, in this case the Batch Processor. As the system administrator, you may be asked to confirm 
the version and/or build number by a USA Digital Solutions staff member and this is where that is 
done. 
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IMPACT/SQL INCOME EXPORT 

There is a utility available to Impact/SQL installations that provides for the export of the data from the 
Income Analysis table so that it can be used in another application, such as a financial accounting 
general ledger system. There is not typically an icon set up for this program as it does not have 
universal applicability. However, should it be of use to the company, a desktop icon can be 
established for the user responsible for this function. 
 
When called on, the login screen looks like that for the other Impact/SQL modules. 
 
 
Once the user logs in by providing their initials, password, and then clicking on the OK button, the 
screen below is presented which is used to set up the export and then to execute it: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
The Export Format  dropdown box displays the various output options that have been developed to 
date. 

 
The data can be exported into an MS Access .MDB 
file, from which it can be pulled by systems that can 
read that format (ODBC). The ACCPAC format is 
accepted by that accounting system, as is the 
QuickBooks 2002 export. The format you wish to use 
should be selected. 
 
 
 
The Date Range  to be used is then identified. The export is inclusive of the dates specified. NOTE: 
data is not included in the Income Analysis table until it has been through the Accounting posting 
cycle. You must know what date the system has been posted through as this module will not alert you 
to the fact that you have asked for a date range that extends beyond the last posting date. 
 
The Directories  and Drives  area, in the lower right of the screen, is used to specify the target for the 
exported data. Select the drive first and then navigate to the sub-directory where you wish the 
exported file to be stored. A listing of all of the files within that sub-directory will then appear on the 
left side at the bottom of the screen under the Export File Name  heading. Either select an existing 
file from the listing, if you wish to overwrite an existing file, or enter a new name in the space 
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provided. If you are following a naming convention, you can select a filename for the pattern by 
clicking on it and then edit the name in the box under the area header. 
 
Once the export has been properly configured, click on the OK button to execute it. When OK is hit, 
you will get a message, like that below, identifying the date range for which the export will be done, 
the target file name, and output format for the export. If all is in order, click on Yes to complete the 
export. Click on No to cancel without performing the export. 
 

 
 
 
 
 
 
 

 
When the export is complete, you will be returned to the main screen. Use the Cancel  button to close 
the function. Outside of Impact/SQL, within your general ledger or other income analysis system, you 
will then use that application’s import function to bring in the exported data. 
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IMPACT/SQL UPDATE 

The Update program (update.exe) is utilized in workstation environments only, as opposed to Citrix or 
Terminal Server environments. In a workstation environment, each user’s workstation has files stored 
on it that are used to run Impact/SQL in conjunction with the data on the central server. The Update 
program is used to make sure that the program and supporting files on the workstation are the most 
current versions, as installed on the server. When the programs and/or any supporting files on 
the server are updated due to the installation of a  new version of Impact/SQL or an updated 
report file or .DLL, then the Update program will n eed to be executed on every  workstation 
before the enhancement will be available to the use rs of those workstations. 
 
The Update program, when executed from a shortcut on the workstation’s desktop, will refer to a text 
file normally called Update.bat , which contains information about the specific installation, which types 
of files should be updated, and their locations. The contents of a sample Update.bat file are displayed 
here. 
 
 Sample Update.bat file 
 rem DelFiles=true,  DllReg=true,     ErrHandling=true,  FileLen=false 
 rem Force=false,    NoSeconds=true,  Turbo=true  
 rem AutoRun=false,  WinSysPath=true 
 rem skipfiles 
 rem ------------------------------------------------------------ 
 copy i:\runs32\*.exe c:\impact\*.exe 
 copy i:\reports\*.rpt c:\impact\report\*.* 
 copy “i:\Save Files\*.sav” c:\impact\SaveFiles\*.sav 
 copy i:\dlls\*.* %winsys%\*.* 
 copy i:\company\mainsite\data\*.gif c:\impact\*.* 
 copy i:\word\*.dot c:\impact\word\*.dot 
 copy i:\impactexcel\impact.xla c:\impact\word\*.* 
 copy i:\company\mainsite\ttltmp\dummy.lgl c:\impact\*.* 
 pause 
 
The file types that are copied from the server to the c:\impact subdirectory on the workstation, are: 
 

• exe’s – the programs 
• rpt’s – the Crystal Reports report files 
• sav’s – files used in preparation of some reports 
• dll’s – dynamically linked library files (put in the c:\Windows\System32 path, rather than 

c:\impact 
• gif’s – image file(s), used on the desktop 
• dot’s – the MS Word template files used to manage document processing 
• impact.xla – an MS Excel template used with exported documents 
• dummy.lgl – a starter file for legal descriptions 
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IMPACT/SQL PRINTER TEST 

The Printer Test program (prttest.exe) is used to generate one or more test checks outside of 
Impact/SQL, which can be examined to make sure their formatting is correct. In addition, the dummy 
checks can be sent to the bank(s) to make sure that the micr encoding on them can be properly read 
by the bank’s equipment. 
 
Generally, a shortcut to this program will only be added to the System Administrator’s or Accounting 
Manager’s desktop. You do not want everyone to be able to generate dummy checks. The 
check##.rpt files, where ## is the bank number, for the bank to be tested, must already be in place 
before the Printer Test program can be run. 
 
When the program is ran, the user will be asked to login and then will be presented with a 
configuration screen, as shown below: 
 

 
 
The top of the screen will identify the defined check printer and the left side of the screen displays all 
of the checks##.rpt files that the program found installed that are available for testing. As previously 
mentioned, the “##” is the Bank Number assigned in Impact/SQL to the bank. Click on a specific 
checks##.rpt file to select it to be test printed. The Options  section, on the right side of the screen, is 
used to identify how many sample checks to print, the maximum digits the bank can read for a check 
number, the number of detail lines that you wish to see on the check stub(s), and the dollar amount to 
present on the check(s) that are printed. Once the test is configured, click on the OK button to 
generate the sample checks. To close the program, click on the Cancel button. 
 
Note:  A bank normally requires 20 sample checks to be printed on check stock with the MICR toner 
and font. Once your samples print, confirm that the MICR font printed properly (numbers in MICR 
format across the bottom of the check.) If not, the MICR font will need to be installed on the Terminal 
Servers or local workstations, depending on the environment. Contact USA Digital Solutions staff for 
the MICR fonts if you do not have them. 
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IMPACT/SQL INVOICE EXPORT 

There is a utility available to Impact/SQL installations that provides for the export of invoice data so 
that it can be used in another application, such as a financial accounting accounts receivable system. 
There is not typically an icon set up for this program, as it does not have universal applicability. 
However, should it be of use to the company, a desktop icon can be established for the user 
responsible for this function. 
 
When the module is loaded, the login screen looks like that for the other Impact/SQL modules. Once 
the user logs in, the following configuration screen is presented: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Export Format  dropdown box displays the various output options that have been developed to 
date. 
 
 
 
 
 
 
 
 
 
 
 



 

Impact Utilities Manual for version 7.0.0 Page 121 

The data can be exported into an MS Access .MDB file from which it can be pulled by systems that 
can “read” that format. The QuickBooks 3.0, QuickBooks 5.0, MAS90, ACCPAC, BusinessWorks, and 
QuickBooks 2002 are the other formats that the data can be exported into. The format you wish to 
use should be selected. 
 
The Date Range  to be used is then identified. The export is inclusive of the dates specified.   
 
Note:  Invoices are available to the export function immediately upon creation. Pre-bills are NOT 
included. Also, users can edit invoices after they are exported. Because of this, proper procedures 
need to be in place for the entire invoice cycle, both within Impact/SQL and outside of it. 
 
The Directories  and Drives  area, in the lower right of the screen, is used to specify the target for the 
exported data. Select the drive first, and then navigate to the sub-directory where you wish the 
exported file to be stored. A listing of all of the files within that sub-directory will then appear on the 
left side, bottom, of the screen, under the Export File Name  heading.  Either select an existing file 
from the listing, if you wish to overwrite an existing file, or enter a new name in the space provided. If 
you are following a naming convention, you can select a filename for the pattern, by clicking on it, and 
then edit the name in the box under the area header. 
 
Once the export has been properly configured, click on the OK button to execute it. When OK is hit, 
you will get a message, like that below, identifying the date range for which the export will be done, 
and the target file name and output format for the export. If all is in order, click on Yes to complete the 
export.  Click on No to cancel without performing the export. 

 
Outside of Impact/SQL, within your Accounts Receivable system, you will then use that application’s 
import function to bring in the exported data. 
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